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Common Questions and Answers

1. When playing files from my SCSI drive, why does the sound have a warbling effect? ANSWER 

2. When saving files as Macintosh AIFF and transferring them to my Macintosh, why does the Macintosh 
not recognize them as sound files? ANSWER

3. After running an effect on a file, why is there a loss in volume level?    ANSWER

4. Why do some effects take so long to process a file? ANSWER

5. When I start Sound Forge my Play and/or Record buttons/options are grayed out. Why can I not play or
record? ANSWER

6. Why can I not get Sound Forge to respond to levels from my Microphone or my CD Player? ANSWER

7. I have sound files that don't want to play on my system. Sound Forge loads them fine, why will it not 
play them? ANSWER

8. Why will Sound Forge not open my compressed files like Microsoft ADPCM? ANSWER

9. Why is it when I play my sound files the play pointer that Sound Forge displays seems to be off from 
what I am hearing? ANSWER

10. When I record or play back files I hear what sounds like small clicks in the sound. ANSWER

11. When I record (or play) data at high sample rates, I cannot get Sound Forge to stop by pressing the 
Stop button. ANSWER

12. When using SMPTE/MTC to drive my sequencer, my sequencer sometimes loses sync. ANSWER

13. After converting WAV files to Redbook audio using the software which came with my Compact Disc 
recorder, there are audible clicks at the end of the track. ANSWER

14. My Compact Disc recorder uses a file type with an RBK extension. What is an RBK file and can I 
open it with Sound Forge? ANSWER

15. When playing Sound Files with rates above 44,100 Hz on my Turtle Beach Multisound or Tahiti, my 
system crashes. ANSWER

16. When playing Sound files at 8,000 Hz on my Turtle Beach Multisound, the play pointer moves but I do
not hear any output. ANSWER

17. When playing Sound Files at rates other than 11, 22, or 44 kHz the files sound wrong (the pitch is 
wrong). ANSWER

18. When making a selection with the mouse, why does the selection change to another location? 
ANSWER

19. Microsoft ADPCM files created using Sound Forge crash when I play them in Media Player 
on my Turtle Beach sound card. Why? ANSWER



Q: When playing files from my SCSI drive, why does the sound have a warbling effect? 

A: When playing files from a SCSI drive that is connect to a SCSI adapter that utilizes a DMA channel 
(such as most Adaptec adapters) you may experience a warbling effect in the sound playback. This 
can occur if your sound card uses DMA and its DMA channel is set to a higher number than your 
SCSI adapter.

To fix this problem, set the DMA channel used by your sound card is a lower number than that used 
by your SCSI adapter. So, if your SCSI adapter is set to DMA channel 5 and your sound card is set to 
DMA channel 7, try reconfiguring them so the sound card uses DMA channel 5 and your SCSI 
adapter uses DMA channel 7.

                                                         
See also
Common Questions and Answers 



Q: When saving files as Macintosh AIFF and transferring them to my Macintosh, why does the 
Macintosh not recognize them as sound files?

A: The Macintosh uses special information within it's operating system to keep track of the types of files 
to which it has access. Sound Forge for Windows can save the audio data in the correct file format, 
but it cannot tell the Macintosh what type it is. To do this you must use a program on the Macintosh, 
like ResEdit, which allows you to change the Type of the file. You simply need to set the Type field to 
AIFF for the Macintosh to recognize the file as a sound file.

                                                         
See also
Common Questions and Answers 



Q: After running an effect on a file, why is there a loss in volume level?

A: Most effects that can alter the volume level of a file have two fader controls, Dry Out and Effect Out 
(where Effect is the name of the function, like Reverb). These controls should be adjusted to get the 
proper balance between processed and non-processed sound and also    determine the combined 
volume level. For example, if you run an effect with both controls set at 40% and the level after 
processing is too low, simply raise both the Dry and Effect Out faders an equal amount to raise the 
final level.    However, take care to keep the output signal from clipping .

                                                         
See also
Common Questions and Answers 



Q: Why do some effects take so long to process a file?

A: Some processing functions used by Sound Forge are very math intensive. Examples include EQ, 
pitch change without change of duration, and the reverb effect. This means that millions of integer 
and floating-point arithmetic operations must be performed for each second of sampled data. If your 
computer's CPU does not have a math-co-processor (in the Intel architecture that means if you have 
an i486 SX instead of an i486 DX or Pentium), floating-point operations will drastically slow you down 
and there is not much you can do except save up for a faster processor.

Of course, running effects on stereo, 44,100 Hz, hour long files will slow you down no matter what 
machine you are using. If you are going to be deleting or inserting space into these huge files, we 
recommend that you break the files into smaller ones and then mix the smaller files together once you
are done processing them. This is especially painful when you insert or delete from the beginning of a
large file, since Sound Forge must then shift the rest of the file over.

One way the get around disk related editing delays is to use the Regions List and Playlist to make all 
arrangements non-destructively and then use the Convert to New function on your Playlist. Another 
useful feature in Sound Forge is the Preview Cut function under the Edit Menu--use this function to 
verify your Cut and Clear operations before actually changing the file.

                                                         
See also
Common Questions and Answers 



Q: When I start Sound Forge my Play and/or Record buttons/options are grayed out. Why can I 
not play or record?

A: When Sound Forge starts, it checks to see if you have a wave playback and record device installed in
your system. If you do not then it disables the appropriate operations. If you are sure that you have a 
sound card installed in your system, yet Sound Forge does not recognize this, you need to check a 
couple of things. First check the Wave folder in the Preferences dialog. The two settings of 
importance are the Playback and Record drop-down list boxes. These options determine the wave 
playback and record devices which will be used by Sound Forge. By default Sound Forge uses the 
Wave Mapper (may also be called the Sound Mapper) device which should automatically pick an 
appropriate device for use by Sound Forge. If either the Playback or Record device is set to (None) 
then Sound Forge can not execute the corresponding operation. To learn more about configuring your
wave devices refer to the Wave Preference folder in the Reference section.

                                                         
See also
Common Questions and Answers 
Configuring Drivers
Windows Sound Setup



Q: Why can I not get Sound Forge to respond to levels from my Microphone or my CD Player?

A: Most sound cards come with multiple inputs which you can record sound from. These may include 
microphone, CD, auxiliary, MIDI and line inputs. Although some cards record from all of these inputs 
at the same time, many cards make you choose which device is currently your record device (also 
known as the input source). These cards come with software which allows you to pick which device is
the input source. You will need to refer to your sound card manual to determine how to set the input
source.

Most sound cards also come with some kind of application which controls the input level of the 
recording device. You may need to increase the level of your input sources in order to record from 
them. Again, you will need to refer to your sound card manual to learn how to adjust these levels.

                                                         
See also
Common Questions and Answers 



Q: I have sound files that do not want to play on my system. Sound Forge loads them fine, why 
will it not play them?

A: Sound Forge allows you to load many different types of sound files, including ones that your system 
may not be capable of playing. There are a variety of reasons that your sound card may not be 
capable of playing a file.

Some sound cards only allow playback and recording at specific sample rates. Typically these rates 
are limited to 11,025, 22,050, and 44,100 Hz. If you try to play a file that is 32,000 Hz the sound card 
will not allow you to play it.

If you have an older sound card it may only support Mono playback. If this is the case simply convert 
any Stereo files to Mono and you will be able to play them.

If you have an older sound card it may only support 8 bit playback. If this is the case simply change 
the sample size of the file from 16 to 8 bits.

                                                         
See also
Common Questions and Answers 



Q: Why will Sound Forge not open my compressed files like Microsoft ADPCM?

A: Sound Forge has built in support for the Microsoft Audio Compression Manager (ACM). This allows 
you to open files that are compressed with a variety of algorithms including Microsoft ADPCM, IMA 
ADPCM, and other third party compression schemes like True Speech from The DSP Group.

If you cannot open a Microsoft ADPCM file, you may not have the Microsoft ACM installed in your 
system or you do not have the Microsoft ADPCM driver installed and enabled for the ACM. Please 
refer to the Appendix's on Installing the Microsoft Audio Compression Manager and Sound Forge and 
The Microsoft Audio Compression Manager for more information on how to install and use the ACM 
with Sound Forge.

                                                         
See also
Common Questions and Answers 
The Audio Compression Manager
Installing the ACM



Q: Why is it when I play my sound files the play pointer that Sound Forge displays seems to be 
off from what I am hearing?

A: For Sound Forge to display the current position of the pointer relative to playback of audio data it 
must rely on your sound card driver to provide the correct position. Many sound card drivers do not do
a very good job of this. Typically the position these cards provide is both off by a fixed amount as well 
as reported only in large discrete steps. Sound Forge provides a way to compensate for this by 
setting various options in the Wave Preferences folder (File menu). Refer to the Wave Preferences 
folder in the Reference section for more information.

                                                         
See also
Common Questions and Answers 



Q: When I record or play back files I hear what sounds like small clicks in the sound.

A: When Sound Forge is recording or playing audio data it needs to move large amounts of data 
between your hard drive and your sound card. This can be a tremendous amount of work for your 
computer depending on the kind of system you have. If Sound Forge can not move the data fast 
enough then you will hear small gaps between blocks of data which typically sound like clicks or 
puttering. There are a number of things you can do to reduce the overhead during the time Sound 
Forge is moving sound data, all of which are covered in the Using Sound Forge section called 
Optimizing Sound Forge.

                                                         
See also
Common Questions and Answers 



Q: When I record (or play) data at high sample rates, I cannot get Sound Forge to stop by 
pressing the Stop button.

A: Sound Forge tries very hard to keep recording and playback of audio smooth (no gaps in your sound).
So there may be delays between the time that you press the Stop button and the time that Sound 
Forge actually stops. Note that you can always press and hold the Escape key to stop record or 
playback no matter how bad the situation is. Just be a little patient and wait a few seconds. These 
delays are usually only observed when one or more components of your system can not keep up with
the data rate. Typical faults are:

1. Very slow (older) hard drives.

2. Poorly written Sound Card Drivers.

3. Setting your Storage directory to a slow device like a Network drive or a Compressed Hard drive.

If at all possible, use the fastest uncompressed storage device available with Sound Forge. For 
more information on configuring your system, see the section on Optimizing Sound Forge.

                                                         
See also
Common Questions and Answers 



Q: When using SMPTE/MTC to drive my sequencer, my sequencer sometimes loses sync.

A: Depending on the performance of your system (and your sequencer) you may experience SMPTE 
sync drop-out problems. This is typically due to too many things going on at once (i.e. more than your 
computer is capable of maintaining). For example, if you have wave playback, synchronization 
messages, sequencing, and perhaps more going on at the same time, you may experience sync 
drop-out.

To compensate for this, many sequencers allow you to set a freewheel time, which is a slack time 
between SMPTE messages during which the sequencer will continue to play even if SMPTE/MTC 
messages are being missed. By increasing this freewheel time you allow Sound Forge and your 
sequencer to be less tightly dependent on SMPTE messages, but this may also decrease your 
synchronization accuracy. The best recommendation is to start with a small freewheel time and, if you
experience sync drop-out problems, increase the freewheel time until the drop-outs go away.

                                                         
See also
Common Questions and Answers 
Using Sound Forge with sequencers



Q: After converting WAV files to Redbook audio using the software which came with my Compact
Disc recorder, there are audible clicks at the end of the track.

A: Not all software for converting WAV files to Redbook audio handles the WAV file structure correctly. 
The software simply skips the first 44 bytes of data in the WAV file and then considers everything else
in the file to be audio data. This means that if you have saved Summary Information, Sampler 
Information, or Regions and Playlist data in the WAV file it will be interpreted as audio data.

If you are experiencing this problem simply, use the Save As command in Sound Forge to save a 
new WAV file with the Save Summary Information, Save Sampler Information, and Save 
Regions/Playlists check boxes unchecked. This tells Sound Forge to save only the minimum 
amount of information needed for a WAV file.

                                                         
See also
Common Questions and Answers 



Q: My Compact Disc recorder uses a file type with an RBK extension. What is an RBK file and can
I open it with Sound Forge?

A: RBK files are simply Raw PCM sound data files. These files are used by some Compact Disc 
recorders. These files are used to store Redbook audio onto a Compact Disc. RBK files are data only 
and contain no other information. They are stored as 16 bit, stereo data with a sample rate of 44.1 
kHz. There are a number of things that make them different than a normal 16 bit raw file:

1. The channels are stored in reverse order.

2. The data is stored in Big Endian format (Motorola).

3. The data length of the file has to be a multiple of 2352 bytes (1 CD sector). The size of a CD sector
is calculated as follows;

1 second of 44.1k, 16 bit, stereo Audio = 176,400 bytes.
CD audio has 75 sectors of data for each 1 second of audio.
Sector size = 176,400/75 = 2352 bytes.

To open an existing RBK file, simply use the RAW file option in Sound Forge's Open dialog box and 
select the RBK preset. Remember that you will have to swap the channels if you want to maintain the 
correct left/right channel settings.

                                                         
See also
Common Questions and Answers 



Q: When playing Sound Files with rates above 44,100 Hz on my Turtle Beach Multisound or Tahiti,
my system crashes.

A: This is caused by a severe bug in the Turtle Beach Multisound and Tahiti sound card drivers. You will 
experience the same crash no matter what software you use to play sample rates above 44,100 Hz--
including Media Player and even Turtle Beach's own Wave application.

Contact Turtle Beach for updated drivers.

                                                         
See also
Common Questions and Answers 



Q: When playing Sound files at 8,000 Hz on my Turtle Beach Multisound, the play pointer moves 
but I do not hear any output.

A: This is caused by a bug in the Turtle Beach Multisound driver.

Contact Turtle Beach for updated drivers.

                                                         
See also
Common Questions and Answers 



Q: When playing Sound Files at rates other than 11, 22, or 44 kHz the files sound wrong (the pitch
is wrong).

A: This is due to poorly written sound drivers that incorrectly play sounds with sample rates that are not 
supported by the sound card hardware. For example, a sound that is supposed to play at 13,000 Hz 
might get played at 11,025 Hz instead. This will cause the pitch to be lower and the playback time 
slower than it should be. The Microsoft Windows Sound System Version 2.0 and many 'compatible' 
sound cards contain this unfortunate bug.

Contact your sound card manufacturer for updated drivers.

                                                         
See also
Common Questions and Answers 



Q: When making a selection with the mouse, why does it change to another location?

A: If you have the Snap to Zero Crossings    or Snap to Time  option on (View menu), the selection 
points will be automatically moved to the nearest zero crossing or time unit.    If you turn both of these 
options off, selections made will not be modified by Sound Forge.

                                                         
See also
Common Questions and Answers 



Q: Microsoft ADPCM files created using Sound Forge crash when I play them in Media Player on 
my Turtle Beach sound card. Why?

A: Turtle Beach has implemented the Microsoft ADPCM format in the DSP of their audio cards. 
Depending on the version of the drivers you are using, you may crash when playing files created in 
Sound Forge on these cards.

This is a bug in the Turtle Beach drivers. Contact Turtle Beach for updated drivers.

                                                         
See also
Common Questions and Answers 



File Menu
New 
Open 
Close 
Save 
Save As 
Save All
Delete 
Summary Info 
Properties 
Preferences  
Exit



Edit Menu
Undo 
Repeat
Cut 
Copy 
Paste 
Mix 
Clear 
Select All 
Preview Cut
Paste to New 
Trim/Crop 
Crossfade 
Replace 
Replicate 
Data Format 
Go To 
Selection 
Disable Undo 



View Menu
Status Format 
Clipboard Contents 
Play Clipboard 
Zoom Selection 
Zoom Out Full 
Zoom In Full 
Maximize Width 
Edit Mode 
Magnify Mode 
Pencil Mode
Lock Region Length 
Snap to Time 
Snap to Zero Crossings 
Loop Tuner 



Special Menu
Transport 
Regions List 
Playlist 
Edit Sample 
Edit Frame Rate
Edit Tempo
Drop Marker
Mark In 
Mark Out 
Center Cursor
Toggle Selection 
MIDI Input Sync/Trigger 
MIDI Output Sync 
Pre-Queue for SMPTE/MTC
MIDI Triggers 



Process Menu
Auto Trim/Crop 
Swap Channels 
DC Offset 
Dither 8 Bit 
Fade Graphic 
Fade In 
Fade Out 
Insert Silence 
Invert/Flip 
Mute 
Normalize 
Pan Graphic 
Pan Left to Right 
Pan Right to Left 
Resample 
Reverse 
Smooth 
Time Compress/Expand 
Volume 



Effects Menu
Amplitude Modulation 
Chorus 
Delay/Echo 
Distortion 
Dynamics 
Envelope 
Flange 
Gapper/Snipper 
Noise Gate 
Pitch Bend 
Pitch Change 
Reverb 
Vibrato 



Tools Menu
ACM Filter 
Auto Region
FM Synthesis 
Graphic EQ 
Parametric EQ 
Sampler 
Search
Simple Synthesis 
Statistics 



Window Menu
New Window
Cascade 
Tile Horizontally 
Tile Vertically 
Arrange Icons 
Minimize All 
Close All 
Focus to Sample Window 
Regions List 
Playlist 
Keyboard 
Mixer 



New
The New command creates a new sound data window.

Channels
Check the button to select whether the new data will be mono or stereo.
Sample Size
Check the button to select whether the new data will be 8 bit or 16 bit.
Sample Rate
Select a standard sample rate from the drop down list box or type in a custom rate.
Maximum Editing Time
Shows the maximum time currently available on the hard drive for editing a file of the specified type.

Using the New toolbar button (or holding the shift key down while selecting New from the
menu) will skip the New dialog box and use the previously selected Mono/Stereo, 8 bit/16

bit, and Sample Rate settings.

Shortcut
Control+N
Drag and drop a selection to the Sound Forge desktop to create a new file from the selection.

                                                         
See also
File Menu
Creating a New Window
Drag and Drop Operations



Open
Use this command to load a sound file into Sound Forge.

File Name
Type the file name you want to open or a *. and an extension to see a list of files with the corresponding
extension in the current directory.
Files
Lists the files in the current directory of the type specified in the File Name box.
Drives
Lists available drives. Select a new drive from this combo box.
Directories
Lists available directories. Select a new directory from this list box.
List of File Types
Select the type of file you want to open. If you select All Types, Sound Forge will auto identify the 
format of a sound file if it can.
Read Only
When checked, the sound file will be opened but you will not be able to alter the sound data in the file. 
This feature is useful if you only need to play the file or copy sections from the file. You can still change 
the Regions List, Playlist, and Summary Information for the file, but these changes must be saved to a 
new file. 

Whenever you open a file in Sound Forge, a backup copy is created so that the original
file is not affected until you select to save your work. When you open a file as Read Only,
Sound Forge will not create a backup copy of the file, which makes opening files quicker

and uses less disk-space.

Play
Auditions the sound file without opening it in Sound Forge. If playing a file from a slow network or CD-
ROM, some skipping might occur.    This feature is only available for WAV files.

Shortcut
Control+O
Control+F12
Control+Alt+F2

                                                         
See also
File Menu
Opening an Existing File
Open raw data file
Installing the ACM



Open raw data file
This dialog box is reached when you select Raw from the List of File Types in the Open dialog. Use this 
to open a file that is not stored in one of the standard sound file formats supported by Sound Forge.

Name
List of preset formats available. To create your own format from the selected parameters, press Save 
As.
Sample Rate (2,000-60,000 Hz)
Sample playback rate which will be used by Sound Forge when playing the file.
Sample Type
Format used to store each sample.

8 Bit PCM
Uncompressed linear format.
16 Bit PCM
Uncompressed linear format.
G.711 u-Law
Compressed format commonly used for telecommunications in the United States.
G.711 A-Law
Compressed format commonly used for telecommunications in Europe.

Format (Unsigned, signed, sign bit)
Shows the sample format that the data is stored as. Samples are most often saved in the PCM format.
Channels (Mono/Stereo)
Number of channels, or tracks, stored in the file.
Byte Order (Little or Big Endian)
Order in which the high and low bytes of a 16-bit sample are stored. Little Endian is used by Intel 
microprocessors, while Big Endian is used by Motorola microprocessors.
Header Bytes
Number of bytes stored in the file before the sound data.
Trailer Bytes
Number of bytes stored in the file after the sound data.

                                                         
See also
File Menu



Close
Use this command to close the current sample data window. If the data has not been saved since the last 
edit you will be asked if you wish to save your changes.

                                                         
See also
File Menu
Saving a File
Close All



Save
Use this command to save the current sample data. If the data is new data which was not retrieved from a
previous file or was loaded from a format which is not supported for saving, you will be prompted with the 
Save As dialog box. The Macintosh Resource (SND) format is not supported for saving. If you need to 
export sound files to a Macintosh, use the Macintosh AIFF format.

Shortcut
Control+S
Shift+F12
Alt+Shift+F2

                                                         
See also
File Menu
Saving A File
Save As
Sound File Formats
Detail Fields



Save All
Use this command to save all the currently opened files.    You will be prompted for each unsaved file. If 
you hold the shift-key down when selecting this command, no prompts will be displayed.

                                                         
See also
File Menu



Save As
Use this command to save the current sample data in a different file and/or file format.    The Macintosh 
Resource (SND) format is not supported for saving. If you need to export sound files to a Macintosh, use 
the Macintosh AIFF format.

File Name
Type the name of the file in which you want to save the current sample.
Drives
Lists available drives. Select a new drive from this combo box.
Directories
Lists available directories. Select a new directory from this list box.
File Types
Select the type of file to which you would like to save.
Format
Shows the sample format in which the data will be saved. Samples are most often saved in the PCM 
format. However, other formats are often used for compression purposes. If you have the Microsoft 
Audio Compression Manager (ACM) installed, you can save files in a variety of compressed formats 
including the Microsoft ADPCM format.
When saving as a Raw file, other options are available after choosing OK in this dialog box.
Attributes
Sample Rate, sample size, and stereo/mono. Here, you can change the sample size (8 or 16 bit) that 
the file will be saved as. You can also convert a file between mono and stereo formats. When you 
convert from mono to stereo, the data will be stored in both channels. When converting from stereo to 
mono, the data will be mixed to a single channel.
Save Summary Information in file
Check if you want Summary information (such as author and copyright) stored in the WAV file.
Save Sampler Information in WAV file
Check if you want Sampler Information (such as note assignment and loops) saved in the WAV file.
Save Regions/Playlist Information in WAV file
Check if you want Regions and Playlist information stored in the WAV file.

Only data formats supported by the selected File Type are listed in the Format drop down
list box. Other file types are available when saving a file as Raw data.

Shortcut
Alt+F2
F12

                                                         
See also
File Menu
Saving A File
Converting Files
Embedding Text in WAV Files
Sound File Formats
Detail Fields



Save As Raw Data File
This dialog box is reached when you select Raw from the Format list in the Save dialog. Use this to save 
an opened file into a file format that is not one of the standard sound file formats supported by Sound 
Forge.

Name
This list of file formats contains preset versions of raw file storage formats commonly used by other 
applications. You can create a new file format by using the Save As button to save the current storage 
parameters.
Sample Type (8 Bit PCM, 16 Bit PCM, G.711 u-Law, G.711 A-Law)
Format used to store each sample.
Format (Unsigned, Signed, Sign bit)
Binary format of each sample. 
Channels (Mono/Stereo)
Number of channels, or tracks, stored in the file.
Byte Order (Little or Big Endian)
Order in which the high and low bytes of a 16-bit sample are stored. Little Endian (low, high) is used by 
Intel microprocessors, while Big Endian (high, low) is used by Motorola microprocessors.

                                                         
See also
File Menu
Saving A File



Delete
Use this command to delete a sound file from your hard drive.

File Name
Type the file name you want to delete or a *. and an extension to see a list of files with the 
corresponding extension in the current directory.
Files
Lists the files in the current directory of the type specified in the File Name box.
Drives
Lists available drives. Select a new drive from this combo box.
Directories
Lists available directories. Select a new directory from this list box.
File Types
Select the type of file you want to delete. This provides an easy way of setting the file extension.

                                                         
See also
File Menu



Properties
Use this command to see a list of information which is embedded in the selected sample file. See 
Appendix C for a list of Summary Information fields. To edit these fields, select Summary Information 
from the File menu. All the Summary Information fields are available when editing Microsoft WAV files. 
Other file formats may not store all of this information.

                                                         
See also
File Menu
Summary Information



Summary Information
Use this command to view and edit information embedded in the selected file. These fields are only 
available when editing Microsoft WAV files.

Title, Subject, Engineer, Comments
Commonly used fields you can quickly edit. To view and edit all other fields, press the Extended button.
Load
Sets all of the fields to the default values. The default values can be set in the Extended Summary  
dialog box.
Extended Summary
Allows you to view and edit all available summary fields. See Appendix C for a list of fields.

Fields
To edit a field, you must first select it from the Fields list. The check appearing to the left of the 
type tells whether this field is currently enabled for saving to the WAV file. If the check is not 
shown, the field will not be written to saved files. To change the state of the check, click with the 
left mouse button in the area immediately to the left of the type or double click on the entry.
If the field for a type currently has no text associated with it the word (Empty) will appear to the 
right of the type in the list box.    Empty fields are not saved.
Contents
Shows the text associated with the selected field. The text can be changed by typing in this box.
Default
Sets the default fields to the current file's field information. Use this to save information which will
be used in a number of different files, like copyright and engineer information at your recording 
site. 
Load
Sets the current file's summary information fields to the default settings.

Shortcut
Double click on the right-most field of the Status Bar
                                                         
See also
File Menu
Summary Information Fields



Preferences 
Many user configurable options are available in the Preferences dialog box. To select a preference folder,
simply click on the folder tab or use the TAB key to place the focus on the folder name and use the right 
or left arrow key to navigate through the folders. Available preference folders are:

General
Toolbars
Display
Wave Devices
MIDI and Sync
Storage
Status
Regions List and Playlist
Previews
More Preferences
                                                         
See also
File Menu



General Preferences
Use to select general user options.

Multiple select file open Default: Checked
Enabling this option allows you to select multiple files in the File Open dialog box. If you wish to be 
limited to opening one file at a time disable this check box.
If you are a system administrator you may want to disable this option for users who are new to 
Windows, who may be confused by a multiple selection file list box.
3D dialog and display effects Default: Checked
This option is used to enable or disable the 3D look of dialog boxes.
Confirm on close Default: Unchecked
Enabling this option forces Sound Forge to prompt you with a confirmation message box prior to exiting 
Sound Forge.
If you are a system administrator you may want to enable this option for users who are new to 
Windows, who may double click on the close box by accident.
Warn when Mix/Crossfade rates mismatch Default: Checked
Enabling this option tells Sound Forge to warn you with a dialog box prior to mixing or crossfading data 
which has different sample rates. Mixing or Crossfading data of different sample rates may produce 
unintended sounding results.
Disable Undo buffer creation by default Default: Unchecked
Enabling this option will keep Sound Forge from creating undo buffers for any operation which modifies 
a sound file. You are still able to turn the undo creation on by using the Disable Undo command (Edit 
Menu) for any window, but by default no undo buffers will be created.
Sector align data for Digidesign's Session 8 Default: Unchecked
This option is only necessary if you are using Sound Forge to modify files for use with Digidesign's 
Session 8. Enabling this option forces Sound Forge to align the data portion of WAV files on a sector 
boundary, which is needed when using WAV files with the Session 8.
Auto Power MIDI Keyboard window Default: Checked
Enabling this option tells Sound Forge to open up the MIDI device assigned to the keyboard (if it is not 
already open) when you press a key on the keyboard. You may want to disable this option if you are 
using the same MIDI output device for MIDI synchronization or for your sequencer. If this option is 
disabled you need to press the ON button on the keyboard prior to using the keyboard to send notes.
Save .VOC files using newest format Default: Unchecked
Prior to Creative Labs boards supporting the playback of 16 bit data, VOC files had no way of storing 16
bit audio data. With the addition of 16 bit playback sound boards to the Sound Blaster line of products a
newer version of the VOC file was created. With this option disabled Sound Forge will save all 8 bit files
in the old format and all 16 bit files in the new format. With this option enabled it will save all files in the 
new format. Only enable this option if you have software which requires the new format for 8-bit data.
Always open full-screen Default: Unchecked
Enabling this option forces Sound Forge to always open in full screen mode. If this option is disabled 
Sound Forge opens in the size and position it was in when it was last closed.
Ignore device capabilities in Mixer window Default: Unchecked
Normally, when Sound Forge loads audio devices found in the system, it checks to see if the drivers 
support volume control. Those devices which report that they do not support volume control are grayed 
in the Mixer devices list. However, some devices do not report their capabilities correctly. If this option is
enabled Sound Forge will ignore the device capabilities and attempt to set the levels for any device you 
select in the Mixer window.
Recently used file list Default: Enabled
This option allows you to set the number of recently used files which will appear in the File menu. If you 
do not wish to have any files listed in the File menu, uncheck the check box for this option.



Toolbars Preferences
Use to select which toolbars are displayed on the main screen. A check before the toolbar means that the 
toolbar is turned on. The following toolbars are available:

Standard Default: Checked
Contains standard file, and edit operations.
Transport Default: Checked
Contains record and play operations.
Navigation Default: Unchecked
Contains operations for navigating within the data window. Some of the operations included are 
Zooming, Marking, Moving the Cursor, and Moving to relevant points.
Views Default: Unchecked
Contains operations for storing and retrieving Data Window Views
Status/Selection Default: Unchecked
Contains operations to set the display Status Format as well as the Snap-To operations.
Regions/Playlist Default: Unchecked
Contains the Regions/Playlist buttons as well as synchronization commands and synchronization status
boxes.
Process Default: Unchecked
Contains all processing operations.
Effects Default: Unchecked
Contains all effect operations.
Tools Default: Unchecked
Contains all tool operations.
Show Tooltips Default: Checked
The Show Tooltips checkbox turns on or off the help information box displayed next to the mouse 
when it is held over certain items.



Display Preferences
Use to set your display preferences.

Max zoom ratio on open Default: 1:1,024
Specifies the maximum zoom magnification when loading a new sample file. This allows you to control 
the maximum data that will be shown in a data window when a file is loaded from the hard drive.    
Higher values show more data on initial file loading, which takes more time.
Wait cursor zoom ratio threshold Default: 1:32
Specifies the amount of zoom above which an hourglass cursor will be displayed between data window 
repaints. If the mouse cursor seems to flicker on and off a lot when redrawing wave data, you may want
to increase this value.
Show Axis in Waveform Display Default: On
Specifies whether the sample data window displays a set of horizontal axes indicating the volume of the
sample. Lines are drawn at volume levels of 0, 50, and 100% of the maximum value.
Color Preference for
The color preferences section allows you set a custom color for a variety of graphics within Sound 
Forge. Each graphic has a default color or you can set a custom color by checking the Custom box and
setting the component Red, Green, and Blue of each color.

Play Cursor
Specifies the color of the cursor which is drawn while playing a file.
Regions: Marker
Specifies the color used to display Marker tabs on the Data Window ruler.
Regions: Region
Specifies the color used to display Region tabs on the Data Window ruler.
Sample Loop: Sustaining
Specifies the color used to display Sustain loop tabs on the Data Window ruler.
Sample Loop: Release
Specifies the color used to display Release loop tabs on the Data Window ruler.
Wave Axis: Center
Specifies the colors used to draw the center line of the Wave Axis.
Wave Axis: Half
Specifies the color used to draw the line at half volume for the Wave Axis.
Wave Background
Specifies the colors used to draw the background of each Data Window.
Wave Data
Specifies the color used to draw the wave data in each Data Window.



Wave Devices Preferences
Use this folder to specify what wave devices Sound Forge should use for recording and playback. Note 
that the capabilities of these devices may limit you from playing some files.

Playback
Specifies the device to be used when playing sound data.
Selecting a mapper device such as the Wave Mapper or Microsoft Sound Mapper allows Windows to 
select an appropriate device to use for the current sound data.
Record
Specifies the device to be used when recording sound data.
Selecting a mapper device such as the Wave Mapper or Sound Mapper allows Windows to select an 
appropriate device to use for the current sound data.
Interpolate position between buffers Default: Off
Specifies whether Sound Forge should interpolate the position of the play position pointer during play 
back. If this option is not checked, Sound Forge relies on the device driver for the sound card to provide
the correct position of the pointer during playback.
Many sound cards do not report their position accurately so if the play position pointer does not move 
smoothly you should enable this option. If your sound card does not have accurate position reporting, 
your Drop Marker and Mark In/Out positions will also be off when dropping markers while playing.
Position bias Default: 0
Specifies an offset value which Sound Forge should add to the position values returned by the sound 
card wave driver during playback.
Many sound cards do not report their position accurately. When you play back sounds, if the position of 
the play pointer seems to lag or precede the actual sound you are hearing you will need to adjust this 
value. We have found that many sound cards report a value ahead of the actual sound. Some typical 
offset values for these cards are -2048, -4096, -8192, and -16384 (multiples of 1024). The best policy is
to start with smaller offset values and work towards larger ones until the play position pointer is 
accurate.
If your sound card does not have accurate position reporting then your Drop Marker and Mark In/Out 
positions will also be off when dropping markers while playing.
Show play counter Default: Checked
Specifies whether Sound Forge will show a running play counter during play back. A running play 
counter may affect performance on slower computers.
Show record counter Default: Checked
Specifies whether Sound Forge will show a running record length on the playbar during record. A 
running record length may affect performance on slower computers.
Buffer Alignment Default: 32,768
Select the alignment of data buffer blocks passed to the wave driver. This field should normally be set to
32,768 , but some drivers may be optimized to use smaller blocks. 
Total Buffer Size Default: 256 kb
Select the amount of RAM you would like to use for buffering sounds during play and record. Using a 
large value can optimize performance at high sample rates but may also cause a slight delay on 
playback.
Preload all buffers before starting playback Default: Unchecked
Setting this option will cause Sound Forge to load all buffer memory before starting the play operation. 
Turning this option on may improve performance.

When using the PC Speaker as a wave output device, the wave alignment should be set
at 2 kb and the Buffer Size should be set to 4 kb. Using large values for the PC Speaker

will hinder system responsiveness.





MIDI and Sync Preferences
Use to select MIDI and Synchronization user options.

Output
Specifies the MIDI output device for synchronization.
This device is the device used to send SMPTE/MTC when the MIDI Output Sync (Special menu) option
is enabled.
Input
Specifies the MIDI input device for synchronization and triggering.
This device is the device through which Sound Forge will receive all MIDI triggering and 
synchronization input when the MIDI Input Sync/Trigger (Special menu) option is enabled. This 
includes SMPTE/MTC, MIDI Triggers, and Regions/Playlist triggers.
Use 30 frames per second for SMPTE Non-Drop Default: Checked
Specifies whether all SMPTE Non-Drop calculations performed by Sound Forge use a frame rate of 30 
frames per second or 29.97 frames per second. You will only need to uncheck this option if you intend 
to work with Video which expects true 29.97 FPS SMPTE Non-Drop. Refer to Appendix H for a 
discussion of SMPTE issues.
Use PC Timer for SMPTE generation Default: Checked
Specifies whether Sound Forge should use the internal PC timer for SMPTE generation rather than 
position values reported by the sound card driver. Since many sound cards do not report their position 
accurately it is usually better to use the PC timer for SMPTE generation.
PC Timer resolution (2 - 32 milliseconds) Default: 4
Specifies the timer accuracy used for generating SMPTE when the Use PC Timer for SMPTE 
generation option is enabled. The lower the resolution value, the more accurate the SMPTE generation 
will be. However lower values may also decrease system performance.



Storage Preferences
Use to select file storage preferences.

Temporary Storage Directory
The specified directory is used to store temporary files used by Sound Forge.
Sound Forge stores its temporary data in a temporary directory on your hard drive. Using temporary file
space allows you to edit very large files and keeps Sound Forge from eating up large portions of RAM 
on your computer. Your temporary directory must have enough space to handle the total size of all files 
you plan to edit at one time along with space for any clipboard data and undo buffers. 
If you change the Temporary Directory, you will have to close Sound Forge for the change to take 
effect. 
Compress temporary files before saving. Default: Checked
When running effects or editing operations on sound files, the data within the files may grow or shrink 
depending on the operation. For example, when you do a Cut operation the data is moved within the file
but the file size is not actually reduced at that time. This helps to increase the speed of operations 
within Sound Forge. 
When this option is enabled, Sound Forge truncates all data files any time you attempt to save a file. 
This gives you more available storage space and allows you to save files when space on your hard 
drive is limited. If you have an overabundance of hard drive space you may improve performance of 
effect and edit operations by disabling this option.
Note that the temporary files are not compressed is the normal sense, only truncated. No loss of audio
quality will result from having this option checked.



Status Preferences
Use to select display status options.

Default SMPTE Format
Specifies the SMPTE type used when pressing the SMPTE button on the Status/Selection Toolbar.

Non-Drop 30 FPS (29.97 if option not checked)
Calculates status values using a 30 frames per second SMPTE code.
Drop 29.97 FPS
Calculates status values using a 29.97 frames per second SMPTE code. This is accomplished by 
dropping two frames every minute except for minutes 00, 10, 20, 30, 40, and 50.
Non Drop 29.97 FPS
Calculates status values using a 29.97 frames per second SMPTE code. Frame counting does 
not drop frames so no frame compensations are necessary for dropped frames.
EBU 25 FPS
Calculates status values using a 25 frames per second SMPTE code. This format is the European
Broadcast Union time code.
Film Sync 24 FPS
Calculates status values using a 24 frames per second SMPTE code. This format is for standard 
24 frames per second film media.

Default Time Format
Specifies the Time Format (seconds or milliseconds) used when pressing the Time button on the 
Status/Selection Toolbar.
Default Frames Per Second Default: 15.0
Specifies the default frame rate used to calculate frame values.
Frame values are useful when trying to synchronize sound with animation. Most animation players 
specify a playback frame rate at which video frames are shown to the user. If you are using an 
animation that has a frame rate of 15.0 frames per second, you would set the Frame rate to 15.0. When
status values are shown by Sound Forge they will be shown in values of frames. This allows you to find 
the frame to which a given point in the sound file corresponds.
Frame rates can be any value between 1.0 and 1,000.0 frames per second.
Default Beats Per Measure Default: 4
Specifies the number of beats in each measure for displaying in measures and beats. For example 2/4 
time would have two beats per measure.
Default Beats Per Minute Default: 120
Specifies the number of beats per minute, i.e. the tempo of a song for displaying lengths. For example a
tempo of 120 is 120 beats per minute.
Display format for SMPTE code Default: 00:00:00.00
Specifies how SMPTE values will be formatted for display by Sound Forge. Select one of the available 
preferences from the drop down list box.



More Preferences
Use to select miscellaneous user options.

Snap to Zero-crossing slope Default: Positive Slope
Specifies how zero crossings are detected.

Negative slope
Zero crossings are detected only on a negative slope. 
Positive slope
Zero crossings are detected only on a positive slope.
Any crossing
Zero crossings are detected on both positive and negative slopes.

It is usually best to use either the Positive or Negative slope setting for Zero crossings, so that 
noticeable pops and clicks are not generated by cutting data when using Snap to Zero crossings.
Default SDS channel (1-16) Default: 1
Specifies the channel used in MIDI Sample Dump Standard (SDS) packets when saving audio as an 
SDS file.
Default SDS patch (0-127) Default: 0
Specifies the patch used in SDS packets when saving audio as an SDS file.
Link to the Audio Compression Manager Default: Checked
Specifies whether the Audio Compression Manager should be used when loading compressed WAV 
files. Enabling this function allows you to read and write sound files which are in a compressed format 
as long as you have the ACM installed. For more information on the ACM refer to the chapter on the 
Microsoft Audio Compression Manager.



Regions List and Playlist Preferences
Use to select user options dealing with the Regions List and Playlist.

Regions List display format Default: Start and End
Specifies how the Regions are displayed within the Regions List.

Start and End
Regions are displayed with the start and end time of each region.
Start and Length
Regions are displayed with the start time and length of each region.

Playlist display format Default: Start and End
Specifies how the Regions are displayed within the Playlist.

Start Only
Regions are displayed with only the start time of each region.
Start and End
Regions are displayed with the start and end time of each region.
Start and Length
Regions are displayed with the start time and length of each region.

Sort Regions List alphabetically Default: Checked
Specifies whether regions are displayed in the Regions List in the order they were added or are sorted 
alphabetically.
Playlist pre-roll (0.0 - 300.0 seconds) Default: 0 seconds
When playing entries in the Playlist, this value specifies the amount of pre-roll which will be used. This 
allows you to easily hear the transition from one region to another without having to play all the way 
through the first region.



Preview Preferences
Preview preferences apply to all processing, effects, and tools which have the ability to play a preview. 
You can also modify preview options within any dialog box which has preview by clicking on the system 
box of the dialog box and selecting the Preview Configuration option.

Limit previews to (1 - 30 seconds) Default: 2 Seconds
Specifies the length of audio which will be used when generating a preview. Keeping this value small 
lowers the amount of time needed to generate a preview when tuning effects or process values.
Fade out last 10 milliseconds (snap/pop eliminator) Default: Checked
Enabling this option tells Sound Forge to fade out the last 10 milliseconds of a preview effect so that 
large pops are not heard at the end of a preview buffer. With this option disabled, a preview could end 
with a large data value which can cause an audible and annoying pop.
Loop preview continuously Default: Unchecked
Enabling this option causes preview buffers to loop infinitely rather than playing just a single time. This 
can be useful when listening to the difference between the original sound and the sound after and effect
or process has been applied.
Cut preview configuration
When using the Preview Cut function in the edit menu, the Pre-roll and Post-roll times specify the 
amount of audio data that is played prior to and after the data which is to be cut.

Pre-roll (0.0 - 30.0 seconds) Default: 1 Second
Specifies the amount of data played prior to a cut region.
Post-roll (0.0 - 30.0 seconds) Default: 1 Second
Specifies the amount of data played after a cut region.



Storage Directory
The selected directory will be used to store temporary files used by Sound Forge.



Exit
Use this command to exit Sound Forge. You will be asked whether you would like to save any samples 
you have modified during the editing session.

                                                         
See also
File Menu



Undo
Use this command to undo the last edit operation. For instance, if you deleted a section of data by 
accident, simply choose the Undo option from the Edit menu to put the data back.

Tips
When working on large files, it takes Sound Forge a longer period of time to create an undo buffer. To 
save time and file space, you can disable the undo. This is done by selecting the Disable Undo item 
under the Edit menu.

Shortcut
Control+Z
Alt+Backspace

                                                         
See also
Edit Menu
Copy, Paste, Cut, and Undo



Cut
Use this command to remove selected sample data and put it onto the clipboard. This command has no 
effect if there is no selected data. Cutting sample data replaces the previous contents of the clipboard.    
To hear what the cut will sound like before without altering the data, use Preview Cut.

Note: You cannot cut from a single channel in a stereo file since the two channels in a stereo file must 
always be equal in length.

Shortcut
Control+X
Control+Del

                                                         
See also
Edit Menu
Copy, Paste, Cut, and Undo



Copy
Use this command to copy selected sample data onto the clipboard. This command has no effect if there 
is no selected data.

Shortcut
Control+C
Control+Insert

                                                         
See also
Edit Menu
Copy, Paste, Cut, and Undo



Paste
Use this command to insert a copy of the clipboard contents at the current insertion point. If there is a 
selection made, the Paste command deletes the selected data before inserting.

Note: This command has no effect if the clipboard is empty. Pasting data of different sample rates will 
cause the data in the clipboard to play at the same rate as the rate of the window in which the data is 
pasted. Pasting into a stereo file will insert data to both channels since the channels in a stereo file must 
always be equal in length.

Shortcut
Control+V
Shift+Insert
Drag and drop a selection to another data window + Alt

                                                         
See also
Edit Menu
Copy, Paste, Cut, and Undo
Drag and Drop Operations



Mix
Use this command to mix a copy of the clipboard contents with the sample data. The mix start point is 
either the cursor point or the start or end of the selection in the destination Data Window.

Source Volume (0-100%)
Gain applied to the source data before mixing with destination data.
Destination Volume (0-100%)
Gain applied to the destination data before mixing with source data.
Invert Data (On/Off)
Use to invert the amplitude of the source or destination data.
Start Mix At (Start of Selection, End of Selection)
When there is a selection in the destination data window, you have the option of performing the mix 
starting at the beginning or end of the selection.    When no selection is present, the data is always 
mixed starting at the cursor position.
Apply destination volume to overlapping area only (On/Off)
When off, the Destination Volume gain is applied to the entire destination sound file.    Otherwise, the 
Destination Volume gain is applied to only where the destination and source data are mixed.
Pre-Post-fade destination edges (0 - 5 seconds/Off)
Use this to apply a fade to the destination data before and after the mixing region.    The Pre-fade time 
determines the fade time before the mix start, while the Post-fade time determines the fade-time after 
the mix end.
For example, when mixing vocals over a music track, you can have the music track fade before and 
after the region where vocals are mixed, so that the vocals are more pronounced. This technique is 
sometimes referred to as ducking.

Note: This command has no effect if the clipboard is empty. Mixing data of different sample rates will 
cause the data on the clipboard to play at the same rate as that in the current sample with which the data 
is mixed.

Shortcut
Control+M
Drag and drop a selection from the source to the destination data window.

                                                         
See also
Edit Menu
Drag and Drop Operations
Simple Mixing
Advanced Mixing Options



Clear
Use this command to remove selected sample data without copying it onto the clipboard.

Note: You cannot clear data from a single channel in a stereo file since the two channels in a stereo file 
must always be equal in length. This command has no effect if there is no selected data.

Shortcut
Delete

                                                         
See also
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Select All
Use this command to select all data in the current data window.

Shortcut
Control+A
Control+Numpad 5
Double clicking the left mouse button in the Waveform Display will select all data.

                                                         
See also:
Edit Menu



Paste to New
Use this command to create a new data window which contains the contents of the clipboard.

Shortcut
Control+E
Drag and drop a selection to the Sound Forge workspace to create a new file from the selection.

                                                         
See also
Edit Menu
Drag and Drop Operations



Trim/Crop
Use this command to remove all data from the sample except the selected data. This command has no 
effect if there is no selected data.

Trimming/Cropping sample data does not copy data onto the clipboard.

                                                         
See also
Edit Menu
Cropping data



Crossfade
Use this command to crossfade a copy of the clipboard contents with the sample data.    The crossfade 
start point is either the cursor point or the start or end of the selection in the destination file.

The crossfade operation is similar to a mix, except that you can apply a linear fade to the source and 
destination data.    It is commonly used as a transition between one sound segment to another.

When applying a crossfade, you often want to fade out (100 to 0%) the destination data and fade in the 
source (0 to 100%) data starting near the end of the destination file.    Linear fades are applied only to the 
area where the destination and source files overlap following the crossfade start point.    Any extra source 
data is appended at the end of the destination file.

Source Start/End Level (0-100%)
Determines the linear fade applied to the source data before mixing with the destination.    A gain equal 
to the Source End Level is applied to the source data when appending to the end the source file.
Destination Start/End Level (0-100%)
Determines the linear fade applied to the destination data. Any destination data following the crossfade 
end point is not affected.
Start crossfade at (Start of Selection, End of Selection)
If there is no selection in the destination data window, the linear fade starts at the insertion point. When 
there is a selection in the destination data window, the linear fade can begin at the start or end of the 
destination selection.

Note: Crossfading data of different sample rates will cause the data on the clipboard to play at the same 
rate as that in the current sample with which the data is crossfaded.    This command has no effect if the 
clipboard is empty.

When using drag and drop crossfading, make sure that the Control key is down when releasing the 
mouse button.    When dealing with mono and stereo data, crossfading will occur on the channel which the
selection is dropped to (Left, Right, or Both).

Shortcut
Control+F
Drag and drop a selection from the source to the destination Data Window while holding the Control key.   
Make sure that you don't start the drag with the Control key down, otherwise you will switch to Magnify 
Mode. The Control key must be down when you release (drop) the selection.

                                                         
See also
Edit Menu
Drag and Drop Operations



Replace
Use this command to replace an area of sample data with the contents of the clipboard.

The Replace command replaces data using the following rules:

- If an area is selected which is greater than the length of the clipboard, the data from the beginning of
the selection is replaced for the length of the clipboard.

- If an area is selected which is less than or equal to the length of the clipboard, the data within the 
selection is replaced with the clipboard for the length of the selection.

The replace command is useful when you are trying to replace silent sections of audio with background 
noise.

Shortcut
Control+H

                                                         
See also
Edit Menu



Repeat
Use this command to repeat the last performed operation. This can be used with most processing 
functions.    The last dialog settings will be used unless you hold down the shift key, which allows you to 
change the operation's dialog parameters.

Shortcut
Control+Y to repeat last operation with the last used dialog box options
Control+Shift+Y allows you to change the dialog settings before repeating

                                                         
See also
Edit Menu
Processing Shortcuts



Replicate
Use this command to copy multiple copies of the clipboard to the current data window.

The Replicate command will copy as many copies of the clipboard as will fit to a selected area. If no 
selection is currently made in the data window, the function will have no effect. 

Copy Partials
Selecting the Copy Partials button will fill the selected region completely, using a partial copy of the 
clipboard if needed.
Whole Copies
Selecting this option will use only whole copies of the clipboard, and will not fill the selected region 
completely if its length is not an exact multiple of the clipboard length.

Example:

1. Copy a 1 second sample onto the clipboard.
2. Insert a 5.5 second silence sample in the data wave form.
3. Select the 5.5 second area and select Replicate.
4. If you choose Whole Copies, 5 copies of the clipboard will be placed in the area the silence 
previously occupied and 0.5 seconds of silence will remain at the end.
5. If you choose Copy Partials, 5.5 copies of the clipboard will be placed in the data rather than just 5. 
No silence will remain.

The replicate command is useful when you are trying to replace silent sections of audio with background 
noise. It can also be used to introduce stuttering effects or echoes.

                                                         
See also
Edit Menu



Data Format
Use this command to change the data format of the current data window. This includes sample rate, 
sample size (bits per sample), and stereo/mono.

Sample Size
Select 8 or 16 bit for the sample size.
Channels
Select mono or stereo for the number of channels.
Sample Rate
The playback rate can be set from 2,000 Hz to 60,000 Hz by entering the rate you wish to use. You may
also select the most common sample rates by using the drop down list. 

Shortcut
Alt+Enter
Waveform Display Shortcut menu
Status Bar Shortcut menu

                                                         
See also
Edit Menu
Shortcut Menus
Editing Sound Formats



Go To
Use this command to set the cursor to a particular location in the sample.

Go To
Provides preset locations to pick from.
Position (0 - Sample Length)
The position where the cursor will be moved can be specified here.
Input Format
Determines the input format that will be used to enter the position.

If you have a selection, you can switch the cursor between selection points with the ` key
(reverse quote, normally above Tab key). You can also switch the cursor between

selection points by holding the Control key while selecting the Go to Start or Go to End
buttons in the Playbar or Transport toolbar.

Shortcut
Control+G
F5
Waveform Display Shortcut menu
Selection Status Bar
Left click on the Overview to move cursor position.

                                                         
See also
Edit Menu
Shortcut Menus
Using Go To



Selection
Use this command to change the start, end, length, or channel of the selection.

Selection
Provides preset regions to pick from.
Start (0 - Sample Length)
The start point of the selection is specified here.
End (Start - End)
The end point of the selection is specified here.
Length (0 - Sample Length)
The start point of the selection is specified here.
Channel (Left, Right, Both)
If the sample is stereo, you can specify which channel of the sample will be selected.
Input Format
Determines the input format that will be used to enter the Start, End, and Length.

Shortcut
Control+D
Waveform Display Shortcut menu
Selection Status Bar

                                                         
See also
Edit Menu
Shortcut Menus
Advanced Editing and Navigation



Status Format
Use this command to set the status format.    Possible formats are:

Samples
Seconds
Milliseconds
Frames
Beats
SMPTE Drop
SMPTE Non-Drop
SMPTE EBU
SMPTE Film Sync

Shortcut
Playbar Selection Status Shortcut menu

                                                         
See also
View Menu
Using Status Formats
Shortcut Menus
Status Preferences



Samples
Use this command to set the status format to samples.
                                                         
See also
View Menu
Using Status Formats
Status Formats



Seconds
Use this command to set the status format to seconds.
                                                         
See also
View Menu
Using Status Formats
Status Formats



Milliseconds
Use this command to set the status format to milliseconds.
                                                         
See also
View Menu
Using Status Formats
Status Formats



Frames
Use this command to set the status format to frames.
                                                         
See also
View Menu
Using Status Formats
Status Formats



Beats
Use this command to set the status format to beats.
                                                         
See also
View Menu
Using Status Formats
Status Formats



SMPTE Drop
Use this command to set the status format to SMPTE Drop (29.97 fps).
                                                         
See also
View Menu
Using Status Formats
Status Formats



SMPTE Non-Drop
Use this command to set the status format to SMPTE Non-Drop (30 or 29.97 fps).
                                                         
See also
View Menu
Using Status Formats
Status Formats



SMPTE EBU
Use this command to set the status format to SMPTE EBU (25 fps).
                                                         
See also
View Menu
Using Status Formats
Status Formats



SMPTE Film Sync
Use this command to set the status format to SMPTE Film Sync (24 fps).
                                                         
See also
View Menu
Using Status Formats
Status Formats



Clipboard Contents
Use this command to display information on the current contents of the clipboard. Information includes, 
size, sample rate, number of channels, and bits per sample. If no data is in the clipboard you will be 
notified with a message box.

                                                         
See also
View Menu



Play Clipboard
Use this command to hear the current contents of the clipboard. This command has no effect if there is no
data in the clipboard.

                                                         
See also
View Menu



Zoom Selection
Use this command to maximize a selected area in the data window.

The Zoom Selection command will calculate the maximum zoom factor for the size of a selection area, 
draw the data at this zoom factor, and left justify the data in the data window.

To zoom in and out by small increments, you can use the up and down arrow keys or the
Zoom In/Out buttons on the lower right hand side of the Data Window.

Shortcut
Control+Up arrow (when a selection is active)
Waveform Display Shortcut menu

                                                         
See also
View Menu
Magnification and Zooming



Zoom Out Full
Use this command to minimize the data magnification and if possible, fit the whole sample in the data 
window. To zoom in and out by small increments, you can use the up and down arrow keys.

Shortcut
Control+Down arrow
Waveform Display Shortcut menu

                                                         
See also
View Menu
Magnification and Zooming



Zoom In Full
Use this command to maximize the data magnification to 1 sample per pixel. To zoom in and out by small 
increments, you can use the up and down arrow keys.

Shortcut
Control+Up arrow (when no selection is active)
Waveform Display Shortcut menu

                                                         
See also
View Menu



Maximize Width
Use this to maximize the width of the selected window.

Shortcut
Control+Enter
Maximize Width button on lower-right hand side of the data window.

                                                         
See also
View Menu



Edit Mode
Use this mode for normal editing.

                                                         
See also
View Menu



Magnify Mode
Use this mode to zoom in to a particular region without losing your selection. While in Magnify Mode, 
when you make a selection Sound Forge will draw a dotted rectangle around an area and will magnify the
selected area when the mouse button is released.    To return to normal editing, select Edit Mode from the 
View menu.

Shortcut
While in any mode, if you hold the Control key down before making a selection with the mouse, you will 
switch to Magnify Mode. This is handy for quickly magnifying a particular section of your sound file.

                                                         
See also
View Menu
Magnification and Zooming



Pencil Mode
Use this mode used to edit the waveform by drawing on it. For example, if you have a glitch in the 
sample, zoom in to the glitch and smoothly re-draw the waveform using the pencil tool. Pencil mode is 
only available when operating at magnification levels between 1:1 and 1:16. To return to normal editing, 
select Edit Mode from the View menu.

                                                         
See also
View Menu



Snap to Time
When on, selections and cursor positions are always rounded to the nearest unit of time length.

See also
View Menu



Snap to Zero Crossings
When on, selections are always moved outward to the nearest zero crossing. This is useful for avoiding 
clicks and pops which often result when edits are made while the waveform has a high amplitude, causing
abrupt discontinuities in the waveform.

Shortcut
Control+B

                                                         
See also
View Menu



Loop Tuner
Use this to turn the Loop Tuner window on and off.

                                                         
See also
View Menu
Sample Tools



Lock Region Length
Use this to have the length of a region remain constant when changing the start or end time of a region or
loop.

Shortcut
Holding the Control key down while dragging Ruler Tabs also locks the length of a region or loop.

                                                         
See also
View Menu
Using the Loop Tuner



Transport

Record
Play All
Play
Pause
Stop
Start
End
Play Normal Mode
Play Looped Mode
Play Sample Mode

                                                         
See also
Special Menu



Play All
Use this function to play the entire sample file from beginning to end, regardless of cursor position, 
selection, or Playlist.

Shortcut
Shift+Spacebar

                                                         
See also
Special Menu



Play
Playback file in current playback mode (Normal Mode, Looped Mode, or Sample Mode)

Shortcut
Spacebar
Right-click on Overview

                                                         
See also
Special Menu



Pause
Stop playback and keep cursor at the stop point.

Shortcut
Shift+Spacebar
Enter
Right-click on Overview during playback

                                                         
See also
Special Menu



Stop
Stop playback and return the cursor to its position prior to playback.

Shortcut
Spacebar (during playback)

                                                         
See also
Special Menu



Start
Move the cursor to the start of file.

Shortcut
Control+Home

                                                         
See also
Special Menu



End
Move the cursor to the end of file.

Shortcut
Control+End

                                                         
See also
Special Menu



Preview Cut
Use this command to playback the entire file except for the selected region.    This lets you preview the 
result of a Cut operation without altering the file.
                                                         
See also
Edit Menu



Play Normal Mode
Sets Playback mode to Normal Mode. When Play is selected while in this mode:

· If there is no selection, playback occurs from the cursor to end of file. 

· If there is a selection, playback occurs from the beginning of the selection to the end of the 
selection.
Shortcut
To switch between playback modes, use Control+Spacebar

                                                         
See also
Special Menu



Play Looped Mode
Sets Playback mode to Looped Mode. When Play is selected while in this mode:

· If there is no selection, the entire sample is played in an endless loop.

· If there is a selection, the selection is played in an endless loop.
Shortcut
To switch between playback modes, use Control+Spacebar

                                                         
See also
Special Menu



Play Sample Mode
Sets Playback mode to Sample Mode. When Play is selected while in this mode, the file is played with 
the sustain and release loops repeating a set number of times. Use this to listen to a sample as it would 
sound when played by a sampler.

Shortcut
To switch between playback modes, use Control+Spacebar

                                                         
See also
Special Menu



Record
Use this function to record to an existing or new data window.

The Record and Record Remote dialogs are always destructive and contain no
Undo capabilities. To prevent accidentally recording over sound data, record into a new
or scratch data window and paste the takes you want to keep into the desired sound data

window.

The following is a list of all controls available in the record dialog.

New
This button allows you to create a new data window for recording.
Close
Press this button to exit record mode.
Remote
Press this button to enter Remote Recording mode. This mode will hide the main Sound Forge Window 
and show only the Record Remote dialog box (a condensed version of the Record dialog). This allows 
you to easily record while using other components of your system like a CD player, mixer, or sequencer.
Go To
Pressing this button displays the Go To dialog for selecting a Start position. This option is not available 
in Punch In mode.
Selection
Pressing this button displays the Set Selection dialog for selection a Region. This option is only 
available in Punch In mode.
Window
Pressing the window button allows you to select the data window into which you will record.
Mode
Selects the current recording mode. Modes are as follows:

Automatic Retake
This mode begins recording at the specified Start position and replaces any sound data that 
already exists after that position. When recording is stopped, the Start position is automatically 
rewound to the original starting position.
Multiple Takes with Regions
This mode begins recording at the specified Start position and replaces any sound data that 
already exists after that position. When recording is stopped, the Start position is set to ending 
position of the take. Additionally, a unique Region is created in the Regions List that marks the 
take. To review a take using the Play button, press the REW button to rewind the Start position to
the beginning of the take then press Play. Pressing the FWD button will set the Start position to 
the end of the take in preparation for the next take.
Multiple Takes (no Regions)
This mode is exactly the same as the Multiple Takes with Regions mode with the exception that 
no Regions are created for takes.
Punch In
This mode is used to record over the top of an existing region of sound. This allows you to record 
a portion of a previous take without recording a whole new file.

Start
Displays the position where recording will begin.
End
Displays the position where recording will end (this value is inclusive).
Length
Displays the length to record.



Input format
Use this to change how the Start, End, and Length values are entered and displayed as well as the 
display of Time Recorded and Time Left on Drive values.
Monitor (On/Off)
Select this checkbox to monitor the level of the input signal. This option can be enabled at any time. 
The meters light up as a function of the volume of the recording input. For best results the level should 
be somewhere in the yellow range with an occasional red. This button also activates the Peak and 
Margin values. The Peak value shows the maximum input level recorded since the last Reset was 
invoked. The Margin value shows the percentage the input level can be increased prior to clipping. If 
the Peak value reaches 100% (and the Margin value reaches 0%), clipping has occurred.
Reset
Resets the Peak and Margin values back to their initial states.
Prepare
Pressing the prepare button prepares your system for recording. This means that the record device is 
opened and all preparation that can be done prior to recording is completed. This allows the system to 
begin recording as quickly as possible after the Record button is pressed. You do not need to use the 
prepare button unless you are trying to begin recording immediately after pressing the Record button.
Record
Pressing the record button starts recording. If recording has been Prepared, then recording starts 
immediately. If recording has not been Prepared, Sound Forge attempts to start recording as quickly as 
possible; a small delay may occur.
Play
Pressing the play button allows you to hear a section of data over which you are going to record or 
which you have just recorded. This allows you to keep recording until you get the correct take.
RTZ
Return To Zero (RTZ) sets the Start position to the beginning of the sound data. This option is not 
available in Punch In mode.
REW
Rewind (REW) sets the Start position to the beginning of the most recent take. This option is not 
available in Punch In mode.
FWD
Forward (FWD) sets the Start position to the end of the most recent take. This option is not available in 
Punch In mode.
GTE
Go To End (GTE) sets the Start position to the end of the sound data. This option is not available in 
Punch In mode.
Review pre/post-roll
These two edit boxes specify the amount of time which will be played prior to and after regions when 
reviewing a take.

Shortcut
Control-R

                                                         
See also
Special Menu
Using Recording



Record to New
To record to a new window, choose the New button in the Record dialog. The New Window dialog will be 
presented allowing you to select the attributes for the new window. Holding the Shift key down when 
selecting the New button will bypass the New Window dialog and create a window using the last used 
attributes.

Shortcut
Control+Shift+R

See also
Special Menu
Recording basics



Regions List
Add
Delete
Modify
Replicate
Update
Clear
Copy to Clipboard
                                                         
See also
Special Menu
The Playlist and Regions List



Add to Regions List
Use this function to add a selection to the Regions List.

Shortcut
Drag and drop selection to Regions List
Ruler Shortcut menu

                                                         
See also
Special Menu
Shortcut Menus



Delete Region from Regions List
Use this function to delete a region from the Regions List.

Shortcut
In the Regions List, select a region and press Delete
Region Tag Shortcut menu

                                                         
See also
Special Menu
Shortcut Menus



Edit Regions List
Use this function to modify a region in the Regions List.

Name
Name of the region, which can be up to 255 characters long.
Type (Marker/Region)
A Marker is a single point, a region is a start and end point, and has an associated length.
Start, End, Length, Input Format
Use to change the selection. Sound Forge automatically fills in the values depending on your selection 
or cursor position.
Trigger
Use if you want to trigger a region or marker using MIDI commands.
Note On - Play
The region will be played when the specified note on message is received and will play for the full 
length of the region.
Note On - Play / Note Off - Stop
The region will be played when the specified note on message is received and will stop when either the 
full region is played or the specified note off message is received.
Note On - Queue / Note Off - Play
The region will be queued for play when the specified note on message is received and will play when 
the corresponding note off message is received. This is used to reduce the time between receiving a 
trigger and playing a region.
Channel
Determines the MIDI input channel for triggering.
Note
Determines the MIDI note that will trigger region playback. This value can be entered as either a MIDI 
note value such as C5 or as a MIDI note number such as 60.
If you have the MIDI Input Sync/Trigger mode enabled while using this dialog box, you can auto fill the
Channel and Note values by pressing a key on your MIDI keyboard.

Shortcut
Region Tag Shortcut menu
Region List Shortcut menu
Press Enter when a region in the Regions List has focus
Double click on a region in the Regions List

                                                         
See also
Special Menu
Shortcut Menus
The Playlist and Regions List



Replicate Region in Regions List
Use this function to create a new copy of the marker/region.

Shortcut
Region List Shortcut menu

                                                         
See also
Special Menu
Shortcut Menus



Update Region
Use this function to change the current marker/region location to match the current cursor/selection. 

Shortcut
Region Tag Shortcut menu
Region List Shortcut menu

                                                         
See also
Special Menu
Shortcut Menus



Clear Regions List
Use this function to remove all markers/regions from the Regions List.

                                                         
See also
Special Menu



Copy Regions List to Clipboard
Use this function to copy the text of the Regions List into the clipboard for use with a text editor.

Shortcut
Region List Shortcut menu

                                                         
See also
Special Menu



Playlist
Add
Delete
Replicate
Edit
Clear
Stop Point
Pre-Roll on Playback
Copy to Clipboard
Convert to File
                                                         
See also
Special Menu
The Playlist and Regions List



Add Section to Playlist
Use this function to add a region to the Playlist.

Shortcut
Drag and drop a region from the Regions List to the Playlist.
Playlist Shortcut menu

                                                         
See also
Special Menu



Delete Section from Playlist
Use this function to delete a region from the Playlist.

Shortcut
Press the Delete key when a region has focus in the Playlist.
Playlist Shortcut menu

                                                         
See also
Special Menu



Replicate Section in Playlist
Use this command to create a new copy of the region.

Shortcut
Playlist Shortcut menu

                                                         
See also
Special Menu



Clear Playlist
Use this function to remove all markers/regions from the Regions List.

                                                         
See also
Special Menu



Stop Point
Use this command to place a stop point on the region. Sound Forge stops playback within the Playlist 
whenever a stop point is reached.

Shortcut
Playlist Shortcut menu
* (asterisk) when a Playlist region has focus

                                                         
See also
Special Menu



Pre-Roll on Playback
When on, playback from the Playlist begins at the specified time prior to the selected start point in the 
Playlist. The amount of Pre-Roll time can also be set in the Playlist/Region List Preferences folder.

For example, say you have two regions, Region 1 and Region 2 in the Playlist. If you have the Pre-Roll 
time set to 0.5 seconds, when you start playback of the Playlist from Region 2, the last 0.5 seconds of 
Region 1 will be played back before starting with Region 2. This allows you to hear the transition between 
the two regions.

Shortcut
Playlist Shortcut menu
/ (backwards slash) when a Playlist region has focus

                                                         
See also
Special Menu



Copy Playlist Text to Clipboard
Use this command to copy the text of the Playlist onto the clipboard for use with a text editor.

Shortcut
Playlist Shortcut menu

See also
Special Menu



Convert to New
Use this command to create a new sample file which contains the regions arranged sequentially as 
specified in the Playlist.

Shortcut
Playlist Shortcut menu

                                                         
See also
Special Menu



Edit Playlist Section
Use this function to add or modify a region in the Playlist.

Name
The name of the region in the Playlist that is being modified
Play Count
The number of times the Playlist region will repeat before continuing on the next region in the play list. 
Setting this value to 0 will cause the region to be skipped during playback.
Trigger
The method with which the Playlist region will be invoked (triggered) when you have the MIDI Input 
Sync/Trigger mode enabled.
Channel
If the Playlist region is being triggered by a MIDI note, this will be the receive channel for that region.
Note
If the Playlist region is being triggered by a MIDI note, this is the MIDI note number that will trigger this 
Playlist region. This value can be entered as either a MIDI note value such as C5 or as a MIDI note 
number such as 60.
If you have the MIDI Input Sync/Trigger mode enabled while using this dialog box, you can auto fill the
Channel and Note values by pressing a key on your MIDI keyboard.
SMPTE
If the Playlist region is being triggered from a SMPTE time cue, this is the point in SMPTE time that will 
trigger the Playlist region.
Pre-roll playback
When checked sets the number of seconds of pre-roll from the end of the prior Playlist region that will 
be heard when starting the Playlist sequence from this Playlist region.

Shortcut
Playlist Shortcut menu
Double click on a region in the Playlist
Press Enter when a region in the Playlist has focus

                                                         
See also
Special Menu
The Playlist and Regions List



MIDI Triggers
MIDI Triggers are used to control several Sound Forge functions using MIDI commands from external 
devices such as a MIDI keyboard or sequencer. Triggers can be either MIDI Note-On/Off or Controller 
commands. For Sound Forge to trigger, the MIDI Input Sync/Trigger option (Special menu) must be 
enabled.

Name
The name of the user defined MIDI Trigger setup. You can save the current configuration using the 
Save as button.
Event window 
The Event window displays the available trigger operations in Sound Forge and, if enabled, triggering 
information. Selecting an event allows you to edit its trigger information.

Event
The operation which will be performed by Sound Forge when a trigger is received.
Trigger
The specific note or controller that will evoke the event it is assigned to.
Channel
The MIDI channel the trigger is associated that will evoke the event.

Trigger (None, Note, Controller)
This is where you enter the above information upon selecting an Event in the Event window.

None
Used to select no MIDI trigger for the selected event.
Note
Determines the selected event will be triggered by a MIDI note.
Controller
Determines the selected event will be a MIDI controller.

Channel (1-16)
The channel the controller or trigger is assigned to.
Controller/Note (0-127)
The MIDI controller being assigned, if a controller is selected. The MIDI note if note is selected.
Value (0-127)
The value the controller must reach in order to evoke the event.

Note: MIDI Triggers are different from triggers in the Playlist and Regions List. When using triggers in the 
Playlist, Regions List, or MIDI Triggers, be aware that they can interact with each other to create 
unexpected results. Sound Forge first looks at the MIDI Triggers, then the Regions List, and then the 
Playlist when determining what to do when a MIDI command is detected.

If you have the MIDI Input Sync/Trigger mode enabled while in the MIDI Triggers dialog
box, you can auto fill the Channel, Note, and Controller values by pressing a key or

controller on your MIDI keyboard.

                                                         
See also
Special Menu



MIDI Input Sync/Trigger
When MIDI Input Sync/Trigger is turned on, Sound Forge can be triggered from MIDI commands received
through the MIDI Input Port. The MIDI Input Port is specified in the MIDI/Sync folder under Preferences 
(File Menu).

When this option is off, the MIDI Triggers, Regions List triggers, and Playlist triggers specified will not be 
enabled. When this option is on dialog boxes which specify MIDI triggers will also accept input from the 
MIDI Input Port, allowing easy entry of MIDI Note and Controller values.

                                                         
See also
Special Menu
MIDI and SMPTE Synchronization



MIDI Output Sync
Selecting this item will enable Sound Forge to send MIDI Time Code out the MIDI output port. The MIDI 
Output Port is specified in the MIDI/Sync Folder under Preferences (File menu).

                                                         
See also
Special Menu
MIDI and SMPTE Synchronization



Drop Marker
The Drop Marker command is a way to mark positions in a sound file. You can drop a marker at the 
current cursor position while editing or on the fly during file playback. It is much easier to create a marker 
from the toolbar or by pressing 'M' on the keyboard rather than the menu (as this would be difficult to 
coordinate on the fly). Markers can be quickly selected from the list in the Go To dialog box located in the 
same menu/button bar. Also, markers are placed in the Regions List for quick playback.

Note: There is usually a very small delay between the time when you select Drop Marker and when the 
marker is actually created. Using the keyboard shortcut 'M' gives the fastest response, and thus the 
highest accuracy. 

Depending on the sound card you are using, there might be an offset error between what you hear and 
where the cursor is at. To correct this, go into the Wave folder in the Preferences Folder and use the 
Position Bias to correct for the sound card driver's offset error. 

Some sound cards do not return position information to Sound Forge very efficiently. If the cursor moves 
in large chunks during playback, check the Interpolate position between buffers to allow Sound Forge 
to estimate where the sound card playback is occurring.

Shortcut
M
\ (backward slash)

                                                         
See also
Special Menu
Using Markers



Center Cursor
Selecting this item will center the display so that the cursor appears in the center of the data window. This
item does not actually move the cursor to a new position in the data display, it simply redraws the display 
so that you will now see the areas of the sound file equally on either side of the cursor. If the cursor does 
not seem to center when selecting this, it is because the cursor is either very close to the beginning or 
end of the sound file, and therefore cannot be centered.

If you have a selection, you can switch the cursor between selection points with the ` key
(reverse quote, usually above the Tab key). You can also switch the cursor between

selection points by holding the Control key while selecting the Go to Start or Go to End
buttons in the Playbar or Transport toolbar.

Shortcut
. (period)
* (asterisk)

                                                         
See also
Special Menu



Pre-Queue for SMPTE/MTC
Selecting this item will make Sound Forge open the wave device and pre-load data of the next region to 
be played in the Playlist. This is a good measure to take to insure that audio will begin playing the 
moment the designated SMPTE time is detected by Sound Forge when synchronizing to MTC. This 
keeps the time between triggering and playback to a minimum.

This option is automatically disabled when any other audio command is used such as Play, Stop, or 
Record.

                                                         
See also
Special Menu



Mark In
This item is similar to Drop Marker function. It will allow you to mark the In point of a new selection while 
the sound file is playing back. You can also use this as a method of marking the In point of a new 
selection while editing by moving the cursor to where you want the selection to start.. This is a good way 
to accurately set the start of a selection. For greatest accuracy you should use the keyboard shortcut
key '[' when Marking In during playback.

Shortcut
[ (left square bracket)

                                                         
See also
Special Menu
Using Markers
Mark Out



Mark Out
Use this function to create a Mark Out point of a new selection. Mark In and Mark Out are used to 
determine a selection, and can be used during playback. For greatest accuracy you should use the 
keyboard shortcut key ']' when Marking Out during playback.

Shortcut
] (right square bracket)

                                                         
See also
Special Menu
Using Markers
Mark In



Toggle Selection
By using the Backspace key (or this menu item), you can toggle back and forth between the last selection
and last cursor position. For instance, you may be setting the cursor in various places while navigating 
throughout a sound file. If you then hit Backspace, the last selected region will immediately return to the 
display. 

Shortcut
Backspace
',' (comma)

                                                         
See also
Special Menu



Edit Sample
Use this command to change sample parameters.

Sample Type (One Shot, Sustaining, Sustaining with Release)
Selecting one of these choices will determine how the sample is played back. 

One Shot The sample will play normally (as it appears) with no loops.
Sustaining The sample will repeat the sustain-loop region the specified number of times.
Sustaining with Release The sample will repeat the sustain-loop region, play the region 
between the sustain and release loop and then repeat the release-loop region.

Loop (Sustain, Release)
Use to select the loop currently being edited.
Loop Count (1-999, infinite)
Number of times that the sustain or release loop will be repeated before continuing playback. This 
information may or may not affect how your sampler plays the data. By specifying a finite loop count it is
easier to hear how transitions between loops and normal data will sound.
Start, End, Length, Input Format
Use to change the position and length of the loop.
MIDI Unity Note
This is the MIDI note that will cause a sampler to play the sample at the pitch (sample rate) it was 
originally recorded.
Fine Tune
Some samplers will utilize this information to adjust the pitch (sample rate) of the sample. Sound Forge 
does not fine-tune the sample itself when this option is utilized. This option is an information type setting
that will be transmitted to a sampler via a sample transfer procedure. A sampler such as the K2000 can 
use this information for its playback of the sample. The K2000 should accurately display this information
on Master/Sample/Misc. page, it appears as Pitch Adjust, just below Root Key Number. 
SMPTE Offset/Format
Some sampler editors store a SMPTE Offset value in the sample. Sound Forge ignores this offset 
value. If you want to add SMPTE Offset information to your sample, choose a SMPTE Format from the 
Format list and type in an offset value. Otherwise leave the Format option to No Offset.

Shortcut
Ruler Shortcut menu
Loop Tag Shortcut menu
Drag and drop a selection to the ruler to create a new loop

                                                         
See also
Special Menu
Sampler Tools



Disable Undo
Use this command to prevent Sound Forge from creating temporary files used for undoing operations. 
Since creating undo files takes time and disk space, it is sometimes more convenient to have the Disable 
Undo option on, especially when working with large files.

Remember to turn the Disable Undo feature off when you wish to be able to undo operations.

Note: Since Sound Forge never works on the original file (it always makes a work copy), you can always 
recover it by re-opening it. However, saved changes are permanent.

Shortcut
Control+U

                                                         
See also
Special Menu



Edit Tempo
Use this command to automatically calculate the musical tempo (Beats Per Minute) from the current 
selection. Sound Forge uses the current tempo to display measures in the Ruler and in the Auto Region 
tool. 

To use the Edit Tempo function, first make a selection in the Waveform Display. The selection made 
should be equal in size (or integer multiple) to the length of a beat or measure. The easiest way to tune a 
selection to be exactly one measure long is to play the selection looped and change the selection points 
until a constant downbeat is heard.

Type (Beat/Measure)
Choose whether the current selection in the Waveform Display is one beat or one measure long.
Start, End, Length, Input format
Determines the selection used to calculate the tempo.
Beats per measure (1-32)
Use to specify the number of beats in a measure when selecting a measure (i.e. 4 for most pop music 
out there). It can also be used to specify beats per selection length if the selection is larger than one 
measure.
Beats per minute (1.00-1000.00)
This tempo value is calculated by Sound Forge depending on your selection length, selection type 
(measure or beats), and Beats per Measure. 
Play
Press to preview the selected section which will be used for tempo calculation.
Play Looped
Enables/disables playing the selected section in a continuous loop.

Note: The default tempo can be changed in the Status Folder of the Preferences dialog box. 

                                                         
See also
Special Menu



Edit Frame Rate
Use this command to change the frames per second value used by Sound Forge for status information. 

                                                         
See also
Special Menu



New Window
Use this command to create a new data window. The new window will be given a generic name. This 
command uses the sound parameters from when the File New command was last used.

Shortcut
Control+Shift+N

See also
Window Menu



Cascade
Use this command to arrange the data windows so they overlap with the title bar of each window 
remaining visible.

Shortcut
Shift+F5

                                                         
See also
Window Menu



Tile Horizontally
Use this command to arrange the data windows side by side without them overlapping.

                                                         
See also
Window Menu



Tile Vertically
Use this command to arrange the data windows top to bottom without them overlapping.

Shortcut
Shift+F4

                                                         
See also
Window Menu



Arrange Icons
Use this command to arrange the minimized data icons in the Sound Forge workspace.

                                                         
See also
Window Menu



Minimize All
Use this command to minimize all open data windows in the Sound Forge workspace.

                                                         
See also
Window Menu



Close All
Use this command to close all open data windows in the Sound Forge workspace.

                                                         
See also
Window Menu



Focus to Sample Window
Use this function to return the screen focus to the sample data window. This is does the same operation 
as left-clicking anywhere on the data window.

Shortcut
Alt+0

                                                         
See also
Window Menu



Regions List
Use this to turn on or off the Regions List Window.    

Shortcut
Alt+1 to turn on or set focus.

                                                         
See also
Window Menu
The Playlist and Regions List



Playlist
Use this to turn on or off the Playlist Window.

Shortcut
Alt+2 to turn on or set focus.

                                                         
See also
Window Menu
The Playlist and Regions List



Keyboard
Use this to turn on or off the Keyboard Window.

Shortcut
Alt+3 to turn on or set focus.

                                                         
See also
Window Menu
The Sonic Foundry MIDI Keyboard



Mixer
Use this to turn on or off the Mixer Window. The Mixer allows you to control the Wave (digital audio) and 
MIDI (synthesizer) output volume level of sound cards that support this feature. The    Auxiliary fader can 
be used to control a number of different parameters, such as CD-ROM output level or Recording Level. 
Not all sound cards support mixing control.

To select a device, right-click on Wave, MIDI or Aux.    You can then choose from a list of available devices
from the corresponding Shortcut menu. Grayed items represent devices that are present but do not 
support Mixer functionality.

Most sound cards contain custom mixer applications for controlling how a sound card behaves. These 
custom mixers are usually much better suited to setting levels on your sound card than Sound Forges 
Mixer window, but are often not as convenient.

Shortcut
Alt+4 to turn on or set focus.

                                                         
See also
Window Menu
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Keyboard Shortcuts
The following is a comprehensive list of keyboard shortcuts available in Sound Forge.

General Keyboard Shortcuts
File Commands
Press To
Alt+Shift+Enter Show the Properties dialog for the active data window.
Control+N Create a new data window.
Control+O Open a sound file into a new data window.
Control+S Save modified sample data back to the file.
Control+W Close the active data window.
Alt+F4 Exit Sound Forge.

Window Management Commands
Press To
Alt+0 Set input focus to Waveform Display in active window.
Alt+1 Set input focus to the Regions List.
Alt+2 Set input focus to the Playlist.
Alt+3 Set input focus to the Shortcut MIDI Keyboard.
Alt+4 Set input focus to the Shortcut Audio Device Mixer.
Alt+F5 Restore the Sound Forge application window.
Alt+F10 Maximize the Sound Forge application window.
Control+F5 Restore the active data window.
Control+F6 Go to the next data window.
Control+F10 Maximize the active data window.
Control+Shift+F6 Go to the previous data window.
Shift+F4 Tile the data windows horizontally.
Shift+F5 Cascade the data windows.

Edit Commands
Press To
Control+A Select all data in the active window.
Control+C Copy the selected data onto the Clipboard.
Control+E Paste Clipboard contents into a new data window.
Control+F Crossfade data from the Clipboard with the active window.
Control+H Replace selection with Clipboard contents.
Control+K Preview Cut or Clear in the active window.
Control+M Mix data from the Clipboard with the active window.
Control+T Trim (crop) to the current selection.
Control+U Toggle Undo buffer creation for the active window.
Control+V Paste data from the Clipboard into the active window.
Control+X Move (cut) the selected data onto the Clipboard.
Control+Y Repeat last Process, Effect or Tool.
Control+Z Undo the last action.
Delete Clear (delete) the selected data; nothing placed on the Clipboard.

Miscellaneous, View and Special Commands
Press To
Alt+Enter Show the Data Format dialog box for the active data window.
Backspace Toggle current selection on and off.
Control+B Toggle Snap to Zero Crossing on and off for active data window.
Control+Enter Maximize the width of the active data window.
Control+D Show the Set Selection dialog box.
Control+G Show the Go To dialog box.
Control+L Show the Loop Tuner for the active data window.
Control+R Record new data into a data window.
Escape Stop or cancel the current action (including playback).
F1 Open the Sound Forge Help file to the Contents page.
F10 Make the menu bar active.
Shift+F10 Display a shortcut menu.

Waveform Display Keyboard Shortcuts
Cursor Movement
Press To move to
Right Arrow The next screen pixel.
Left Arrow The previous screen pixel.



End The last sample visible in the Waveform Display.
Home The first sample visible in the Waveform Display.
Control+End The last sample in the data window.
Control+Home The first sample in the data window.
Page Up 10% of the current view past the cursor position.
Page Down 10% of the current view previous to the cursor position.
Control+Right Arrow 2% of the current view past the cursor position.
Control+Left Arrow 2% of the current view previous to the cursor position.
Numpad + The next sample.
Numpad - The previous sample.
Control+Numpad + 10 samples past the current cursor.
Control+Numpad - 10 samples previous to the current cursor.

Selecting Data
Press To select from cursor to
Shift+Right Arrow The next screen pixel.
Shift+Left Arrow The previous screen pixel.
Shift+End The last sample visible in the Waveform Display.
Shift+Home The first sample visible in the Waveform Display.
Control+Shift+End The last sample in the data window.
Control+Shift+Home The first sample in the data window.
Shift+Page Up 10% of the current view past the cursor position.
Shift+Page Down 10% of the current view previous to the cursor position.
Control+Shift+Right Arrow 2% of the current view past the cursor position.
Control+Shift+Left Arrow 2% of the current view previous to the cursor position.
Shift+Numpad + The next sample.
Shift+Numpad - The previous sample.
Control+Shift+Numpad + 10 samples past the current cursor.
Control+Shift+Numpad - 10 samples previous to the current cursor.

Navigation and Playback
Press To
Control+<Number> Save view in cell <Number>. <Number> ranges from 1 to 8.
<Number> Restore view using cell <Number>. <Number> ranges from 1 to 8.
Up Arrow Increase magnification (zoom in closer to data).
Down Arrow Decrease magnification (zoom out farther from data).
Control+Up Arrow Zoom Selection if selection, Zoom In Full if no selection.
Control+Down Arrow Zoom Out Full (or to Zoom on Open resolution).
Numpad 5 or * Switch cursor to opposite end of selection
Tab Cycle stereo selection from left channel to right channel to both channels
Shift+Tab Cycle stereo selection from both channels to right channel to left channel.
[ (open bracket) Set Mark In at current cursor position.
] (open bracket) Set Mark Out at current cursor position.
M or \ (backslash) Drop a Marker at current cursor position.
. (period) Center cursor in Waveform Display.
Spacebar Play or Stop current data window in default mode.
Shift+Spacebar Play All or Pause current data window.
Control+Spacebar Switch play mode between Normal, Looped and As Sample.
Enter Pause playback; keep cursor at current position.
Escape Stop playback of current data window.

Regions List and Playlist Keyboard Shortcuts
Regions List Shortcuts
Press To
Spacebar Play or Stop the active Marker or Region.
Enter Edit the active Marker or Region.
Delete Delete the active Marker or Region.
` (grave accent) Cycle through the Regions List display formats.

Playlist Shortcuts
Press To
Spacebar Play (stop) from the active Playlist entry.
Enter Edit the active Playlist entry.
Delete Delete the active Playlist entry.
+ (plus sign) Add one to the active Playlist entry play count.
- (minus sign) Subtract one from the active Playlist entry play count.
* (asterisk) Add or remove a Stop Point on the active Playlist entry.
/ (forward slash) Toggle Pre-roll on and off for the Playlist.
` (grave accent) Cycle through the Playlist display formats.





Shortcut Menus
Shortcut menus are menus that appear when you click on certain areas of the screen. They allow you to 
quickly access important functions.

Waveform Display Shortcut Menu
This Shortcut menu is reached by right clicking on the Waveform Display of a sound file. It is a way of 
quickly reaching the following commands and dialogs: Zoom Selection, Zoom Out Full, Cut, Copy, 
Replace, Trim/Crop, Data Format, Go To, Edit Selection .

Playbar Selection Status Shortcut Menu
This Shortcut menu is reached by right-clicking on any of the Playbar's selection status fields. It allows 
you to set the current status format.

Regions List Shortcut Menu
This Shortcut menu is reached by right-clicking on the Regions List. It allows you to perform the following 
Regions List operations: Add, Delete, Edit, Replicate, Update, Copy to Clipboard.

Playlist Shortcut Menu
This Shortcut menu is reached by right-clicking on the Playlist. It allows you to perform the following 
Playlist operations: Add, Delete, Edit, Replicate, Stop Point, Pre-Roll Playback, Copy onto Clipboard, 
Convert to New.

Ruler Shortcut Menu
This Shortcut menu is reached by right-clicking on the Ruler. It allows you to reach the Add 
Marker/Region or Edit Sample dialog for adding regions, markers, and loop points.

Marker Tag Shortcut Menu
This Shortcut menu is reached by right-clicking on a marker tag in the Ruler.

Region Tag Shortcut Menu
This Shortcut menu is reached by right-clicking on a region tag in the Ruler.

Loop Tag Shortcut Menu
This Shortcut menu is reached by right-clicking on a loop tag in the Ruler. 

Status Bar Shortcut Menus
These Shortcut menus allow you to change the playback rate, sample size, channels (Stereo/mono), and 
status format by right clicking on the status bar fields.

Mixer Wave and MIDI Shortcut Menus
This Shortcut menu is reached by right or left-clicking on the Wave, MIDI, or Aux headings in the Mixer 
window. They allow you to select the Wave, MIDI, or Auxiliary device that the volume fader controls.

Keyboard MIDI Out Shortcut Menu
This Shortcut menu is reached by right or left-clicking on the MIDI Out button on the Keyboard. It allows 
you to set the device to which the MIDI keyboard will transmit.



Drag and drop shortcuts
Using Drag-and-Drop allows you to quickly perform operations between open data windows, the Playlist, 
the Regions list, and the Ruler.

Drag to New
To create a new file from the current selection, drag the selection to an open area of the Sound Forge 
desktop.

Drag Mix
To mix a selection into another data window, set the mix start point in the destination window and then 
drag the selection from the source to the destination window. When mixing a mono selection into a stereo 
file, you can mix the selection to both channels by dropping the selection on the destination centerline. 
Otherwise, the selection will be mixed into either the left or right channel only.

Drag Crossfade
To crossfade a selection into another data window, set the crossfade start point in the destination window 
and then drag the selection from the source to the destination window while pressing the Control key. 
When crossfading a mono selection into a stereo file, you can crossfade the selection to both channels by
dropping the selection on the destination centerline. Otherwise, the selection will be crossfaded into either
the left or right channel only.

Drag Paste
To paste a selection into another data window, set the paste start point in the destination window and then
drag the selection from the source to the destination window while pressing the Alt key. When pasting a 
mono selection into a stereo file, you can paste the selection to both channels by dropping the selection 
on the destination centerline. Otherwise, the sound data will be placed in either the left or right channel 
only, with silence in the other.

Drag to Regions List
To add the current selection to the Regions List, simply drag it to the Regions List.

Drag to Playlist
To add a region in the Regions List to the Playlist, drag it from the Regions List to the Playlist.

Drag to Ruler
To create a loop, drag the current selection to the Ruler. If a loop already exists, you can change the loop 
points by holding the shift key down when dropping the selection in the ruler.



Other Mouse Shortcuts
Select All
Double-click on the Waveform Display to select the entire sound file.

Magnify Mode
To zoom in to a section, select an area while holding the Control key. This will switch Sound Forge to 
Magnify Mode, which zooms to fit the selected area.

Edit Sample
Double-click on the Ruler to reach the Edit Sample dialog.

Return control value to default
Double-click on a slider or fader to set it to its default value.

Preview
Shift-click on the Preview button to hear the original sound. This is equivalent to checking the Bypass 
check box.

Control-click on the Preview button to reach the Preview Configuration dialog.

Main Status Bar
Double-click on the sample rate, sample size, or channels (stereo/mono) field to reach the Data Format 
dialog. Double-click on the file size field to reach the Summary Information dialog.

Selection Status Bar
Double-click on left-most field to reach the Go To dialog. Double-click on the other two fields to reach the 
Set Selection dialog.

Go To Marker
Double-click on a Marker tag in the Ruler to move the cursor to the marker's position.

Set selection to region/loop
Double-click on a Region or Loop tag in the Ruler to change the current selection to the region or loop 
end-points.

Edit region or Marker
Double-click on a region or Marker in the Regions List to reach the Edit Region/Marker dialog.

Edit Playlist
Double click on a Playlist entry to reach the Edit Playlist dialog.
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ADPCM
Adaptive Delta Pulse Code Modulation (ADPCM) is a method of compression audio data. Although the 
theory for compression using ADPCM is standard, there are many different algorithms employed. As an 
example, Microsofts ADPCM algorithm is not compatible with the International Multimedia Associations 
(IMA) approved ADPCM.



A-Law
A-Law is a companded compression algorithm for voice signals defined by the Geneva 
Recommendations (G.711). The G.711 recommendation defines A-Law as a method of encoding 16-bit 
PCM signals into a non-linear 8-bit format. The algorithm is commonly used in United States 
telecommunications. A-Law is very similar to µ-Law, however, each uses a slightly different coder and 
decoder.



Aliasing
Aliasing is a type of distortion that occurs when digitally recording high frequencies with a low sample 
rate. For example, in a motion picture, when a car's wheels appear to slowly spin backwards while the car
is quickly moving forward you are seeing the effects of aliasing. Similarly when you try to record a 
frequency greater than one half of the sampling rate (the Nyquist Frequency), instead of hearing a high 
pitch you may hear a low frequency rumble.

To prevent aliasing, an anti-aliasing filter is used to remove high-frequencies before recording. Once the
sound has been recorded, aliasing distortion is impossible to remove without also removing other 
frequencies from the sound.



Amplitude Modulation
Amplitude Modulation (AM) is a process whereby the amplitude (loudness) of a sound is varied over time.
When varied slowly, a tremolo effect occurs. If the frequency of modulation is high, many side frequencies
are created which can strongly alter the timbre of a sound.



Attack
The attack of a sound is the initial portion of the sound. Percussive sounds (like drums, piano, guitar 
plucks) are said to have a fast attack. This means that the sound reaches its maximum amplitude in a 
very short time. Sounds that slowly swell up in volume (soft strings and wind sounds) are said to have a 
slow attack.



Audio Compression Manager (ACM)
The Audio Compression Manager (ACM) from Microsoft is a standard interface for audio compression 
and signal processing for Windows. The ACM can be used by Windows programs to compress and 
decompress WAV files, as well as apply DSP algorithms to audio data.



Bit
A bit is the most elementary unit in digital systems. Its value can only be 1 or 0, corresponding to a 
voltage in an electronic circuit. Bits are used to represent values in the binary numbering system. As an 
example, the 8 bit binary number 10011010 represents the unsigned value of 154 in the decimal system. 
In digital sampling, a binary number is used to store individual sound levels, called samples.



Bit Depth
Bit Depth refers to the number of bits used to represent a sample. For example 8 bit and 16 bit are two 
common Bit Depths. Sound Forge uses the term Sample Size when referring to Bit Depth.



Byte
A byte refers to a set of 8 bits. An 8 bit sample requires one byte of memory to store, while a 16 bit 
sample takes two bytes of memory to store.



Clipboard
The clipboard is where sample data is saved when you cut it from a sample so that you may past it or mix
it into another sample.    Sound Forge maintains it's own clipboard for cutting and pasting sample data 
allowing you to keep memory usage to a minimum.    However, this does not change the normal operation 
of the clipboard and you can still cut and paste between Sound Forge and other Windows applications.



Clipping
Clipping is what occurs when the amplitude of a sound is above the maximum allowed recording level. In 
digital systems, clipping is seen as a clamping of the data to a maximum value, such as 32,767 in 16 bit 
data. Clipping causes sound to distort.



Cutoff-frequency
The cutoff-frequency of a filter is the frequency at which the filter changes its response. For example, in a 
lowpass filter, frequencies greater than the cutoff frequency are attenuated while frequencies less than 
the cutoff frequency are not affected.



CODEC
Acronym for Coder/Decoder. Commonly used when working with data compression.



Data Window
Each opened sound file in Sound Forge has its own Data Window. On top of each Data Window is a Title 
Bar displaying either the title of the sample or the name of the file. Also in each Data Window are the 
Waveform Display, Ruler, Playbar and other tools that give you information and allow you to navigate 
throughout the entire sound file.



Decibel
The decibel (abbreviated as dB) is a unit used to represent a ratio between two numbers using a 
logarithmic scale. For example, when comparing the numbers 14 and 7, you could say 14 is two times 
greater than the number 7; or you could say 14 is 3 dB greater than number 7. Where did we pull that 3 
dB from? Engineers use the equation dB = 10 x log (P1/P2) when comparing two measurements of power
and dB = 20 x log (V1/V2) when comparing instantaneous values. Decibels are commonly used when 
dealing with sound because the ear perceives loudness ratios in a logarithmic scale.

In Sound Forge, most measurements are given as a percentage. For example, if you want to double the 
amplitude of a sound, you apply a 200% gain. A sample value of 32,767 (maximum positive sample value 
for 16 bit sound) can be referred to as having a value of 100%. Likewise, a sample value of 16,384 can be
referred to having a value of 50%.

Decibels are used by Sound Forge in a few places. One is to represent Root Mean Square (RMS) values 
(found in the Statistics Tool) as a fraction of the maximum amplitude sine wave RMS power. For example,
a sine wave with an amplitude of 100% is said to have a 0 dB RMS power, while a 50% amplitude sine 
wave is said to have an RMS power of -3 dB.



Device Driver
A Device Driver is a program that allows Windows or DOS to connect different hardware and software 
together. For example, a sound card device driver is used by Windows software to control sound card 
recording and playback.



Digital Signal Processing
Digital Signal Processing (DSP) is a very general term describing anything that alters digital data. Signal 
processors have existed for a very long time (tone controls, distortion boxes, wah-wah pedals) in the 
analog (electrical) domain. Digital Signal Processors alter the data after it has been digitized by using a 
combination of programming and mathematical techniques. DSP techniques are used to perform many 
effects such as equalization and reverb simulation.

Since most DSP is performed with simple arithmetic operations (additions and multiplications), both your 
computer's processor and specialized DSP chips can be used to perform any DSP operation. The 
difference is that DSP chips are optimized specifically for mathematical functions while your computer's 
microprocessor is not. This results in a difference in processing speed.



Drag-and-Drop
Drag-and-Drop is a quick way to perform certain operations using the mouse in Sound Forge. To Drag-
and-Drop, you click and hold a highlighted selection, drag it (hold the left-mouse button down and move 
the mouse) and drop it (let go of the mouse button) at another position on the screen. For more 
information on where you can use Drag-and-Drop, look in Appendix A: Shortcuts.



Dynamic Range
Dynamic Range is the difference between the maximum and minimum signal levels. It can refer to a 
musical performance (high volume vs. low volume signals) or to electrical equipment (peak level before 
distortion vs. noise floor). For example, orchestral music has a wide dynamic range while thrash metal 
has a very small (always loud) range.



File Format
A file format specifies the way in which data is stored on your floppy disks or hard drive. In Windows, the 
most common file format is the Microsoft WAV format. However, Sound Forge can read and write to many
other file formats so you can maintain compatibility with other software and hardware configurations.



Frequency Modulation
Frequency Modulation (FM) is a process whereby the frequency (pitch) of a sound is varied over time. 
Slow frequency modulation results in pitch-bending effects. Fast frequency modulation creates many 
different side-band frequencies.



Frequency Spectrum
The Frequency Spectrum of a signal refers to its range of frequencies. In audio, the frequency range is 
basically 20 Hz to 20,000 Hz. The frequency spectrum sometimes refers to the distribution of these 
frequencies. For example, bass-heavy sounds have a large frequency content in the low end (20 Hz - 200
Hz) of the spectrum.



Insertion Point
The Insertion Point is like the cursor in a word processor.    It is where pasted data will be placed or other 
data may be inserted depending on the operation.    The Insertion Point appears as a vertical flashing 
black line and can be moved by clicking the left mouse button any where in the data window.



MCI
The Media Control Interface (MCI) is a standard way for Windows programs to communicate with 
multimedia devices like sound cards and CD players. If a device has a MCI device driver, it can be easily 
controlled by most multimedia Windows software.



Media Player
Media Player is a Windows 3.1 program that can play digital sounds or videos using MCI devices. Media 
Player is useful for testing your sound card setup. For example, if you can't hear a sound play through 
your sound card in Sound Forge, try using Media Player. If you can't play the sound using Media Player, 
check the sound card's manual (do not call Sonic Foundry's Technical Support until you've called the 
sound card manufacturer).



MIDI
Musical Instrument Device Interface (MIDI) is a standardized way for music equipment to communicate. 
Technically, it is a serial communications protocol using a 31.25 kHz baud rate.    MIDI is used to send 
control, timing, and data information between devices for things like triggering notes, time 
synchronization, and sample dumps.



MTC
MIDI Time Code (MTC) is an addendum to the MIDI 1.0 Specification and provides a way to specify 
absolute time for synchronizing MIDI capable applications.



Nyquist Frequency
The Nyquist Frequency (or Nyquist Rate) is one half of the sample rate and represents the highest 
frequency that can be recorded using the sample rate without aliasing. For example, the Nyquist 
Frequency of 44,100 Hz is 22,050 Hz. Any frequencies higher than 22,050 Hz will produce aliasing 
distortion in the sample if no anti-aliasing filter is used while recording.



Overview
The Overview is the area on the Data Window directly under the Title Bar. The entire length of the 
Overview represents the entire sound file. Cursor, selection, and position information is shown relative to 
the entire length of the sound file.



Playbar
The Playbar is the bar at the bottom of each Data Window.    On the left of the Playbar are the following 
buttons: Go To Start, Go To End, Stop, Play Normal, Play Loop, Play Sample.    On the right are the 
Selection Status Fields which display the selection start, end, and length.



Root Mean Square
The Root Mean Square (RMS) of a sound is a measurement of the intensity of the sound over a period of 
time. The RMS power of a sound corresponds to the loudness perceived by a listener when measured 
over small chunks of time.



Ruler
The Ruler is the area on a Data Window above the Waveform Display. It shows the horizontal axis units 
as well as Marker, Region, and Loop tags.



Ruler Tags
Ruler Tags are the icons on the Ruler which represent the location of Markers, Regions, and Loop points 
in the Waveform Display.



Sample Dump
A Sample Dump is the process of transferring sample data between music equipment. Because of the 
large amounts of data required to store digital sound, sample dumps may take a very long time when 
using the MIDI Sample Dump Standard (SDS). However, when using the faster SCSI MIDI Device 
Interface (SMDI) protocol, sample dumps can be performed many times faster.



SDS
The MIDI Sample Dump Standard (SDS) is a way to transfer samples between music equipment. 
Samples transferred with SDS are sent across MIDI cables at the MIDI data rate of 31.25 kHz baud. The 
slow data rate of MIDI makes SDS a painful experience when transferring large samples. SMDI is a much
preferred sample transfer method for musicians.



Sampled Sound
Sampled sounds are sounds which have been recorded in a digital format and saved on your system for 
playback through a sound board. A sampled sound is sometimes referred to as a sample. However, a 
sample can also refer to a single point in a sampled sound.



Sampler
A sampler is a device that records sounds digitally. Although, in theory, your sound card is a sampler, the 
term usually refers to a device used to trigger and playback samples while changing the sample pitch.



Sample Rate
The Sample Rate (also referred to as the Sampling Rate or Sampling Frequency) is the number of 
samples per second used to store a sound. High sample rates, such as 44,100 Hz provide higher fidelity 
than lower sample rates, such as 11,025 Hz. However, more storage space is required when using higher
sample rates.



Sample Size
The Sample Size, or Bit Depth,    refers to the number of bits used to represent a single sample. Sound 
Forge uses either 8 or 16 bit samples. While 8 bit samples take up less memory (and hard disk space), 
they are inherently noisier than 16 bit samples.



Shortcut Menu
A Shortcut menu, also called a Shortcut menu, is a context sensitive menu which appears when you click 
on certain areas of the screen. The functions available in the Shortcut menu depend on the object being 
clicked on as well as the state of the program. As with any menu, you can select an item from the 
Shortcut menu to perform an operation. Shortcut menus are used frequently in Sound Forge for quick 
access to many commands. An example of a Shortcut menu can be found by right clicking on any 
Waveform Display in a Data Window.



Sign-Bit
Data that has positive and negative values and uses zero to represent silence. Unlike the Signed format, 
twos complement is not used. Instead, negative values are represented by setting the highest bit of the 
binary number to one without complementing all other bits. This is a format option when opening and 
saving RAW sound files.



Signed
Data that has positive and negative values and uses zero to represent silence. This is a format option 
when opening and saving RAW sound files.



SMDI
SCSI MIDI Device Interface (SMDI) is a standardized protocol for music equipment to communicate. 
Instead of using the slower standard MIDI serial protocol, it uses a SCSI bus for transferring information. 
Because of its speed, SMDI is often used for sample dumps.



SMPTE
The Society of Motion Picture and Television Engineers time code.    This code is used to synchronize 
time between devices.    The time code is calculated in Hours:Minutes:Second:Frames, where Frames are
1/30 of a second.



Status Bar
The Status Bar is the bar at the bottom of the Sound Forge main screen.    The Status Bar fields on the 
right of the Status Bar contain information about the active Data Window (Sample Rate, Sample Size, 
Stereo/Mono, Total Size).    On the right side of the Status Bar, help and processing information is 
displayed.



Tempo
Tempo is the rhythmic rate of a musical composition, usually specified in Beats Per Minute (BPM).



u-Law
u-Law (mu-Law) is a companded compression algorithm for voice signals defined by the Geneva 
Recommendations (G.711). The G.711 recommendation defines µ-Law as a method of encoding 16-bit 
PCM signals into a non-linear 8-bit format. The algorithm is commonly used in European and Asian 
telecommunications. µ-Law is very similar to A-Law, however, each uses a slightly different coder and 
decoder.



Unsigned
Data that has only positive values and uses half the maximum value to represent silence. This is a format 
option when opening and saving RAW sound files.



Virtual MIDI Router (VMR)
A Virtual MIDI Router (VMR) is a software only router for MIDI data between programs. No MIDI hardware
or cables are required for a VMR, so routing can only be performed between programs running on the 
same PC. A VMR is normally used to synchronize two MIDI capable programs (for example, a VMR 
allows Sound Forge to drive a sequencer with SMPTE/MTC). Sonic Foundry supplies a VMR with Sound 
Forge called the Sonic Foundry Virtual MIDI Router.



Waveform
A Waveform is the visual representation of wave-like phenomena, such as sound or light. For example, 
when the amplitude of sound pressure is graphed over time, pressure variations usually form a smooth 
waveform. The Waveform Display in each Data Window represents exactly this.



Waveform Display
The Waveform Display is the part of the Data Window which shows a graph of the sound data waveform. 
The vertical axis corresponds to the amplitude of the wave. For 16 bit sounds, the amplitude range is -
32,768 to +32,767. For 8 bit sounds, the range is -128 to +127. The horizontal axis corresponds to time, 
with the left most point being the start of the waveform. In memory, the horizontal axis corresponds to the 
number of samples from the start of the sound file.



Zero Crossing
A Zero-Crossing is the point where a fluctuating signal crosses the zero amplitude axis. By making edits 
at zero crossings with the same slope, the chance of creating glitches is minimized.



Zipper noise
Zipper noise occurs when you apply a changing gain to a signal, such as when fading out. If the gain 
does not change in small enough increments, zipper noise can become very noticeable. Sound Forge's 
fades are accomplished using 64-bit arithmetic, thereby creating no audible zipper noise.



Temporary File Cleanup
If for some reason Sound Forge is terminated improperly (this occurs when Sound Forge or, most likely, 
another program crashes),    all the opened and unsaved sound files can be recovered.    Sound Forge 
never works directly on the original file until you select to save your work.    Instead, temporary files are 
created and any edits made are stored in these files.    When an improper termination of the program 
occurs, these temporary files remain in your hard disk and can be reopened to recover any work done to 
the sound files before crashing.    Also, the original sound files will remain unchanged until you save your 
work.

When starting the program, any temporary files detected in your temporary file directory are an indication 
that something went wrong.    Sound Forge will ask you if you want to rename and open these temporary 
files to recover your work.    You also have the option to delete these files if no important work had been 
done, or to just ignore these files.

Rename
Use this to change the ending of a file name from FORGExxx.TMP to FORGExxx.RAW.    You can then 
open the raw file using the File Open dialog.    The file will be placed in the directory specified under the 
Temporary Storage Preferences folder.

Delete
This command deletes the selected temporary file.    Use this only when you are sure that no important 
work is in the file.

Ignore
If you don't want to deal with the temporary files left over from an improper termination at this moment, 
use this command.    However, it is recommended that you either rename the files and check their 
contents or delete them, since they are taking up valuable disk space.



Mono to Stereo
When converting a mono (single channel) file to a stereo (two channel) file,    you must specify    what 
channel or channels of the stereo file the mono data should go to.    This operation is not only used in file 
conversions, but also when mixing, pasting, or crossfading mono material into a stereo file.

Left Channel
The mono sound data is placed only on the left channel of the stereo file.

Right Channel
The mono sound data is placed only on the right channel of the stereo file.

Both Channels
The mono sound data is placed on both the right and left channels of the stereo file.



Stereo to Mono
When converting a stereo (two channel) file to a mono (one channel) file,    you must specify    what 
channel or channels of the stereo data should go to the mono file.    This operation is not only used in file 
conversions, but also when mixing, pasting, or crossfading stereo material into a mono file.

Left Channel
Only the left channel of the stereo file is used in the operation.

Right Channel
Only the right channel of the stereo file is used in the operation.

Mix Channels
The left and right channels are mixed together to perform the operation.



Preview Configuration
This dialog box allows you to set    preview preferences for sound processing operations.

Limit Previews to (1 - 30 seconds)
Determines the length of the wave data that will be processed for previewing.

Fade out last 10 milliseconds    (Of/Off)
Use this to fade the ends of the preview data to prevent clicks and pops.

Loop preview continuously      (On/Off)
When on, the preview data will loop infinitely when pressing the preview button in the processing 
function dialog box.

Default all previews to the current setting    (On/Off)
Use this to store the current preview settings to be used as defaults for all preview operations.    When 
Off, only the current preview will be affected by any changes made in this dialog box.

                                                         
See also
Previews



Preset Save As
To save a preset, just enter the name of the preset and press OK.    If you select an already existing 
preset, you will be asked if you want to replace the existing preset with the current preset.      

The presets that come installed with Sound Forge cannot be replaced or deleted.



Go To Marker
Use this to move the cursor to a marker location.

Shortcut
Marker Tag Shortcut menu



Select Region
Use this to change the current selection to be equal to the region endpoints.

Shortcut
Region Tag Shortcut menu



Edit Marker or Region
Use this edit a marker or region.

Shortcut
Region or Marker Tag Shortcut menu



Update Marker or Region
Use this to update the marker or region to the current cursor or selection point.

Shortcut
Region or Marker Tag Shortcut menu



Delete Marker or Region
Use this to remove a marker or region.

Shortcut
Region or Marker Tag Shortcut menu



Select Sample Loop
Use this to change the selection to be equal to the loop points.

Shortcut
Loop Tag Shortcut menu



Edit Sample Loop
Use this to edit the sample sustain or release loop.

Shortcut
Loop Tag Shortcut menu



Update Sample Loop
Use this to change a loop to the current selection.

Shortcut
Loop Tag Shortcut menu



Delete Sample Loop
Use this to delete a sample loop.

Shortcut
Loop Tag Shortcut menu



Select Record Window
Use this to select an open Data Window which will store the recorded data.



Record Remote
The Record Remote dialog is invoked by pressing the Remote button in the Record dialog box. It allows 
you to record to a data window while using other components of your system to generate audio. Note that
some options are not available in the Remote Record dialog that are available in the main Record dialog.

The System Menu (Alt+Spacebar) provides many of the options that are available in the main Record 
dialog such as New Window, Selection, Go To, etc.

The Record and Record Remote dialogs are always destructive and contain no
Undo capabilities. To prevent accidentally recording over sound data, record into a new
or scratch data window and paste the takes you want to keep into the desired sound data

window.

The following is a list of all controls available in the record dialog.

Close
Press this button to exit record mode.
Un-Remote
Press this button to leave Remote Recording mode and return to Normal Recording mode.
Monitor (On/Off)
Select this checkbox to monitor the level of the input signal. This option can be enabled at any time. 
The meters light up as a function of the volume of the recording input. For best results the level should 
be somewhere in the yellow range with an occasional red. This button also activates the Peak and 
Margin values. The Peak value shows the maximum input level recorded since the last Reset was 
invoked. The Margin value shows the percentage the input level can be increased prior to clipping. If 
the Peak value reaches 100% (and the Margin value reaches 0%), clipping has occurred.
Prepare
Pressing the prepare button prepares your system for recording. This means that the record device is 
opened and all preparation that can be done prior to recording is completed. This allows the system to 
begin recording as quickly as possible after the Record button is pressed. You do not need to use the 
prepare button unless you are trying to begin recording immediately after pressing the Record button.
Record
Pressing the record button starts recording. If recording has been Prepared, then recording starts 
immediately. If recording has not been Prepared, Sound Forge attempts to start recording as quickly as 
possible; a small delay may occur.
Play
Pressing the play button allows you to hear a section of data over which you are going to record or 
which you have just recorded. This allows you to keep recording until you get the correct take.
RTZ
Return To Zero (RTZ) sets the Start position to the beginning of the sound data. This option is not 
available in Punch In mode.
REW
Rewind (REW) sets the Start position to the beginning of the most recent take. This option is not 
available in Punch In mode.
FWD
Forward (FWD) sets the Start position to the end of the most recent take. This option is not available in 
Punch In mode.
GTE
Go To End (GTE) sets the Start position to the end of the sound data. This option is not available in 
Punch In mode.

The following is a list of all extra System Menu (press Alt+Spacebar) commands available in the Record 



Remote dialog.

New Window
This option allows you to create a new data window for recording.
Go To
This option displays the Go To dialog for selecting a Start position. This option is not available in Punch 
In mode.
Selection
This option displays the Set Selection dialog for selecting a Region. This option is only available in 
Punch In mode.
Window
This option allows you to select the data window into which you will record.
Review Pre/Post-Roll
Enables the Review Pre/Post-Roll values that are entered in the main Record dialog.
Reset Monitor
Resets the Peak and Margin values back to their initial states.

                                                         
See also
Remote recording



Search for Help on
Use this to find on-line information on a particular topic.



Sound Forge for 32 Bit Windows
This section discusses details specific to the 32 Bit version of Sound Forge 3.0. If you do not own a copy 
of Sound Forge for 32 Bit Windows and wish to upgrade, please contact Sonic Foundry for pricing and 
availability.

Sound Forge 3.0 for 32 Bit Windows is the first true 32 Bit flat model digital sound editor available 
for the PC. The performance differences from a 16 Bit sound editor are amazing. Processing 
is often 2 to 3 times faster with the 32 Bit version of Sound Forge, but there are a few things 
to keep in mind.

Sound Forge for 32 Bit Windows has been designed to run on the following platforms:

- Microsoft Windows 95 Final Beta or later (final release strongly suggested).

- Microsoft Windows NT 3.5 or later. x86 processors only.

Depending on the platform you are running Sound Forge for 32 Bit Windows on, some limitations may be 
present. These limitations result from a lack of compatible hardware and software available for 32 Bit 
Windows or are a direct result of the 32 Bit Windows Operating System implementation. These limitations
are summarized below.

Limitations under Microsoft Windows NT
The following is a list of limitations of Sound Forge for 32 Bit Windows when running under Windows NT:

1. The Sonic Foundry Virtual MIDI Router (VMR) is not supported under Windows NT.

2. Not all sound and MIDI cards have drivers available for Windows NT. Contact your manufacturer for 
availability of Windows NT drivers.

3. Synchronization with 16 bit applications (sequencers) running in the Windows on Windows (WOW) 
layer will not perform as well as running 16 bit Sound Forge under 16 bit Windows with a 16 bit 
sequencer. We currently know of no 32 bit sequencers.

Limitations under Microsoft Windows 95
The following is a list of limitations of Sound Forge for 32 Bit Windows when running under Windows 95 
Final Beta or later:

1. Sound Forge does not take full advantage of all the new Windows 95 user interface gadgets.

 



Sound Forge Main Screen Basics
This section will show you around the Sound Forge screen and teach you the most basic operations. We 
will cover:

Using the Mouse 
The Main Screen 
Toolbars 
The Data Window
Tooltips 
Getting On-line Help 



Using the Mouse
Although using the mouse in Sound Forge is not required, it will make your editing sessions easier. Once 
you become familiar with Sound Forge you will probably want to use some of the built in shortcuts 
provided by the mouse and the keyboard. The following list of terms will help you when reading the 
manual.

Pointing Moving the mouse pointer over an item is called pointing.

Clicking Pointing to an item and quickly pressing and releasing the left or right mouse button 
is called clicking. The manual will let you know whether you need to right-click or 
left-click on an item to execute a specific function. When there is no specification as 
to left or right you can assume we mean left-clicking. Right-clicking is often used to 
reach Shortcut Menus.

Double-Clicking Double-clicking is the same as clicking except instead of pressing and releasing the 
mouse button once you do it twice in quick succession. Double-clicking always 
indicates clicking twice with the left mouse button.

Shift Clicking Shift clicking is holding down the shift key on the keyboard while clicking the mouse.
Shift clicking is used mainly to skip dialogs so that you can quickly repeat 
operations.

Control Clicking Control clicking is holding down the control key on the keyboard while clicking the 
mouse. Control clicking is used to modify the operation of a normal click.

Dragging Holding down the mouse button while you move the mouse pointer is known as 
dragging. Dragging is used to quickly move sections of data between separate 
windows and to move trackbars, scrollbars, faders, and sliders.

Dropping After dragging an item, releasing the mouse button on top of another area is known 
as dropping. Dragging and dropping is used to speed up operations like mixing or 
moving regions within the Playlist.



The Main Screen
When you start Sound Forge, you see the main screen, or work space, where you will do all your editing. 
When you first open Sound Forge, no Data Windows are open and you will need to either open an 
existing sound file or create a new one. There are a variety of ways to do this, all of which are explained 
later in the manual. The following list briefly describes each part of the screen.

Program Title Bar Shows "Sound Forge" and the name of the currently active Data Window if 
the Data Window is maximized within the workspace.

Data Window Each opened sound file has its own Data Window. Data Windows can be 
arranged, resized, or minimized.

Menu Bar Shows the menu headings for the available functions. When no Data 
Windows are open, the Process, Effects, and Tools menu are not listed 
because these contain functions which require an open Data Window.

Status Bar On the left, help and processing information is displayed. The fields on the 
right show the sample playback rate, sample size, mono/stereo, and total 
length of the active Data Window. These fields can be edited by double-
clicking or right-clicking on them. When no Data Windows are open, the 
fields are blank.

Sound Forge Workspace This is the background area behind the Data Windows. You can drag 
sections here to create new Data Windows.



Toolbars
The first time you run Sound Forge, two toolbars also appear on the screen: the Standard and Transport 
toolbars. The toolbars contain buttons which are used to quickly execute commands.

Standard Provides quick access to many commonly used Sound Forge file and edit 
commands.

Transport Provides the audio transport buttons: Record, Play All, Play Normal, Pause, Stop, 
Go to Start, and Go to End.

These toolbars, like any other toolbar in Sound Forge, can be dragged and dropped to anywhere on the 
screen. Toolbars are also resizeable and removable. When a toolbar is dragged to any side of the main 
window, it docks, or attaches to the side. If you drag a toolbar away from a side, it becomes a floating 
toolbar. To hide a floating toolbar, just click on its close button.

A list of available toolbars can be displayed by selecting the Preferences command under the File menu 
and looking in the Toolbars folder. To show a toolbar, just check the box next to the toolbar you wish to 
use and then select OK. The number of open toolbars and their position on the screen is entirely up to 
you.



The Data Window
Data Windows are the windows which contain sound data files. These windows contain a number of sub 
windows and controls which you will use in editing and viewing your sound data. Many parts of the Data 
Window lead to Shortcut Menus, dialogs, and other operations.

The following list briefly describes each part and possible mouse operations:

Title Bar Shows the file name or, if present, the title stored in the Summary Information
of WAV files. Double-click to maximize/restore the window.

Ruler Shows the current location in the Data Window as well as Ruler Tags. Right-
click to reach the Ruler Shortcut Menu.

Ruler Tags Used to indicate the position of Region end-points, Loop end-points, and 
Markers. Double-click to change the current selection. Right-click to reach the 
Ruler Tag Shortcut Menu. Drag to change their locations.

Playbar On the left side of the Playbar are the following audio transport buttons: Go to 
Start, Go to End, Stop, Play Normal, Play Looped, and Play Sample. To the
right are the Playbar's Selection Status Fields.

Selection Status Fields Show the beginning, end, and length of a selection. If no selection has been 
made, only the cursor position (also known as the insertion point) is displayed. 
Double-click on the left-most field to reach the Go To dialog. Double-click on 
either of the other two fields to reach the Set Selection dialog. Right-click to 
reach the Status Format Shortcut Menu.

Waveform Display Shows a graphical representation of the sound file. The horizontal axis 
represents time (marked in the Ruler) and the vertical axis represents 
amplitude. Right-click anywhere on the Waveform Display to reach the 
Waveform Display Shortcut Menu.

Position Scroll Bar Use this to scroll the sample forward and backward in time to see parts of the 
file not currently visible in the Waveform Display.

Overview Allows for quick navigation and playback of any part of the file and shows the 
fraction of the waveform being shown on the Waveform Display as well as the 
selected region. Left-click to move the cursor. Double-click to center the cursor 
in the Waveform Display. Right-click to start playback or pause.



Zoom Resolution Specifies the number of samples of data represented by each point on the 
screen. This determines the length of time which is shown in the Waveform 
Display. With a small resolution value (1:1, 1:2, 1:4, ...), a shorter length of time
is displayed.

Zoom In/Out Use this to change the zoom resolution.

Maximize Width Pressing this button maximizes the width of the Data Window.



Tooltips
If you keep the mouse over a toolbar button or Status Bar field for more than one second, you will notice a
small box appear next to the mouse pointer containing some text. This text is a quick description of the 
function of the button or field. Using Tooltips is an easy way to learn your way around the Sound Forge 
screen. If you wish, you can disable this function by selecting the Preferences command under the File 
menu and looking in the Toolbars folder.

When you press and hold a button in a toolbar or select a menu item, you will see a one line description 
of the command in the left side of the Status Bar. This status text help gives you a little more descriptive 
information about the function of a button. If you release the mouse-button outside of a toolbar or menu-
item, the toolbar command will not be performed.



Getting On-line Help
On-line help is available in a variety of ways. You can:

- Go straight to the Help table of contents by selecting Contents under the Help menu, or pressing F1.
Once there, you can search for your help topic and also get information on using the on-line help.

- Press the help button or the F1 function key in a dialog. This will take you straight to the help 
information on the dialog. 

- Press the F1 function key while selecting a menu item to get information on the command.

You will find that on-line help is extremely useful as a quick reference guide. Since many topics are cross 
linked, it is easy to navigate through all of the help material available on a topic. Once you have become 
familiar with using Sound Forge, you will probably never have to refer to this manual to find information. 
All you will need is the on-line help.



Data Window Basics
With Sound Forge, you can have multiple sound data files open simultaneously on the screen. Each file 
has its own corresponding Data Window which shows you a graphical representation of the waveform 
and other information about the file. This section covers the following topics:

Opening an Existing File 
Playing a File 
Playing a Section 
Using the Transport vs. the Data Window Playbar
Creating a New Window 
Active Windows vs. Inactive Windows 
Copying Data to a New File
Saving a File 



Opening an Existing File
To open an existing sound file, do the following:

1. Select the Open command from the File menu. Sound Forge displays the Open dialog.
2. Use the Open dialog to select and open a file. You can preview uncompressed WAV files by 
pressing the Play button in the Open dialog. Pressing the Play button once more stops the playback 
(you can also use the Spacebar for playing and stopping if the focus is in the list box below the File 
Name edit field).

You can use the List Files of Type to select different types of data files. If Sound Forge recognizes the 
type of a file when it is highlighted in the Files list box, it will display its information in the bottom half of 
the dialog. 

Open the file TUTOR1.WAV now. This file is located in the directory where you installed Sound Forge.

You will now see the Data Window containing TUTOR1.WAV. This file is a recording of someone saying 
"Wow, sound editing is easy!".

Notice how even though the file name is TUTOR1.WAV the name of the Data Window is Wow, sound 
editing.... This is because we have stored a title for the file within the WAV file itself. Sound Forge allows 
you to embed descriptive titles as well as copyright and other text fields for any WAV file.

Sound files in Sound Forge can have a title that is different from the file name. To edit the
title, use the Summary Information (File menu) dialog. You can quickly get to the

Summary Information dialog by double-clicking on the Total Length (right-most) Status
Bar field.



Playing a File
Once you have opened a file, you can hear it by clicking on the Play All button on the Transport toolbar.

While the file is playing, a pointer will move along the Data Window showing the current position. You will 
also see the current position in the first Selection Status field in the Playbar.
Play the TUTOR1 file now. You will hear the words Wow, sound editing is easy!.
You can play from any point in the window by simply moving the cursor. Move your mouse pointer to the 
silence section right after the "Wow" portion of the file. Left-click (don't drag, we don't want a selection 
yet), and you will see the flashing cursor in the silence area after the word "Wow". Click the Play button 
on the Transport toolbar and now you will only hear the "sound editing is easy" part.
If you don't hear anything you may have made a small selection by accidentally dragging the mouse. To 
tell if you've made a selection just look at the three right hand fields in the Data Window status bar. If only 
the first one is filled, then you don't have a selection. If they all have values then you need simply click in 
the Data Window again to clear the selection.



Playing a Section
You can also play portions of the sound data by making a selection on the Waveform Display with the 
mouse. To do this, click and drag the left mouse button starting at the section of silence prior to "Wow". 
Drag the mouse until you are in the portion after the "Wow". Notice that as you drag the data, the 
background appears in an inverted color. Let the mouse button up and you will now have a highlighted 
section of data. Again click the Play button. You should now hear just the "Wow" portion of the file.

While making a selection, and after selecting, you will notice that the three Selection Status fields on the 
right side of the Playbar have values. These values show you the start, end, and length of the selection 
you have made. When no selection has been made, the cursor position (also called the insertion point) is 
shown.

Let's clear the selection and put the cursor back at the start of the file. To do this click on the Go to Start 
button in the Transport toolbar (the fourth button from the left).



Using the Transport versus the Data Window Playbar
There are a number of ways to play your sound files within Sound Forge. The most common method is to 
use one of the play buttons located either on the Transport or on the Data Window Playbar. Let's take a 
look at both of them.

The Playbar buttons
On the left-side of the Playbar at the bottom of every Data Window are six buttons. These buttons allows 
you to play the sound data in a variety of ways. The first two buttons allow you to set the cursor to the 
start or the end of the current file. These are the Go to Start and Go to End buttons. The next button is 
the Stop button, which you can use at any time to stop playback.

The last three buttons play the sound in three different ways and also set the default play mode at the 
same time. The first button is the Play Normal button. This button plays the currently selected section of 
data. If there is no selection, pressing the Play Normal button plays from the current cursor position to 
the end of the file. The next button is the Play Looped button. This button plays the selected section in a 
continuous loop or if no selection is made then the entire file in a continuous loop. The final button is the 
Play as Sample button. This button is used to play a sound file as if it was present in a sampler. This 
means the file will be played until it reaches the sustain loop defined for the file and then will loop in the 
sustain loop for the number of loops defined. If there are no loops defined the file plays straight through 
(this is known as a One-Shot sample).

Whenever you play a file from the Playbar, you will notice a small line that appears underneath the play 
arrow in the corresponding play button. This is the current play mode which will be used whenever you 
select the Play button in the Transport Toolbar (or hit the Spacebar). Play Normal is the current play mode
in the Playbar graphic shown above.

To change the current play mode, press the corresponding Playbar button or use Control+Spacebar.

The Transport Toolbar
The Transport toolbar has seven buttons.

The Transport toolbar buttons are described below from left to right:
Record Brings up the record dialog which allows you to record to either a new or existing 

window. Shortcut: Control+R.

Play All Plays the entire sound file from beginning to end. This allows you to hear the entire 
sound even if you have a selection or the cursor positioned somewhere other than 
the start of the data. Shortcut: Shift+Spacebar.

Play Plays the file using the current play mode. To set the play mode select one of the 
three play buttons on the Playbar as described above. The last button used 
becomes the active play mode. Shortcut: Spacebar.

Pause Works like the stop button in that it stops play of the current file. However when 
selecting pause the cursor is placed at the current play position rather than back to 
where it was when play was selected. Shortcut: Enter during playback.

Stop Stops play and positions the cursor back where it was prior to selecting play. 
Shortcut: Spacebar during playback.

Go to Start Places the cursor at the beginning of the sound file. Shortcut: Control+Home.

Go to End Places the cursor at the end of the sound file. Shortcut: Control+End.



Creating a New Window
To create a new Data Window do the following:

1. Select the New command from the File menu. Sound Forge displays the New Window dialog.
2. Select the new data format in the dialog.

Since we are already working with the TUTOR1 file let's create a new window that has the same data 
format as TUTOR1.

In the New Window dialog set the sample size to 16-bit, the channels to Mono, and the Sample rate to 
22,050. When you click the OK button a new window will appear titled Sample2. This is an empty Data 
Window in which we are going to place data from TUTOR1.



Active Windows vs. Inactive Windows
When you have multiple windows on the screen, only one window is considered the "active" window. This 
is the window on which you are currently working. Any operations you perform will affect only this window.

To make a window the active window you click anywhere on the window with the left mouse button. The 
window's title bar will change to the color you have defined as the active window color in your Window's 
Control Panel.



Copying Data to a New File
Make Wow, sound editing... the active window by clicking on its title bar. If you don't still have the word 
Wow selected, select it again as we did above. From the Edit menu, select the Copy command. This will 
copy the sound data for Wow on to the Clipboard.

Now make Sample2 the active window by clicking on its title bar (if the title bar is covered by another 
window, you can always use the Window menu to activate a data window). Select the Paste command 
from the Edit menu and the Wow data will appear in the Sample2 window. If you press the Play button, 
you can hear how our new file sounds with just the word Wow.

There are much easier ways to copy data from one window to another, or from an existing window to a 
new window, but we will cover those in a later section.



Saving a File
To save a Data Window, you first need to make it the active window. Make sure the Sample2 window is 
active.

1 Select the Save command from the File menu. Since the Sample2 window is a new file, Sound 
Forge displays the Save As dialog. If the file had been opened or previously saved by Sound Forge 
then the file would be immediately saved.
2 Type a file name into the File Name field in the Save As dialog and select the OK button. Let's save
the new sample, Sample2, as MYFIRST.WAV.

The Save As dialog also allows you to change file types, data format, and set summary information fields.
This is covered in a later section.



Simple Editing and Navigation
This section will show you the basic editing operations of Sound Forge.

Common Edit Operations 
Making a selection
Copy, Paste, Cut, Undo
Cropping 
Simple Mixing
Status Formats 
Magnification and Zooming 



Common Edit Operations
The edit operations used most often include cut, copy, paste, delete, mix, and trim/crop. Most of these 
make use of the Clipboard, which is a temporary storage area which can also be used to move data from 
one window to another. The following list provides a brief description of each operation:

Cut Deletes a selected portion of data and copies it on to the Clipboard.

Copy Copies a selected portion of data on to the Clipboard.

Clear Deletes a selected portion of data but doesn't copy it on to the Clipboard.

Trim/Crop Deletes all data in a window except the selected section.

Paste Inserts the contents of the Clipboard into a Data Window at the current cursor 
position.

Mix Mixes the contents of the Clipboard with the current data in a window starting at the 
current cursor position.

To show how these operations are used, we will once again be using the TUTOR1.WAV file. If it is not 
currently open please open the file now as described in the previous sections.



Making a Selection
If TUTOR1 is not the active window, activate it by clicking on its title bar. To make a selection, you must 
first make sure that you are in Edit Mode. To get to edit mode, look under the View menu and select the 
Edit Mode item (it should already be checked). Next, select the word "Wow" with the mouse like we did in
the previous section. You can verify you have the right section of data by pressing the Play button to hear 
it.



Copy, Paste, Cut and Undo
Copying Data on to the Clipboard
Once you have a selection, you can use the Copy command from the Edit menu. This will copy the 
selected data on to the Clipboard. You will see no change, since the copy command does not change the 
data, it only copies it on to the Clipboard.

Pasting Data from the Clipboard
Now move the cursor to the beginning of the file by selecting the Go to Start button on the Playbar. To 
insert the contents of the Clipboard into the file, use the Paste command from the Edit menu. You should 
now see the data for the word "Wow" appear at the beginning of the window. Press the Play button just to
make sure. You should hear Wow Wow Sound editing is easy.

You have just made your first edit in Sound Forge! There are much quicker ways to do what we have just 
done with Sound Forge, but we'll get to that in the Advanced Editing section.

Pasting Data to Another Window
Data on the Clipboard remains on the Clipboard until it is replaced by another operation which places 
data on the Clipboard. Therefore, you can continue pasting the data anywhere you want.

To demonstrate this, create a new window as described in the previous section. Now, select the Paste 
command from the Edit menu once more. You should now have a new Data Window with the data for the 
word Wow. You can also do this by selecting the Paste to New function in the Edit menu. This creates a 
new window and fills it with the Clipboard contents in one easy step.

Cutting Data
To cut data, first you need to select a section of data you want to cut. Select one of the Wow words (you 
should have two if you have been following the examples) from TUTOR1.

Now select the Cut command from the Edit menu. This will remove the selected data and place it on the 
Clipboard.

Undoing an Edit Operation
After any edit operation you can reverse it by selecting the Undo command from the Edit menu.

Let's undo the cut we just made. Select Undo Cut from the Edit menu and you will see the original two 
Wow words in the TUTOR1 window.



Trimming
Trimming (also called Cropping) allows you to single out a section of data and cut everything else out of 
the window except that section. This is a handy feature since you can keep using the Play button to hear 
selections until you have just the right amount and then get rid of everything else with the Trim/Crop 
command in the Edit menu.

By now you should be getting used to selecting data on the screen, so select the "Wow Wow" section in 
the TUTOR1 window. Remember you can use the play button to hear how the selection sounds at any 
time.

Once you have the selection, select the Trim/Crop item found in the Edit menu. After cropping you will 
have only "Wow Wow" left in the window. 

At this point let's close the Wow, sound editing... window. Either double-click on the close box of the 
TUTOR1 window, or select the Close command from the File menu. You will be asked whether you want 
to save the changes you have made to TUTOR1. Select the No button since we don't want to keep the 
changes we made to TUTOR1.

Also close any other windows you may have open, like MYFIRST.WAV.



Mixing
Mixing is a powerful and useful edit operation which you will use often. Mixing allows you to combine two 
sounds together into one window so you can create complex sound effects.

This time we are going to open two files, TUTOR1.WAV and TUTOR2.WAV. Open them now as we've 
shown you in the previous sections.

TUTOR2 is a file which contains the sound of a snare drum and crash cymbal. We are going to mix this 
sound with TUTOR1; the "Wow, sound editing..." window.

Before we begin mixing, let's set the status format to Time to make finding the mixing points a little easier. 
To do this select the item Seconds from the Status Format pop-up menu under the View menu. You will 
need to do this for both Data Windows since Sound Forge keeps track of the format type for each 
individual window.

To make the windows easier to view while we're doing the mix operations you may want to select the Tile 
Vertically item from the Window menu. This will arrange the windows vertically, fully utilizing the Sound 
Forge workspace and will make things easier to see.

If you activate each of the TUTOR windows you will notice that the length of TUTOR1 is 3.0 seconds long 
and TUTOR2 is 1.5 seconds long. For this example, we want the drum hit to occur just before the "Wow". 
We could just copy the drum hit sound on to the Clipboard and then paste it before the "Wow", but this 
would increase the length of TUTOR1 to 4.5 seconds. So instead we'll use the Mix command.

Select all the data in Drum Hit by making it the active window and then double-clicking in the Waveform 
Display with your left mouse button (you could also use the Select All command under the Edit menu). 
Now copy the data on to the Clipboard by selecting the Copy command from the Edit menu.

Make TUTOR1 the active window and then select the Go to Start button on the Playbar. This will put the 
cursor at the beginning of TUTOR1. Select the Mix command from the Edit menu. The Mix dialog now 
appears. Keep both levels at 100% and select OK.

You will see that the drum hit sound has been mixed into the TUTOR1 window and the length of TUTOR1 
is still 3.0 seconds. Press the Play button to hear the results.

Select the Undo Mix command from the Edit menu to put TUTOR1 back to it's original state. 

Now let's mix the drum hit sound closer to the Wow portion of TUTOR1. The Wow occurs at about 0.7 
seconds into TUTOR1, so move your cursor in the TUTOR1 window to approximately 0.7 seconds. You 
do this by clicking with the left mouse button in the Data Window of TUTOR1 and watching the cursor 
position status field on the status bar (the left most field). You don't have to be exact. Once you've 
positioned the cursor, select the Mix command again and then Play the result. Notice how the drum hit 
sound and the Wow sound overlap each other.



Status Formats
When editing sound files, the ruler, total length status field, and Playbar Selection Status fields can be set 
to different formats so you can coordinate sound files with other events, or edit to a timing base that you 
feel most comfortable with.

Lengths and positions can be displayed in a variety of formats including Samples, Time (seconds and 
milliseconds), Frames, SMPTE, and Measures and Beats.

Selecting a Status Format
To select a format choose the Status Format option from the View menu. This shows the nine different 
formats available. Choosing one of these options sets the status format for the current data window.

The available formats are:

Samples Number of samples.
Seconds Seconds and fractions there of.
Milliseconds Milliseconds and fractions there of.
Frames Frames and fractions there of.
Beats Measures:beats.tenths of a beat.
SMPTE Non-Drop SMPTE at 30 or 29.97 fps non-drop.
SMPTE Drop SMPTE at 29.97 fps with drop.
SMPTE EBU SMPTE at 25 fps.
SMPTE Film Sync SMPTE at 24 fps.

Using the current file, TUTOR1, let's take a look at how the status formats affect values in the status 
display fields. First, select the Samples format from the Status Format pop-up menu under the View 
menu.

Now select all of the data in the TUTOR1 window. To do this select the Select All option from the Edit 
menu. This will select all data in the window. You can also select all of the data in a window by double-
clicking the left mouse button anywhere in the Waveform Display of the data window.

In the Selection Status fields on the Playbar (at the lower right hand side of the Data Window) you should 
see the values of 0, 66,149, and 66,150. This means that the first selected sample is sample 0, the last 
selected sample is 66,149, and the total number of samples in the selection is 66,150.

Now select the Time option from the Status Format pop-up menu under the View menu. You will see 
that all these values change to values specified in seconds rather than samples. You can see that a 
sound containing 66,150 samples with a sample rate of 22,050 Hz will play for 3.000 seconds. You can 
experiment with each of the status formats to see how each format is displayed

Before continuing, change the Status Format back to Samples for use later in this section.

Configuring Frames and Beats
When setting the status format to Frames or Beats there is additional information you can provide to 
Sound Forge to customize how these values are displayed. The Edit Frames dialog in the Special menu 
allows you to change the frames per second. In the Edit Tempo dialog, also in the Special menu, you 
can specify the beats per minute and beats per measure values used to calculate measures and beats. 
The default values for Frames and Beats are set in the Status Preferences folder (File menu).



Magnification and Zooming
When sound data is drawn on the screen, it is necessary to represent many samples of data for each 
horizontal point on the screen. There's almost always many more samples in a sound file than there are 
horizontal points (pixels) on the screen. Depending on the editing operations you need to use, you may 
want to view the entire file at once, or you may want to look only at a small portion in greater detail. This is
where the magnification, or zoom resolution, comes in.

In the bottom right corner of the Data Window, on top of the Data Window Playbar, is the current 
magnification ratio. The magnification ratio defines how many samples of sound data are "squeezed" into 
each horizontal point on the screen. The setting is shown as a value of 1:XX where XX is the number of 
samples represented by each horizontal point on the screen.

For example, if the setting is 1:1 then each point on the screen is one sample. With this setting, a very 
short length of time is shown on the Waveform Display. You might not be able to see the cursor or 
selection because you are looking so close-up. If the setting is 1:1,024, then there are 1,024 samples 
represented by each point on the screen and a longer length of time can be seen.

When Sound Forge opens a file it sets the magnification to the value needed to fit the whole file on the 
screen or to the Maximum zoom ratio on open value set in your preferences section, if the file is large. 
To increase or decrease the magnification ratio, use the Zoom In/Out spinner found on each Data Window
next to the ratio. If you increase the magnification ratio you can then use the horizontal Position Scroll Bar
found on the bottom of each Data Window to slide the data left or right within the window.

Using Zoom Selection and Zoom Out
If you would like to quickly magnify a section of a Data Window, the easiest way is to use the Zoom 
Selection command found in the View menu. To use the Zoom Selection command you must first select
an area which you want to magnify. After selecting Zoom Selection, Sound Forge will calculate the 
minimum magnification ratio which will allow the full selection to fit on the screen, and then center the 
selection within the Waveform Display.

To display all data in a window at one time, use the Zoom Out Full command. This
command sets the magnification ratio to the lowest value needed to display all of the

data at once in the Waveform Display. If this value exceeds the Maximum zoom ratio
on open value, the zoom ratio is set to the Maximum zoom ratio on open value.

If you wish to set the zoom factor to its maximum magnification (1:1), use the Zoom In Full command 
also found in the View menu. You will then be able to see the actual waveform oscillations which 
correspond to physical sound waves when played through your speakers.

Another way of zooming in and out is by using the up and down arrow keys. Also, if you right-click on the 
Waveform Display you can quickly select various zoom commands from the Waveform Display Shortcut 
Menu.

Note: For files of large size (many megabytes), it may take a while to render the data depending on the 
speed of your computer and hard drive.

Magnify Mode
Another way to zoom in to a particular section of the sample is to use the Magnify Mode. You can enter 
this mode by selecting the Magnify Mode from the View menu and selecting regions to be magnified. 
You must then return to Edit Mode to do edit operations.

You can also enter this Magnify Mode temporarily by holding down the Control key when making a 
selection. Instead of making a selection, the mouse cursor will become a magnifying glass and a dotted 
square will appear. If you drag the mouse while still holding the Control key, you can select a region which



will then be magnified to a best fit ratio within the Waveform Display.



Advanced Editing and Navigation
This section will show you how to use the advanced editing and navigation operations of Sound Forge:

Making a selection using the Set Selection dialog 
Extending the selection points with the mouse
Selecting with the keyboard
The Overview 
Using the Go To dialog
Using Views 
Drag And Drop Operations 
Advanced Mixing options
Editing Stereo Files 



Making a selection using the Set Selection dialog
If you need to select data at specific points, the Set Selection dialog allows you to type in selection points
or choose a selection from a list of regions. To reach the Set Selection dialog, select the Selection 
command from the Edit menu.

In the Set Selection dialog, you can modify the start, end, length, and channel of the selection. Pre-
determined regions can also be chosen from the Selection drop-down list.

Note: Many commonly used functions in Sound Forge can be performed in a number of different ways. 
For example, you can reach the Set Selection dialog by double-clicking on the right-most Playbar field, 
or you can pick the Selection item from the Waveform Display Shortcut Menu. Sound Forge has been 
designed to allow you, the user, to choose how you want to work as opposed to forcing you to work in a 
certain way. To avoid confusion in our demonstrations, we won't always tell you about every method of 
accomplishing the same task. Refer to the Sound Forge Reference and the Appendix on Shortcut Keys 
for more information on each feature.



Extending a Selection the Mouse
After selecting a section of sound data, you will sometimes find that the start or end-point are not exactly 
what you want. You could just re-select the data, but it is often difficult to get the start or end-points just 
right. 

Sound Forge allows you to update the selection by holding down the Shift key while clicking the left 
mouse button at a new position. Once you have selected an area you can continue to select without 
losing the previous selection by holding the Shift-key down while selecting with the left mouse button. This
is the "Update Selection" mode.

Which side of the selection is updated depends on where you Shift-click the left mouse button. If you click
to the right of 1/2 the selection length then you will change the end of the selection. If you click to the left 
of 1/2 the selection length then you will change the start of the selection. By holding the Shift-key and left 
mouse button down, you can continually adjust the selection length until you release the mouse button.

To extend or shorten a selection, hold down on the Shift key and use the mouse to drag
the selection start or end-point.



Selecting with the keyboard
The keyboard selection controls allow you to quickly select data or update a selection accurately. For 
example, say you want to extend the selection end by a small amount. First, make sure that the cursor is 
at the end of the selection. You can move the cursor from one end of the selection to another by pressing 
the Home (moves to the start) and End (moves to the end) keys. Use the . (period) key to center the 
cursor in the Waveform Display. You can then use the Shift+Right Arrow and Shift+Left Arrow 
combinations to extend the selection end-point by small increments.

The following list shows the available keyboard commands for selecting data.

Press To select from cursor to

Shift+Right Arrow The next screen pixel.

Shift+Left Arrow The previous screen pixel.

Shift+End The last sample visible in the Waveform Display.

Shift+Home The first sample visible in the Waveform Display.

Shift+Page Up 10% of the current view past the cursor position.

Shift+Page Down 10% of the current view previous to the cursor position.

Shift+Control+Right Arrow 2% of the current view past the cursor position.

Shift+Control+Left Arrow 2% of the current view previous to the cursor position.

Shift+Numpad + The next sample.

Shift+Numpad - The previous sample.

Shift+Control+Numpad + 10 samples past the current position.

Shift+Control+Numpad - 10 samples previous to the current position.

As you can see from the above list, Sound Forge has extensive keyboard support for selecting data. You 
will find that almost any operation has an equivalent Keyboard Shortcut which advanced users find 
invaluable.

Let's take a quick look at how to use some of these keys. Open the file TUTOR1.WAV as we've done in 
previous sections. First, make sure that you're in Edit Mode by selecting the Edit Mode item under the 
View menu. Now make a selection that encompasses the word Wow with a generous amount of space on
each side of the word. Pressing the Play button you should hear a little bit of silence, Wow, and a little 
more silence.

Select the Zoom Selection command from the View menu. This will fit the selection on the screen with 
the best possible resolution. Now let's adjust the right side of the selection.

With the Shift key down, left-click and drag to the right of the selection end-point. Adjust the selection to 
be close to the end of the word Wow and let up on the mouse button. Now let's do the same thing with the
keyboard. Hold down the Shift key and press the right arrow key. The selection will extend to the right by 
one screen pixel. If you hold down the Shift key and press the left arrow key, the selection will decrease 
by one pixel. One screen pixel is equal to the number of samples shown in the magnification ratio field. 
You can move the end of the selection in this manor until you've got the selection just right.

Now let's adjust the start of the selection. Since the cursor is at the end of the selection, any keys we 
press for selecting will adjust the end. So we need to put the cursor at the front of the selection. To do 
this, press the Home key. You will see the cursor jump to the start-point of the selection. You can now use 
the selection keys to adjust the start of the selection.



You can also fine tune a selection on a per sample basis rather than a pixel basis. If you look in the above
list you will see that the Numpad '+' (plus) and '-' (minus) keys are used for these operations. This allows 
you to get the exact selection you need without having to change the magnification ratio.

Restoring a Selection
When you change the cursor position (with the mouse or keyboard) without holding the Shift key down, 
you lose your selection and only the cursor is displayed. If you want to return to the last selection, select 
the Toggle Selection item under the Edit menu or press the Backspace key.



The Overview
While making selections and navigating through a sample, you probably noticed the Overview (the thin 
bar directly underneath the title bar) change. The Overview represents the length of the entire sample, as 
if you were zoomed out all the way. From the Overview, you can determine what section of the entire 
sample is being displayed, the selection made, and where the cursor is.

Getting the whole picture 
Zoom out all the way on the TUTOR1 window (Zoom Out Full in the View menu) and make a selection 
over the word Wow. Notice that the entire Overview has brackets above and below it, since the entire 
sample is being displayed. Also notice how the selection and the cursor are displayed on the Overview.

Now press the Zoom In button (the large magnifying glass in lower right-hand corner of the Data Window)
a couple times and notice how the brackets become smaller. This corresponds to the smaller fraction of 
the entire sample which you can see on the Waveform Display when you zoom in. The selection size, 
however, remains the same and does not move. Even when you can not see them on the Waveform 
Display, you can always know where in the sample the cursor and the selection are by referring to the 
Overview.

You can also change the cursor position by left-clicking anywhere on the Overview (as always, when you 
change the cursor you lose your selection).

Fast Navigation and Playback
When you left-click outside the bracketed region in the Overview, you will you not be able to see the 
cursor on the Waveform Display. However, double-clicking anywhere on the Overview will both move the 
cursor and the center the Waveform Display to the selected position in the sample.

You can also play back the sample starting from the current cursor position by right-clicking anywhere on 
the Overview. Doing so starts playback. Right-clicking on the Overview during playback pauses playback. 
This in conjunction with left-clicking in the Overview to move the cursor position makes it very easy to find
sections in large files. Also note that left-clicking on the Overview during playback moves the cursor to the
point where you clicked and continues playback at that point.

As an example, say you wanted to move the cursor to the beginning of a phrase in a speech. You can 
right-click on the Overview bar to begin playback and then left-click at different positions within the 
Overview until you find the right start point. Once you find the start point, you can press the Stop button to
stop playback. The cursor should now be positioned at the last spot on which you left-clicked in the 
Overview; select Center Cursor from the Special menu and you are ready to edit.



Using the Go To dialog
To quickly move the cursor to a specific point and center it in the Waveform Display, use the Go To 
command. You can reach the Go To dialog in a number of different ways: Use the Go To item in the Edit 
menu; right-click on the Waveform Display and select Go To from the Shortcut Menu; double-click on the 
left-most Selection Status field; or press Control+G.

The Go To dialog is much like the Set Selection dialog. You can type in the location where you want to 
go or use one of the pre-determined locations from the list. To create your own location marker, press the 
M key at any cursor position. You can also drop a marker at any time during playback. Refer to The 
Regions List and Playlist for more information on using Markers.



Using Views
If you wish to save the selection points you've set, the zoom magnification, or the position of the 
Waveform Display, you can do so with Views. Sound Forge has the ability to store up to eight views for 
each Data Window. Each view stores the selection, cursor position, magnification, and Position Scroll Bar 
placement. A saved View can later be instantly restored.

Follow these steps that demonstrate how to use Views:

1. Open the file TUTOR1.WAV and select Wow.
2. To store the current View, press CTRL+1.
3. Now, zoom in and make a different selection anywhere you wish. Store this new View by pressing 
CTRL+2.
4. To return to the first view you stored, press 1. Notice that the selection and zoom factor are 
restored.
5. To go to the second View you created, press 2.

You can store and recall up to eight different views (1-8) in this manner. There is also a Views toolbar you 
can use (look in the Toolbars folder of the Preferences dialog) to set and restore Views. When using the 
Views toolbar, all stored Views are indicated by an underscore in each View button.



Drag And Drop Operations
You can perform a Mix, Paste, or Crossfade by dragging a selection from one Data Window and dropping 
it on another.

To drag and drop:

Open two sound files. One will be called the source window and the other, the destination window. 
Set the cursor in the destination window to where you want the Mix, Paste, or Crossfade to begin. 
Now select a region in the source window.
Press and hold the left mouse button in the selected area of the source Data Window. While holding 
the mouse button down, move the cursor until it changes to an arrow dragging a document with a 
small waveform drawn on it.

Drag the cursor onto the destination window.
Let go of the left mouse button. This will bring up the Mix dialog. To perform a Crossfade instead of a
Mix, hold the Control key down while letting go of the mouse button. Holding down the Alt key when 
dropping performs a Paste.

Holding down the Shift key while dragging a section will skip the Mix or Crossfade dialog
and use the same parameters that you used during your last Mix or Crossfade.

As we did in the previous section on mixing, open the two files, TUTOR1.WAV and TUTOR2.WAV. For 
this example, TUTOR1.WAV will be the destination window and TUTOR2.WAV the source window.

To make the windows easier to view while doing the mix operation you may want to select the Tile 
Vertically option from the Window menu.

Make TUTOR1 the active window and press the Go to Start button on the Playbar. This will put the 
cursor at the beginning of TUTOR1.

Highlight all the data in TUTOR2 by making it the active window and double-clicking in the Waveform 
Display. Now drag the selected section by pressing and holding the left mouse button in the Data Window
of the TUTOR2 window. Notice that the cursor changes to a pointer with a document when you begin 
dragging. Move the cursor over the TUTOR1 Data Window and let go of the mouse button (drop the 
section).

When you let go of the mouse in the TUTOR1 window, you will see a dialog which shows the 
TUTOR2.WAV window as the source and TUTOR1.WAV as the destination. Leave the levels at 100%, 
and select OK. You will see that again the Drum Hit sound has been mixed into the TUTOR1 window. 
Press the Play button to hear the results.

Drag and Drop Crossfading
Undo the last operation. Now, in TUTOR1, place the cursor close to the end of the file. Now select all of 
TUTOR2 and drag it to TUTOR1. Press the Control key and then drop the selection. This takes you to the
Crossfade dialog. Select the Normal Crossfade Preset and press OK. You should hear the end of 
TUTOR1 fade out as the beginning of TUTOR2 is faded in.

Drag and Drop Pasting
Again, undo the last operation and place the cursor in TUTOR1 towards the end of the file. Drag all of 
TUTOR2 into TUTOR1. Hold the Alt key down while you drop the selection. If everything was done 
correctly, you should have pasted (inserted) the data from TUTOR2 at the cursor position in TUTOR1.

Creating a New Window with Drag and Drop
A very useful feature of Drag and Drop is the ability to quickly create a new window from a selection. To 



do so, make a selection in a Data Window and drag it to an empty area of the Sound Forge workspace. A 
new Data Window is automatically created containing the data from the selection.



Advanced Mixing options
In the Mix dialog, there are several options you can use to perform complex mixes. For example, when 
mixing vocals over music, you can have the music fade out and then fade back in (sometimes referred to 
as ducking) when the vocal part is mixed. Follow these steps to perform voice-over ducking:

1. Open the file TUTOR1.WAV and select Wow.
2. Drag the Wow selection to an open area in the Sound Forge workspace to create a new Data 
Window.
3. In the Summary Information dialog (File menu), name this sample Wow in the Title field and 
press OK.
4. Now, open the file TUTMUSIC.WAV. This file contains a short music clip which we will mix the Wow
sound on to.
5. Place the cursor in TUTMUSIC at about two seconds from the start of the file.
6. Select all of Wow and drag and drop it to the TUTMUSIC window.
7. In the Mix dialog, select the Slow duck Preset. Notice that the Destination volume is set to 50% 
and the fade times are set to 0.5 seconds. This means that before and after the mix, the music will be 
faded to 50% over 0.5 seconds. Press OK.
8. Undo the operation.
9. Once again, drag Wow to TUTMUSIC and select the Slow duck Preset. This time, set the 
Destination Volume to 10% and press OK. The music will now fade out even lower. Both the source 
and destination volumes can be used to get the right mix of voice and music. The pre and post-fade 
times control how fast the destination sound is faded out and back in.



Editing Stereo Files
When editing stereo files you have two channels of data on which to work. The upper channel is the left 
channel and the lower channel is the right channel. We will refer to them in both ways left (upper), and 
right (lower).

Selecting Data in Stereo Files
When selecting data in stereo files, Sound Forge allows you to select either the left channel, right channel
or both channels for playing, editing, and effects processing.

When editing a stereo file, the Waveform Display showing the two channels is split into three logical 
sections for selection with the mouse. The upper quarter of the Waveform Display is the left channel "hit" 
section, the lower quarter is the right channel "hit" section, and the middle half is for both channels. When 
selecting data with the mouse, which area you are in determines what channel(s) will be selected.

Open the file TUTOR1.WAV and convert it to stereo by selecting Data Format from the Edit menu. Set 
the Channels to Stereo and press OK. Select both channels for the destination in the Mono to Stereo 
dialog. You should now have a stereo version of TUTOR1.WAV.

Move the mouse pointer near the top of the left channel and select the word "Wow". You will notice the 
cursor changes to the left channel selection cursor, and when you select only the left channel of the data 
becomes highlighted. Now do the same thing but in the middle half of the window near the top of the right 
channel and the bottom of the left channel. This time you should see both channels being selected. Do 
this one more time near the bottom of the Waveform Display and you should see only the right channel 
being selected.

Cursor when selecting both channels of a stereo file or when in a mono file.
Cursor when selecting the left channel of a stereo file.
Cursor when selection the right channel of a stereo file.

Toggling Channel Selections
Once you have made a selection in a stereo file you can switch between channel selections by pressing 
the Tab key. The Tab key will cycle between selections of left channel, right channel, and both channels. 
You can also set the channel selection by using the Channel drop-down list in the Set Selection dialog.

Previewing Channels
Selecting a single channel allows you to hear a preview of a single channel in the stereo file. For example
double-click in the TUTOR1 window to select all the data (or use Select All from the Edit menu). Press 
the Play button and listen to the clip. Next press the Tab key to toggle the channel selection into a single 
channel and press the Play button again. Do this one more time to hear the other channel.

Single Channel Editing
Stereo data files are "tied" together by their nature and other cosmic forces. In other words, they always 
play together. This means that there are some edit operations, such as Cut and Paste, which you can't 
use on a single channel. It would leave one channel shorter or longer than the other. This is usually not a 
problem in real world editing situations.

You can copy a selection from a single channel to the Clipboard by selecting the data in either the left of 
right channel and using the Copy command. This will place a mono clip on the Clipboard. You can then 
paste the mono clip to a mono file, both channels of a stereo file, or you can mix it into a single channel or
both channels of a stereo file. When mixing mono Clipboard data to a stereo file you will be asked with a 
dialog whether you wish to mix to a single channel or both channels.





Editing Sound Formats
This section will show you how to deal with the many different sound formats.

Changing sound formats
Converting 16-bit samples to 8-bit samples
Converting files
Embedding Summary Information in WAV files



Changing Sound Formats
When you open a file or create a new window, the format for the window is shown on the first three status 
fields of the main status bar at the bottom of the program window. The format parameters consist of the 
sample rate, sample size, and number of channels (mono or stereo). The last status field displays the 
Total Length of the sound data.

Changing the sample rate will make your sound play faster or slower and with a higher or
lower pitch. If you want the file to sound the same at a different sample rate, use the

Resample function under the Process menu.

When you right mouse click on any of the three format fields, a Shortcut Menu will pop up at the current 
mouse location allowing you to change that parameter. You can also change all three parameters at one 
time by selecting the Data Format option from the Edit menu. The Data Format dialog can also be 
invoked by double-clicking on any of the format fields, or by right mouse clicking on the Waveform Display
of the Data Window.

Open the TUTOR1.WAV file and select the Data Format item from the Edit menu. Notice that the current 
format is 22,050 Hz, 16-bit, mono.

Move the mouse pointer to the sample size field which currently displays 16-bit. Right mouse click on the 
field and a Shortcut Menu with 8 and 16 will appear. Select the 8-bit option and the status field will change
to 8-bit. Pressing the Play button will now play this file in 8-bit mode.

Mono to Stereo and Stereo to Mono Conversions
Next let's convert the file from mono to stereo. Right mouse click on the status field which has the word 
Mono and select Stereo from the Shortcut Menu. You can also do this by using the Data Format dialog.

When you do conversions from mono to stereo, you will be presented with a dialog which asks you where
you want to put the data. Your choices are as follows:

Left Channel The mono data is placed in the left channel. The right channel is set to silence.

Right Channel The mono data is placed in the right channel. The left channel is set to silence.

Both Channels The mono data is copied into both channels.

When performing stereo to mono conversions, the following options are available:

Left Channel Mono data is taken from the left channel of the stereo file.

Right Channel Mono data is taken from the right channel of the stereo file.

Mix Channels Mono data is created by mixing both channels of the stereo file.

For now let's put the data in the left channel so we can get a feel for how the function works. Click the 
radio button next to Left Channel and select the OK button.

You will now have data in the upper half of the Data Window (the left channel) and silence in the right 
channel. Press the play button and you will hear "Wow, sound editing is easy" in only the left channel. If 
you don't have a stereo sound card you will be notified that Sound Forge can't play this file on your sound 
card.

If your card supports only mono data you will still be able to edit stereo files; you just
won't be able to hear them unless you convert them to mono. In fact, you can perform

most of Sound Forge's editing features without having a sound card installed.



For now let's go back to a mono sample but we'll do it in a different manner. Select the option Data 
Format in the Shortcut Menu that appears when you right mouse click on the Waveform Display. The 
Data Format dialog will then appear. This box allows you to change all the parameters at once. Set the 
radio button for Channels to Mono and select the OK button. Select the Left Channel for the source 
channel in the Stereo to Mono dialog and we're back where we started.



Converting 16-bit samples to 8-bit samples
To save storage space, 16-bit samples are often converted to 8-bit samples. However, when you 
represent a sample with only 8-bits, an audible distortion referred to as quantization error becomes very 
prominent. To minimize quantization error, there are several things you can do to the 16-bit sample before
converting it to 8-bit. These include:

Apply a Noise Gate (Effects menu) to completely mute out the silent parts in a sample. Often, a low 
level signal in a 16-bit sample will become very loud noise after the 16 to 8-bit conversion, so it is best 
to have complete silence between the sound parts.

Apply Dynamic compression (Effects menu) to the sample. A small amount of compression (2:1 or 
less--just use the Presets) will lower the dynamic range of a sound, making it easier to represent using 
8-bit samples.

Normalize (Process menu) the sound. This ensures that the entire dynamic range available in 8-bit 
samples is used and lowers the signal to noise ratio.

Once you have performed the above operations, you should use the Dither to 8-bit command in the 
Process menu to do the 16 to 8-bit conversion. Dithering is used to mask the quantization noise with less
obtrusive noise. In the Dither to 8-bit dialog, set the dither bit depth to a low value (like 0.1) and increase 
the value slowly until you reach an acceptable sound.

Remember, an 8-bit sample will always sound noisier than a 16-bit sample, so whenever possible, stick 
with 16-bit samples. When trying to save space, it is possible to get better results from lowering the 
sample rate (see Resample in Process menu) instead of using 8-bit samples.



Converting Files
When producing audio files you may find that you need to provide the file to a customer in a variety of 
formats. This could be WAV files with data formats such as 8-bit mono, 16-bit stereo, or even ADPCM. 
You may need the files converted to RAW data, VOC, or some other PC format, or you may even need to 
convert to a different platform like Macintosh AIFF files or Amiga SVX.

We have seen in the previous sections that you can quickly convert between mono/stereo, 8/16-bit, and 
change the sample rate in Sound Forge. You can then use the Save As command to save the file to a 
new name, or you can save in a new format within the Save As dialog.

If you don't have TUTOR1.WAV open, open it up now. Select the Save As command from the File menu 
and the dialog for saving will be displayed.

When the Save As dialog is displayed, there are three controls that are used for file conversion, the File 
Save Type, the Format, and the Attributes. The File Save Type is the list of all available output file 
types. The Format field sets the format of the data which is saved in the file. The Attributes field controls
sample size, sample rate, and the number of channels.

When you bring up the Save As dialog, the File Save Type will be set to the type from which the file was 
opened (the default for new files is WAV). You can change the type of the file to which you want to save 
by selecting the new type from the File Save Type list. Notice that the extension of the file name will be 
changed to reflect the type of file you are saving.

The Format drop-down list shows the format of the data which will be saved in the file. Usually this will be
PCM which is the standard for most file types. PCM (Pulse Code Modulation) is a standard format for 
normal uncompressed audio. If you are saving a file to a file type which supports other formats, they are 
displayed in the drop-down list of this fields. Other formats are typically used when saving audio data in a 
compressed form.

The Attributes drop-down list shows the sample size, channels, and sample rate which will be stored 
when saving this file. Examples include 11.025 kHz, 8-bit Mono or 44.100 kHz 16-bit stereo. You can 
quickly change the attributes of the data by changing this field. When you change from a mono file to a 
stereo file using the Attributes field, that data is copied to both channels. If you change a stereo file to a 
mono file, the data is mixed to one channel.

When you change the File Save Type you may notice that the Format and Attributes fields will also 
change. This is because not all file types support the same types of sound data. For example the Dialogic
VOX format only supports 16-bit mono Dialogic ADPCM files. This means you can't store stereo 8-bit data
in this file. Don't worry, Sound Forge automatically converts any file you save to an acceptable format.



Embedding Summary Information in WAV Files
Microsoft WAV files allow you to store over 30 text fields in what is known as the INFO chunk. This allows 
you to embed information like Creation Date, Copyright, Keywords, and a variety of other informational 
text data. Sound Forge supports viewing and editing any of these fields.

Summary Information
When editing files of type .WAV the command Summary Information is available in the File menu. This 
allows you to view and/or change basic summary information currently stored in the file.

Extended Summary Information
The Extended Summary dialog consists of a list of available fields each of which may or may not have 
attached text. The Field list box shows the abbreviation of the field type, a short description, and if the 
field is currently empty the word (Empty) appears after the short description. Below the list of fields is the 
Contents text box which shows the contents of that field. At the bottom of the dialog is a longer description
of the current field.

To the left of each field in the list box is a check box which is used to enable or disable saving fields of this
type when saving .WAV files. The field is enabled or disabled by clicking on the check box. If a field is 
empty, i.e. has no text associated, enabling the check box has no effect on a saved file since field 
information is only saved if text information exists for that field.

The Save Summary Information in file check box in the Save As dialog is used to quickly 
enable/disable saving of all summary fields to a file during a Save As operation. This allows you to quickly
strip all summary information from a WAV file. 

For a description of the fields available refer to the section Appendix C: Summary Information Fields. 

Default
If the Default button is selected, the text in the summary fields will be saved as the default fields which 
will automatically be filled when creating a new WAV file. The field ICRD is always filled with the current 
date for new files and the ISFT is filled with the serial number of the copy of Sound Forge used to create 
the file. Saving a default setup is handy for saving copyright and engineer information for new files 
created at your site.

Open the file TUTOR1.WAV and select the Summary Information command from the File menu, this will
show you the Summary Information dialog. Notice that the default for saving summary information is to 
have all fields enabled. The fields which have already been filled in for TUTOR1.WAV are Comments, 
Copyright, Creation Date, Engineer, Keywords, Name, Product, and Software. Scroll to and select each 
field. You will see the embedded text for each of these fields.

Additional Embedded Information
The Microsoft .WAV file format allows non-text data to be embedded in the sound file. If you open and edit
a file which has additional information created by other software, Sound Forge will keep track of this data 
and place it back in the file when you save. 

If you wish to remove additional data (such as embedded bitmaps, metafiles, etc.), you can use the Save 
As item from the File menu. When you save data using the Save As option, Sound Forge will ask you if 
you wish to copy the additional non-Audio information to the new file. At this point you can answer either 
Yes to place the additional information in the n



Recording
Sound Forge has a variety of sound recording modes and options each of which come in handy for 
different situations. These include recording new data, recording over existing data, commonly known as 
Punch In mode, and Remote Recording.

Recording basics
Recording modes
Remote recording



Recording basics

The Record and Record Remote dialogs are always destructive and contain no
Undo capabilities. To prevent accidentally recording over sound data, record into a new
or scratch data window and paste the takes you want to keep into the desired sound data

window.

To start a record session you can either select Record from the Special menu or press the record button 
on the Transport toolbar. The record button is the first button on the Transport with the red circle on it.

If you experience problems recording, you can refer to the Questions & Answers sections for information 
on common recording problems.

After pressing the Record Transport button or selecting Record from the menu, you will be presented with
the Record dialog. Notice that the window into which you will be recording has it's title displayed in the 
dialog title.

In the upper left of the dialog are the recording attributes. These are the record sample rate, sample size, 
and number of channels which will be used when recording. These are the same as the attributes of the 
Data Window into which you will be recording. If you want to change these attributes you either need to 
exit the Record dialog and change them in the Data Window, record to a new window, or pick another 
window to record to.

Recording to a New Window
If you want to record to a new window rather than the currently selected record window, select the New 
button found at the upper right of the Record dialog. This brings up the New Window dialog where you 
can specify the Sample Rate, Sample Size, and number of channels for the new Data Window, which will 
also be used while recording.

Selecting an Alternate Record Window
If you wish to record to a window other than the one currently displayed in the Record dialog title, you can
do so by selecting the Window button. Pick the window into which you would like to record from the drop 
down list box in the Record Window dialog and select OK. The title of the window you select will now 
appear in the Record dialog title.

Available Recording Time
Near the bottom of the dialog you will see the Time recorded and Time left on drive fields. These two 
boxes show how much time you have recorded and how much time is available on your hard drive for 
additional recording. If your Time left on drive field is displaying a limited amount of available time you 
may want to free up some space on your hard drive or pick an alternate drive where Sound Forge stores 
it's temporary files. You can get more information on temporary file usage by referring to the Reference 
section on Temporary Storage.

Checking Record Levels
Sound Forge allows you to check the level of your input source before recording begins. To check your 
levels check the Monitor check box. The meters will light up relating to the volume of the recording input. 
For best results, the level should be somewhere in the yellow range with an occasional red. Once your 
levels are checked you can immediately begin recording by selecting the Record button. If you do not see
the meters light up, you may have your mixer levels or input source set incorrectly. You can refer to the 
Questions and Answers section for more information on these problems.

Adjusting Levels Using the Peak and Margin Values



The Peak and Margin values displayed next to the level meters are useful for maximizing your input level 
without clipping. When recording you almost always want your input signal to be as hot as possible 
without clipping. By this we mean you want your input levels to be as high as possible without exceeding 
the range of values which can be stored digitally when recording. When you clip, the peaks of your 
waveform become clipped off and you will hear noise. The Peak values show you the percentage of the 
total range which input levels have reached since you selected the Test button. The Margin values show 
you the percentage of level you have left until you will reach the clipping state. You never want your 
Margin to reach 0% or your Peak to reach 100%. If they do then clipping has occurred.

To adjust your levels check the Monitor check box so that Sound Forge begins to listen to your recording 
device. This is just like recording except that Sound Forge doesn't store any of the data it receives. Apply 
an input signal by speaking in your microphone, or playing your CD, or whatever it is you're trying to 
record. If the Peak value stays at a low value you should increase the levels of sound you are supplying 
so that the Peak value is somewhere in the 90% range and the Margin value is somewhere between 0 
and 10%. If the Margin reaches 0% (or the Peak 100%) then you have clipped and need to lower your 
input levels. Once you lower your input levels select the Reset button to clear the current peak and 
margin values. Sound Forge always keeps the maximum peak and minimum threshold value since the 
last time you selected the Reset button.

Once you have adjusted your levels you can immediately begin recording by selecting the Record button 
or end monitoring the levels by unchecking the Monitor button below the Meters.

It is particularly important to record sounds with the hottest levels possible when you plan
to later convert 16-bit data to 8-bit. This assures that you will use the greatest dynamic

range possible in an 8-bit file which has less values with which to represent the
waveform.

Previewing Recorded Sounds
After recording your material, you can listen to what you have recorded by selecting the Play button. You 
can also listen to the section over which you plan to record in Punch In mode. To stop playing select the 
Stop button at any time.

Using the Prepare Button
The Prepare button is used when you need Sound Forge to begin recording as soon as possible after 
selecting the Record button. The Prepare button opens the wave device and loads all recording buffers in 
order to minimize the time between selecting the Record button and sound actually beginning to be 
recorded.

The Prepare button is optional. It is not necessary to select this button prior to recording, however it does 
allow for more accurate takes in the Punch In mode.



Recording Modes
Sound Forge has four different modes of recording. These are Automatic Retake, Multiple Takes with 
Regions, Multiple Takes (no Regions) and Punch In. Each mode is described below.

Automatic Retake
The Automatic Retake mode is the easiest method of recording. Recording starts at the position shown in 
the Start field when you select the Record button and continues until you select the Stop button. Any data 
which is currently after the position in the Start field will be replaced. When recording is stopped, the start 
position is reset to the beginning of the take allowing an immediate review and retake if desired.

Automatic Retake is the default mode when recording into an empty Data Window or when you select the 
record button with no data selected in the current Data Window.

Multiple Takes with Regions
The Multiple Takes with Regions mode allows multiple takes to be recorded and each take with 
automatically have a Region defined in the Regions List. Recording starts at the position shown in the 
Start field when you select the Record button and continues until you select the Stop button. Any data 
which is currently after the position in the Start field will be replaced. When recording is stopped, the start 
position remains at the end of the next take allowing the take to be recorded immediately.

Multiple Takes (no Regions)
The Multiple Takes (no Regions) mode allows multiple takes to be recorded, but no Regions are defined 
in the Regions List. Recording starts at the position shown in the Start field when you select the Record 
button and continues until you select the Stop button. Any data which is currently after the position in the 
Start field will be replaced. When recording is stopped, the start position remains at the end of the take 
allowing the next take to be recorded immediately.

Punch In
Punch In mode is used when you want to record over a region of data in an existing Data Window. 
Recording starts at the position shown in the Start field when you select the Record button and continues 
until you select the Stop button, or the length of the data recorded is equal to the length in the Length 
field. This makes it easy to record over a section of audio without effecting the rest of the file. You can use
the Play button to hear the selected Punch In region at any time.

You may adjust the Punch In region by changing the values in the Start, End, or Length edit fields. You 
may also adjust the format of these fields to a variety of different display status formats by selecting a 
format from the Input format drop down list box.

Punch In mode is the default mode when you select the Record option while you have a region of data 
selected in the current Data Window.

Using Pre/Post-Roll with Punch In Mode
At the bottom of the Record dialog are two edit fields which contain the Pre-Roll and Post-Roll times. 
These can be used when listening to a region in Punch In mode. These times define the amount of audio 
you will hear prior to (Pre-Roll), and after (Post-Roll), the selected region when using the Play button. This
allows you to hear the transitions between the Punch In region and sound before and after the region. If 
you wish to use the Pre/Post-Roll option you must check the Review check box at the bottom of the 
dialog. To disable Pre/Post-Roll uncheck this box.

Recording Status
While you are recording, the amount of time recorded will increase and the Time left on drive will 
decrease. Make sure and keep an eye on your Time left on drive if your available record time is limited. 
It's never fun running out of recording time!

Finishing Recording



When you have finished recording select the Close button to exit the Record dialog and return to normal 
editing mode.



Remote Recording
By selecting the Remote button you enter into Remote Recording mode. Remote Recording mode hides 
the main Sound Forge window and puts up the small Record Remote dialog which always stays as the 
top-most window.

The Remote dialog gives you a smaller set of recording controls which makes it easy to control other 
applications in your system while recording. This is particularly useful when using applications that control
your input sources, sound levels, CD audio, or MIDI sequencing. To return to normal record mode from 
the Remote dialog select the Un-Remote button.



Applying Sound Processing Functions
The Effects, Process, and Tools menu contains a large number of functions which are used to apply an 
effect on the sound data, display information, or even synthesize new sounds. Each function is 
documented in detail in the Reference section. In this section, we will run through a few of the functions to
help you get a feel for using them.

Applying sound processing effects 
Applying Effects to Stereo Files 
Getting Help on a function 
Using Controls 
Presets 
Processing shortcuts 
Changing the selection affected by the function 
Previewing an Operation 



Applying Simple Processes and Effects

Applying an effect to the entire sound file
To apply an effect you may first select a section of data on which you wish to operate. To select the entire 
file, double-click on the Waveform Display.

If you do not have a selection when you perform an effect which requires one, Sound
Forge will apply the effect to the entire file.

To show how effects are used we will once again be using the TUTOR1.WAV file. If it is not currently open
please open the file now as described in a previous section.

Select the Reverse item from the Process menu. The reverse operation reverses the data selection, 
making it sound like it's playing backwards. Once the operation has finished, press the Play button to 
hear how TUTOR1 sounds when played backwards.

Applying an effect to a section of the sound file
Select the Undo Reverse item from the Edit menu to put TUTOR1 back to it's original state. Now select 
only the word "Wow" in the window and again select the Reverse item in the Process menu. Play the file 
again and notice how only the word "Wow" is played backwards. After you have listened to the effect, 
undo the reverse again so we can try another effect.

Again, let's select only the word "Wow" in the TUTOR1 window. This time after selecting the data, select 
the Volume item in the Process menu. Use the Scale Factor fader to set the scaling to 50% and select 
OK. If you press Play you will notice that the volume is now at 1/2 of it's original volume.

You can undo the last operation by selecting Undo from the Edit menu

The previous two examples show you how easy it is to apply effects to files. Sound Forge has a large 
number of different processes and effects, ranging from simple volume changes to complex multi-tap 
reverb/delays. To learn about a particular effect, please refer to the Sound Forge Reference section under
the Effects, Process, or Tools menu.

Canceling a function in progress
While applying an effect, the progress meter at the lower left hand side of the main screen shows what 
percentage of a selection has been processed while running a function. You can select the Cancel button 
to stop processing the file. When you cancel an operation in progress, the affected data remains in the 
sound file. Undoing the operation will return the file to its original state.



Applying Effects to Stereo Files
In a stereo file, only the selected region in the channel which you've selected is processed. Most functions
can be applied to either the left, right, or both channels. The only functions which cannot be applied to 
separate left and right channels are function which affect the length of the data, since each track in a 
stereo file must be of the same length. These include Insert Silence, Resampling, Time Compression 
and Expansion, Gapper/Snipper, and Pitch Change (without preserving duration). Also, the Pan 
function by its very nature must have two channels on which to operate. 

If you need to run a process like Insert Silence in only one channel, you should divide the stereo file into 
two mono files first, insert the silence, and then join them back together into a stereo file. Separating 
stereo files into two mono files is a good idea if you are going to be changing the duration of each track by
cutting or inserting space to synchronize different events.

Applying a Function to a Single Channel in a Stereo File
Previously, we reversed TUTOR1 so that we could hear how the data sounded when played backwards. 
Now let's try this on a single channel of a stereo file. First convert TUTOR1 to stereo by right mouse 
clicking on the status field which has the word Mono and select Stereo from the Shortcut Menu as we did 
in a previous section. Make sure and select the Both Channels option in the dialog so we have data in 
both channels of the new stereo file.

Select the entire left channel by double-clicking with the mouse in the upper 1/4 of the TUTOR1 
Waveform Display. If you select both channels, just use the TAB key to toggle the selection to only one 
channel. Now select the Reverse item from the Process menu. You will notice that only the left channel 
data is reversed. Press the Go to Start button on the Playbar to clear the selection and place the cursor 
at the start of the file. Press the Play button and you will hear "Wow, Sound editing is easy." backward in 
the left channel and forward in the right channel. If you only hear one channel then you are in single 
channel preview mode. To hear both channels use the TAB key to toggle the cursor or selection to 
encompass both channels and again press the Play button.



Getting Help on a function
If you want more information on how to use a function, press the F1 function key while selecting the 
function title in the menus. Also, you can press the F1 function key or the Help button while in the function
dialog of those functions with dialogs.



Using Controls
Before going any further, let's become familiar with all of Sound Forge's different controls used to enter 
function parameters. To do this, open a new file and select the FM Synthesis item from the Tools menu. 
Don't worry about understanding what all of the parameters mean. Let's just play with the knobs.

Vertical Fader and Horizontal Trackbars
There is nothing complicated about these controls. To change the parameter values, just left-click and 
hold on top of the thumb and drag left and right or up and down.

There are many keyboard shortcuts for when using faders and trackbars. You can use the Up, Down, Left 
and Right arrow keys to change the value in small increments or the Page-up and Page-down keys to 
change the value in larger increments. The Home and End keys change the parameter value to its 
maximum or minimum.

If you double-click on a fader or trackbar thumb, it returns to its reset value (usually 0%, 50%, or 100%). 
Left-clicking on the hash marks in a Fader changes the value by very small increments. 

In the FM Synthesis dialog, the Amplitude is controlled by a Fader and the Feedback is controlled by a 
Trackbar.

Edit Box Spinner Control
With this control, you have several options on how to change a parameter value. You can: 

-Type in the number by left-clicking on the edit box and then typing in the value. You can also use the 
Up/Down and Page Up/Page Down keys to alter the value.

- Increment the value by clicking on the two small up/down buttons.

- Use the spinner to change the value. This is done by left-clicking on the center button (between the 
two up/down buttons) and dragging the mouse up or down.

This control is used to change the Length and Frequency of the waveform in the FM Synthesis dialog.

Drop-down list
To select an item from a drop-down list, click on the Drop-down list and select the item. If you have to 
scroll through a large list, click on the scroll buttons or use the arrow keys.

The FM Synthesis dialog uses a Drop-down list to change Presets, select waveforms, or change 
operators.

If you scroll down a Preset's drop-down list, you can see all of the Preset parameters
change for each Preset. This is useful for getting a feel of what parameters are used to

create different effects.

Push Button
To use a push button, left-click on it or press the space bar while it has focus.

In the FM Synthesis dialog, the OK, Cancel, Help, Save As, Delete, Selection, Preview, and Reset 
controls are push buttons.

Radio Button
Radio buttons always come in a group of two or more. They are used like the radio-station selector in a 
car radio; turn one on and the rest turn off.



The Insert At control in the FM Synthesis dialog is a group of radio buttons,

Check Box
A check box as its name implies, is a square box you can check or leave blank. They are used to turn a 
feature on or off.

There is no check box in the FM Synthesis dialog.

Envelope Graph
Envelope Graphs are used to draw the shape of a frequency or amplitude envelope that will be applied to 
the graph. The horizontal axis represent time, with the left most point being the start of the selection and 
the right-most point being the end of the selection. The vertical axis represents either amplitude or 
frequency.

To create a new knob on the graph, left-click anywhere on the Envelope Graph and drag the knob in any 
direction, sort of like pulling a string.

You can delete a knob by double-clicking or right-clicking within it.

To reset the graph (delete all knobs) click on the Reset button.



Presets
Using a Preset
Most processing functions allow you to store the current settings for later use. There are also System 
Presets for each effect which can be used without having to learn what all of the knobs and tweakers do. 
These Presets are also a good place to start when you're creating your own effects.

Open the file TUTOR1.WAV again. Under the Effects menu, select Noise Gate. The Noise Gate function
mutes any sounds below a threshold level. Using the Drop-down list labeled Name, scroll down the 
Presets list. Notice that the all of the controls change automatically. Now select one of the Presets and 
select OK. Note that if you didn't have a selection when you ran the effect, the entire file was processed.

Creating and Storing your own Preset
Now open the file TUTOR2.WAV. Select a large portion of the drum hit and then select the item Pitch 
Bend from the Effects menu. 

The Pitch Bend function variably changes the pitch of the wave over time by using a pitch change 
envelope. Use the following steps to create your own pitch bend effect:

1. Press the Reset button. This restores the pitch bend envelope to its reset state.
2. Now raise the Range trackbar to 12 semitones. This affects the range of the pitch change. In this 
setting, the maximum pitch bend is 12 semitones (one octave).
3. To change the pitch bend envelope, left-click on a point on the envelope. You can move a point 
around by dragging it or you can remove it by double-clicking on it. Create an envelope similar to the 
one shown here:
4. Now, select Save As to store this Preset. You can name this Preset whatever name you'd like and 
then select OK.
5. Press OK again to run the function. You should be able to hear the drum hit change in pitch relative
to the envelope you drew.
6. From now on, you have the option of using the effect you just created by selecting it from the drop-
down list. If you decide you don't have use for this effect in the future, you can always delete the 
Preset by selecting it in the Drop-down list and selecting the Delete button.



Processing shortcuts
Repeating an operation
To execute a function with the same parameters as the last time the function was used, hold the Shift key 
down while selecting the function. This is known as "shift clicking" and works for most operations in 
Sound Forge, not just the effect operations. "Shift Clicking" works for toolbar buttons as well as menu 
items.

You can also use the Repeat item (CTRL+Y) under the Edit menu to quickly repeat the last operation 
used. This works for all Process, Effects, and Tools functions in Sound Forge. Holding down the Shift key 
while selecting Repeat takes you to the last function's dialog.

Toolbars
If you like toolbars, there are toolbars for the functions under the Process, Effects, and Tools menus. To 
use these toolbars, you must go in the Toolbars Preferences folder (File menu) and turn on the toolbars 
you wish to appear on your screen.



Changing the selection affected by the function
To apply a function on a region other than the current selection, select the Selection button in the 
function's dialog (you cannot do this with functions that do not have a dialog, such as the reverse 
function). This causes the Set Selection dialog to appear.

In the Set Selection dialog, you can change the start, end, length, and channels which will be affected by
the function. You also have a choice of the format in which you are going to enter these values or can 
even use a Preset selection.



Previewing an Operation
You can preview how a function will affect a sample by using the Preview button found in most sound 
processing dialogs. This is useful for fine-tuning parameters without having to leave the dialog.

To A/B test (with and without processing) the sample, use the Bypass check box. When the Bypass box 
is checked, selecting the Preview button will play the unprocessed data. Otherwise, you will hear the 
processed sample. Note that you can change the state of the Bypass check box while the preview is 
playing to quickly switch between A and B. This is most useful when the Loop preview continuously 
option is enabled.

You can temporarily select the length of data you wish to preview by selecting Preview Configuration 
from the dialog System Menu (single-click on the square button at the upper left hand side of the dialog). 
You can set a permanent preview configuration by using the Preview folder in the Sound Forge 
Preferences section (or by selecting the Default all previews to the current settings in the Preview 
Configuration dialog).

In the Preview Configuration dialog, you can have Sound Forge play the preview and unprocessed files 
in looped mode. To quickly get to this dialog, hold the Control key down and click on the Preview button. 
Check the Loop preview continuously check box and press OK. Now, when you Preview an effect the 
sound repeats continuously. Also, if you check the Bypass button on and off during preview playback, you
can switch between processed and unprocessed sound previewing.



Sound Processing Techniques
In this section, we will cover some basic concepts relating to some of Sound Forge's processing functions
used for modifying (or creating) sound. Detailed information about each effect is also available in the 
Reference Section.

Delay
Reverb
Chorus
Flange
Noise Gate
Compression and Limiting
Expansion
Changing Pitch and Time Duration
Simple and FM Synthesis
Graphic and Parametric EQ



Delay
The Delay/Echo function creates copies of the original sound which are then mixed with the sound file to 
create simple echo effects.

Open TUTOR1.WAV and select Delay from the Effects menu. Choose the Slap-back echo Preset and 
select Preview. A single copy of the sound is heard 0.4 seconds after the original. Changing the delay 
time determines the time between the original and echoed sound.

Now, select the Grand Canyon Preset. Notice that the Multiple delays check box is checked. This means 
that instead of just one echo, you will hear multiple, decaying echoes of the original sound. The Decay 
Time determines how long it takes for these echoes to fade out.

The Pre-Delay function creates echoes heard before the original sound. Use this effect while the 
spaceship in your next sci-fi flick travels back in time by means of a wormhole.



Reverberation
Reverberation is the result of sound reflecting off of room surfaces. Having traveled different distances 
and bounced off different materials, these sound reflections do not reach the listener at the same time 
and have a different frequency content than the original sound source. When blended together, these 
reflections become what we recognize as reverberation. To the listener, reverberation gives aural cues 
about the sound source location, such as room size and wall material.

Simulation of these sound reflections is accomplished using delay taps and feedback along with other 
processing functions like pitch modulation and filtering. A delay-tap is a time-delayed copy of the sound 
which, depending on the feedback setting, gets repeated over time. Delay-taps are used to generate the 
early reflections which are heard as echoes. Using feedback generates decaying copies of the early-
reflection. This simulates sound bouncing around in a room to generate reverberation.

In Sound Forge, the Reverb function allows you to specify up to eight delay-taps spaced anywhere within 
one-half second of the original sound. For normal reverberation , the delay taps decrease over time. 
However, the Reverb function in Sound Forge is not limited to reverb simulation. With different tap 
arrangements, many non-reverb effects are possible.

Open the file TUTOR1.WAV and select the Reverb item from Effects menu.

Now, select Large Hall 1 from the Presets list. To hear the effect, select Preview. Selecting Bypass allows 
you to listen to the unprocessed file. 

This Preset uses all eight delay-taps. To switch between taps, use the Tap drop-down list. There is a delay
time and an amplitude associated with each delay tap which determine when and how loud the delay tap 
is heard after the original sound. In stereo files, each tap can also be panned left or right, to simulate 
sound coming from all directions.

The selected tap is represented as a red vertical line on the echogram. The echogram shows an 
approximation of the impulse response of the current reverb settings and can be used to estimate the 
reverb decay time. Blue lines correspond to other active taps and black lines are feedback echoes.

The horizontal axis of the echogram is time, with the right-most point equal to the Graph Resolution scale 
setting. The vertical axis represents the amplitude of the echo. You can change the scale factor between 
500, 1,000, or 5,000 milliseconds for viewing the impulse response over different time ranges.

By changing the Feedback, you can change the decay time of the reverb. Notice that if you have the 
feedback too high, the echoes keep adding up until they are clipped (use the 5000 ms Graph Resolution 
setting). Too much feedback also creates unnatural ringing of some frequencies.

Select the Default all parameters Preset. Here, there is only one tap active, with no feedback. This 
corresponds to a simple delay. Set the Dry Out to zero and turn on the Lowpass filter. Lowpass filtering 
removes high frequencies, in the same way that many building materials absorb high-frequency sounds. 
Adding modulation creates slight pitch changes, which can make a reverb sound fuller.

Next, convert the file into a stereo file, with sound in both channels. Try using the Tapped-Delay, Stereo 
Pan setting and listen to how the sound bounces between left and right channels. This might me used to 
simulate a stereo recording from a mono file.

Now, switch to the Chorus-reverse verb. Here, the delay taps increase in magnitude over time, thereby 
creating a swelling effect. With a bit of experimentation with tap arrangements, many other sound effects 
are possible.



Chorus
The Chorus function is used to simulate multiple sound sources from a single sound. This is achieved by 
mixing a delayed, pitch modulated copy of itself to the sound source.

With TUTOR1.WAV open, select the Chorus item from the Effects menu.

Preview the Chorus 2 effect to hear an example of chorusing. Increase the depth to 50% to have a slowly 
detuning effect. The rate changes how fast the detuning occurs.

Changing the Delay time effects how much later the modulated sound is heard. Very small values usually 
create interesting filtering effects, such as flanging. With larger values, chorused echoes are created.

The Feedback and Size parameters change the strength of the chorus. Large Feedback or Size values 
intensify the chorus. You can use the Lowpass filter to remove unwanted high frequencies.



Flange
The Flange function is used to create the sweeping effects often heard in 60's guitar recordings and 
techno-sounds of today.

To hear what flanging sounds like, open TUTOR1.WAV and select Flange from the Effects menu.

Preview the Slow Flange 2 effect. The rate and depth parameters are similar to the ones in the Chorus 
effect and can be used to create faster, slower, or stronger flanging.



Noise Gate
Noise Gate
When recording a sound, there is often an audible noise floor during silent breaks. Noise is generated by 
many different things, including electrical equipment, machinery, and traffic outside your window. When 
your sound source is much louder than this background noise, it is simple to remove the noise during 
silent breaks, where the noise is most noticeable, with a noise gate.

For example, open TUTOR1.WAV. Move the cursor to a location between Wow and Sound and select 
Insert Silence (Process menu). Specify 1 second of silence to be inserted at the cursor point. Next, 
create a new file. In the new file, use Simple Synthesis (Tools menu) to generate four seconds of noise 
at 1% amplitude (keep the frequency around 2,000 Hz). Next, copy all of the noise on to the Clipboard 
and mix it to the beginning of TUTOR1. Use 50% for the noise (source) and 100% for the voice 
(destination). You should now have a file with voice and a relatively low hissing sound in the background.

To remove the noise during silent breaks, first you should analyze the amplitude of the noise. In TUTOR1,
select a region with only noise (no voice), and run the Statistics function under the Tools menu. Take 
note of the Maximum Sample Value percentage. If you followed the preceding steps, it should be close to 
0.5%.

Next, select Noise Gate from the Effects menu.

In the Noise Gate dialog, select the Noise Gate 1 Preset. Slide the threshold level to a bit over the 
Maximum Sample Value (in percentage). A value of 1.0% (-20 dB) should be high enough to differentiate 
the noise from the vocals. Press OK. Notice that the noise during the silent regions should have 
disappeared (total attenuation). If it didn't, try raising the Threshold Level until it does.

The other two parameters in the Noise Gate determine how fast the gate will open and close. This will 
affect how the beginning and end of the sound will fade in and out. If the Attack time is too slow, the 
beginning of the vocals might get cut off. Likewise, if the Release Time is too fast, the end of the vocals 
will be cut. Experiment with these times until you can remove as much noise as possible without removing
any of the voice.



Compression and Limiting
Compressing and Limiting are terms used to indicate effects that lower the dynamic range of a sound. 
When you compress a sound, you lower the volume of loud sections and raise the volume of soft sections
in the sound file. This is done to keep the volume level from fluctuating too much over time. Limiting works
exactly like compression, but to a higher degree.

Open the file TUTOR1.WAV. Make a copy of it by selecting the whole region and dragging it to an open 
space in the Sound Forge workspace. Now, with the new file active, select Dynamics from the Effects 
menu.

Choose the 2:1 Compression with low-level gain Preset and select OK. If you can see both files at once 
and are zoomed out, you'll be able to notice how the levels of the new file are more constant than the 
original. Listening should reveal the same thing. However, compression often adds more fullness to 
sounds because it tends to increase low frequencies.

In this Preset, sounds above the Center Level (10 %) are attenuated while sounds below the Center Level
are boosted. Sounds below the Threshold level (2.51%) are not affected by the compressor. Instead, they
are affected by the Pre-threshold gain. The Output Gain of 150% raises the total volume of the file after 
processing to bring the overall output level back to an acceptable level.

Undo the previous operation and select Dynamics again. Now, increase the Ratio to 7:1 and select OK. 
The sound will be even more compressed, meaning that more attenuation and boosting will be applied to 
compressed signals.

Again, undo the operation and select the -3 dB Limiter Preset. Notice that the Maximum Gain setting is 
set to 100%. Now, signals above the Center level (50%, or -3 dB) will still be attenuated, but signals below
the Center level will not be boosted because the gain will be clamped at the Maximum Gain of 100%. 
The Maximum Gain sets the maximum allowed gain during compression or expansion (the Output Gain 
applied afterwards is not affected by the Maximum Gain).

Limiting is often used to keep signals from going above a certain level, but can also be applied to create 
heavily-compressed effects.



Expansion
Dynamic Expansion is the opposite of compression and limiting. Sound above the Center Level gets 
boosted and sound below gets attenuated. The most common effect of expansion is to attenuate low-level
noise, such as a noise gate. However, you can also use expansion to add more dynamic range to a 
sound.

With the TUTOR1.WAV file open, select Dynamics from the Effects menu. Choose the Expander/Noise 
Gate 1 Preset and select OK. Notice how very low-level sounds have been attenuated. This is useful for 
removing noise from silent regions in a similar fashion as a noise gate.



Changing Pitch and Time Duration
Altering pitch by changing playback rate
You are probably familiar with how changing the playback rate of a recording affects its pitch. For 
example, playing a 33 1/3 RPM vinyl record at 78 RPM makes the Beatles sound like the Chipmunks. 
Likewise, playing a 78 RPM record at 33 1/3 makes a trumpet sound like a tuba. This concept is used by 
most sampler units to make a single sample achieve different pitches.

Open the file TUTOR2.WAV. Under the Effects menu, select Pitch Change.

Next, select the Octave Up Preset and select OK. Notice that the length of the file is exactly one-half of its
original size. Listen to the sound to hear both a higher pitch and a faster rate.

Undo the last operation and return to the Pitch Change dialog. Now, select Octave Down and select OK. 
The file is now twice as big, slower, and lower in pitch.

Altering pitch without changing the duration of the sound
Undo the last operation and return to the Pitch Change dialog. In the last two examples, the Preserve 
Duration check box was left unchecked. When you check this box, a completely different algorithm is 
used to change the pitch of the sound. Instead of changing the playback rate, the sound is broken into its 
different frequency components and re-synthesized at a new pitch. Select the One-third up Preset and 
check the Preserve Duration check box. Now, preview the sound. The sample will now have a higher 
pitch, but it will not sound as if its being played back faster.

Changing time duration without changing the pitch of a sound
Another Sound Forge process unique to digital processing is the ability to stretch or compress the time 
duration of a sound without altering the pitch. This is useful for lengthening or shortening sounds to meet 
a specific time length.

Open TUTOR1.WAV and select Time Compress/Expand from the Process menu.

This process is very simple to use. In the dialog, you have the ability to specify the final duration of a 
sound, from 50% to 150% of the original length. Set the duration change to around 90% and select OK. 
Press the Play button and you should hear that the drum hit is now about 0.15 seconds less in duration. 
For best results you should keep the duration change between +/- 10%.

Other ways of using Time-Compression/Expansion and Pitch Change
When using the Preserve Duration algorithm, the Pitch Change function is very computationally intensive
and can take a long time to process a sound. Also, when making large pitch changes it can add unwanted
artifacts to your sound. Likewise, the Time Compression/Expansion algorithm can also degrade the 
sound of your file in some circumstances. Here are some suggestions for you to try when trying to change
the pitch or duration of a sound:

Small and accurate changes in time duration
If you have a sound file that is one minute and three seconds long, but you need it to be exactly one 
minute, there are two ways to go about it. If a very small change in pitch is acceptable, you might try using
the Pitch Change with no Preserve Duration. Keep the Semitones at 0 and adjust the Cents until the 
required Final Length is reached. It is sometimes possible for this method to give better sounding results 
than if you used the Time Compression algorithm.

Changing pitch and then compensating for a change in duration
Let's say that your singer hit a few flat notes. Of course, you can use the Pitch Change with Preserve 
Duration to change the pitch without changing how long the voice lasts. Another possibility is to change 
the pitch with Preserve Duration off, and then compensate for the change in duration using the Time 
Compress/Expand algorithm. This method is much quicker, and in some cases provides better results. If 
the amount of time that you are pitch correcting is small, you may not even need to correct for time as the 



time difference in this case is small as well.



Synthesis
Simple Synthesis
The Simple Synthesis tool can be used to generate a simple waveform of a given shape, pitch, and 
length. More complex waveforms can be generated with the FM Synthesis tool.

Create a new window by selecting the New item from the File menu and set the data format for the 
window to be 16-bit, 22,050 Hz, mono. Next select Simple Synthesis from the Tools menu.

Select the Middle C Reference (3 Secs.) Preset and press OK to generate a Sine wave in the window that
is 3 seconds long and has a pitch of 261.52 Hz (Middle C). Press the Play button to hear your reference 
tone.

FM Synthesis
Sound Forge's FM Synthesis tool allows you to use frequency modulation (FM) and additive synthesis to 
create complex sounds from simple waveforms. 

In frequency modulation, the frequency of a waveform (the carrier) is modulated by the output of another 
waveform (the modulator) to create a new waveform. If the frequency of the modulator is low, the carrier 
will be slowly detuned over time. However, if the frequency of the modulator is high, the carrier will be 
modulated so fast that many additional frequencies, or sidebands, are created.

Sound Forge allows up to four waveforms (operators) to be generated in a variety of configurations. 
Depending on the configuration, an operator can be a carrier, a modulator, or a simple unmodulated 
waveform. Waveforms can also be added together (additive synthesis) to add more complexity to the 
sound.

The best way to become familiar with this module is to start with a single operator configuration and try 
out all the different waveforms by themselves. Experiment using feedback on each waveform to hear the 
different effects of self-modulation. Feedback adds overtones to the sound by modulating the sound with 
itself. Zero feedback indicates simple synthesis.

In the second configuration, two unmodulated operators are mixed together (horizontal connection) and 
heard simultaneously (Additive Synthesis).

Now change the configuration to two stacked operators (vertical connection) and again experiment using 
different waveforms and frequencies on the carrier (bottom operator) and the modulator (top operator). 
With the modulator frequency set low (1-5 Hz), lower the modulator amplitude to create slight detuning. 
Raising it creates big pitch bends. If the modulator frequency is set high, many unusual FM sounds can 
be achieved. Make sure that the modulator amplitude is not too high, otherwise the result will be harsh 
noise-like sounds.

Setting the modulator frequency to 0.00 allows absolute control of the carrier's pitch by using the 
modulator's envelope, which you can use for detuning over time.

Adding more operators increases the complexity of the waveform. When both FM and additive synthesis 
are combined, an almost endless variety of sounds can be generated.



Filtering
What can you do when you have a sound that is not quite perfect, but not bad enough to throw away? 
Sometimes, judicious use of filtering can keep a favorite sound bite from losing favor. Filtering is not a 
cure-all for bad sound, but slight alterations of a sound can bring it back to life.

Sounds are composed of varying amounts of one or more frequencies. For example, a sound with a rich 
timbre will contain many different frequencies. A sine wave sound has only one frequency in it, like 60 or 
440 Hz.

Filters allow the tailoring of the frequency spectrum of a sound. A spectrum is nothing more than a 
representation of how much of each frequency component (from 20 Hz up to one-half the sample rate) is 
present in a signal. Less of any given component means that the given frequency component is not as 
prevalent aurally as another component. Filters pass or reduce (attenuate) frequency components in 
response to your inputs through Sound Forge. Note that other factors such as the frequency response 
characteristic of your computer's speakers and sound card can also affect which frequencies are more 
prominent during the playback of a sound.

Graphic EQ
The Graphic EQ divides all the possible frequencies into ten bands which you can boost or attenuate 
(cut). Each band has a center frequency related to it. The 125 Hz band, for example, affects frequencies 
between 90 and 190 Hz. The Gain value above each band indicates the amount of cut or boost applied to
the band. When a band is set to zero, it means that the frequencies in the band will not be modified. 
Positive Gain values indicate a boost and negative values indicate a cut in amplitude.

Open TUTMUSIC.WAV and select Graphic EQ from the Tools menu.

Select the Cut high frequencies (fast) Preset and press OK to remove the high frequencies from the 
Music Bed file. Press the Play button to hear how the music is much boomier.



Parametric EQ
There are four basic types of parametric filters: bandpass, band reject (notch), lowpass, and highpass. A 
bandpass filter alters frequencies outside of a specified range. A notch filter alters frequencies inside a 
specified range. A lowpass filter alters frequencies above a certain value, and a highpass filter alters 
frequencies below a certain value. Generally, each filter attenuates frequencies in its stopband range(s) 
and leaves frequencies in its passband range alone.

The rate at which the passband transitions into the stopband is the transition band (or rolloff). When you 
specify the characteristics of a filter in Sound Forge, you will no doubt be tempted to specify that a 
lowpass filter will start to transition at, say, 1,000 Hz and finish transitioning by 1,001 Hz. The problem 
with doing so is that there are mathematical limitations to creating such a filter. When you specify a sharp 
transition band, the software will try to design a filter that will take a long time to apply and will 
unnecessarily filter the signal to overly exacting requirements. Razor-sharp filtering can often create 
unwanted side-effects. The more subtly you filter a signal, the more natural it sounds! 

When specifying the attenuation amount for your filter, you are selecting how much to de-emphasize the 
frequency components that you do not want to hear. Numbers that are more negative suppress the 
frequency components more heavily. In other words, -6 dB of stopband rejection is going to let more 
unwanted frequencies through than -15 dB will.

So lets say you just sampled a great hamster sneeze, but there is something not quite right about it when 
you play it back later. What can you do to restore the hamster sneeze to its rightful place as your favorite 
sound in your Windows environment?

Maybe you used a microphone preamp that had bad common-mode rejection characteristics, or you set 
the hamster right next to a lamp when you recorded the sneeze? Well, don't panic, because Sound Forge 
can fix that sound. Try applying a 60 Hz notch filter to the sound. A notch filter will "notch-out" the 
frequencies in a range about 60 Hz so that they are not as readily heard relative to other frequencies. 

Maybe the hamster sneeze has too much "hiss" in it? Try applying a lowpass filter and see if that makes it
better. Remember, a small amount of filtering goes a long way.

One way to approach filtering your sound is the following. Start using Graphic EQ to find the frequency 
bands that are offensive or need to be boosted. Then, revert to your original sound and try applying the 
more exacting parametric filter to the sound. By using the Graphic EQ as a rough cut at editing and the 
parametric filter as the final tune-up you can hone the sound to its final (better-sounding) form.

Open TUTMUSIC.WAV and select Parametric EQ from the Tools menu.

Select the Phone-line Preset and press OK to run the filter. Press the Play button to hear how the music is
much thinner sounding, quite like hearing it over the phone.

Note: The filters in Sound Forge are digital FIR (finite impulse response) filters, which are better than IIR 
(infinite impulse response) filters with regard to the amount of phase dispersion that occurs to your sound.
In case you care, phase dispersion is a bad thing. By using FIR filters, Sound Forge ensures the phase 
coherency of your sound.



The Playlist and Edit Decision List
In this section, we will go over Sound Forge's ability to create regions and markers in a Data Window and 
how to use the Playlist to arrange them. Each Data Window has its own Regions List and Playlist stored 
along with the sound data when using the .WAV file format.

Uses for the Regions List and Playlist
Creating Regions
Editing Regions
Arranging Regions in the Playlist
Creating a new file from the Playlist
Using Markers



Why use the Regions List and Playlist?
Fast Navigation
The most basic use of the Regions List is for dividing a sample into separate named regions. These 
regions can then be quickly played or highlighted in the Data Window. You can also mark important time 
positions with markers so that you can get around large files faster.

Destructive vs. Non-Destructive Editing
When you perform edits on sound files using cut-and-paste operations, Sound Forge must shift the sound
data on your hard-drive. When working with large files, this process can take longer than your patience 
can handle. However, when you create regions in the Regions List and then rearrange them in the 
Playlist, only the playback (as opposed to the hard-disk storage) order changes. This is called non-
destructive editing since no large chunks of data are moved or deleted in your original file.

With non-destructive edits, as opposed to hard-disk intensive destructive edits, you can listen to your 
changes right away. Once you are done arranging the regions, it is also possible with Sound Forge to 
create a new file for distributing to others containing your final arrangement.

MIDI Synchronization and Triggering
The regions you create can also be triggered using MIDI or SMPTE Time Code. This is used for 
synchronizing samples to your sequencer, MIDI controller, or any other time-based media. For example, 
you can assign a MIDI trigger to a voice sample in Sound Forge and then have your sequencer trigger it 
along with other MIDI instruments. Another use is to assign SMPTE times to special effect samples to 
match the visual action on a soundtrack. Refer to the MIDI and SMPTE Synchronization chapter for 
more information on synchronization.



Creating Regions
Creating a Region Using Menu Commands
As with most features in Sound Forge, you can create a region in your sound file a number of different 
ways. One of the simplest ways is to drag a selection from a Data Window into the Regions List. 

Let's create a region in the file TUTFILL.WAV. Open the file as explained earlier in the manual and then 
open the Regions List window. The Regions List window is opened by selecting Regions List from the 
Window menu or by pressing the Regions List button on the Regions/Playlist toolbar. You can also open 
the Regions List window by pressing Alt+1.

To demonstrate creating a region, listen to the file by pressing Play and then select the Cymbal crash at 
the end of the file. Next, select the Add command from the Regions List Shortcut Menu in the Special 
menu. The Add Region/Marker dialog will appear.

Name the region Cymbal Crash and then select OK. A region will be created and placed in the Regions 
List. Each region in the Regions List has a play button which you can use to play that particular region. In 
addition, Region Tags are created in the Data Window ruler that show the location of the region.

Other Ways of Creating Regions
There is also a Shortcut Menu to let you quickly create regions. Select the beginning part of the sample 
with the drum roll and then right-mouse click on the ruler. From the Ruler Shortcut Menu, select 
Region/Marker and the Add Region/Marker dialog will appear. Name this region Drum Roll. Notice that 
if you click on Drum Roll or Cymbal Crash, in the Regions List window the region is selected in the Data 
Window.

The easiest way of creating regions is to drag them from a Data Window directly into the Regions List 
window. To do this select the portion of data between the Drum Roll and Cymbal Crash regions and then 
drag it to the Regions List window and release the mouse button. The Add Marker/Region dialog will 
immediately appear upon releasing the mouse button. Name this region Toms and press OK.



Editing a Region
Editing Regions with the Ruler Region Tags
Changing the end-points of a region is as simple as sliding the region tags on the Data Window ruler 
(above the Waveform Display). When you left-click on a region tag, the corresponding region end-point 
tag is also highlighted. Also, the name of the region is displayed in the left side of the Status Bar. Double-
clicking on a region tag changes the selection points to the region area.

Region edit operations can be performed by right-clicking on the region tags. This brings up the 
Marker/Region Shortcut Menu. You can then choose from the following options:

Select: Modifies the current selection points to be equal to the region end-points.

Delete: Deletes the region. Does not delete the sound data, just the region from the Regions List.

Edit: Takes you to the Edit Marker/Region dialog for manually editing region attributes

Update: Modifies the region end-points to be equal to the current selection.

Editing Regions in the Regions List
Another way to edit the region points is to double-click on a region name in the Regions List. This brings 
up the Edit Marker/Region dialog, which allows you to type in region parameters or select Triggers (see 
MIDI and SMPTE synchronization). Also, right-clicking on the Regions List allows you to choose from 
various commands from the Regions List Shortcut Menu.



Adding Regions to the Playlist
Adding Regions to the Playlist
Let's now arrange the regions you've just created in the Playlist. To add regions to the Playlist you can 
either use the menu or you can drag regions from the Regions List into the Playlist.

Since we already have some regions defined, we can just drag the regions from the Regions List into the 
Playlist. First, open the Playlist window by selecting the Playlist item from the Window menu or pressing 
Alt+2. Next, drag the Drum Roll region into the Playlist. Repeat this procedure with the other two regions. 
Selecting the play button in front of any region in the Playlist plays the regions sequentially starting at the 
selected region.

The Playlist shows the sequential order that regions will be played back. In front of the name of the 
region, there is a number which indicates the number of times the region will be played before the next 
region is played. After the name is the start time of the region. Several display options are available in the 
Regions List and Playlist folder in the Preferences dialog.



Arranging the Playlist regions
Let's assume that you want the Toms region before the Drum Roll region. Select Drum Roll from the 
Playlist and drag and drop it to below Toms. When you start playback from the beginning region (press 
the play button in front of the top region) you can hear the new arrangement. To place a region between 
two other regions, drag and drop the region between the two other regions.

Changing the region playback count
Each region in the Playlist can be played (looped) a number of times. To do this, double-click on a region 
in the Playlist and in the Edit Playlist dialog set the Play count to any number between 0 and 999. You 
can quickly change the count for any selected region by using the + or - keys rather than bringing up the 
dialog. If you set the Play count for the Drum Roll region we created previously to 3 you can hear the 
drum roll played 3 times in a row.

Playing a region at different points in the Playlist
One other advantage of using a Playlist is the ability to repeat the same region at different points in time 
without having to copy the sound data in the file. If you want to create another region with the same data, 
select a region and then select the Replicate item from the Playlist Shortcut Menu in the Special menu. 
You can also replicate a region by dragging the region and, while holding the Control key, dropping it at 
another position in the list.

Removing a region from the Playlist
To remove a region from the Playlist, select the region and select Delete from the Playlist Shortcut Menu 
in the Special menu. You can also select a region and press the Delete key. This operation does not 
affect the sound file data.



Creating a new file from the Playlist
Once you've arranged the Playlist regions, Sound Forge allows you to create a completely new file 
containing the sound data in the Playlist regions. For example, say you've created regions in a file and 
then re-ordered them in the Playlist. To make a new file containing the re-ordered regions, select Playlist 
> Convert to New from the Special menu.



Using Markers
While regions are used to specify a section in a sound file, a marker is a location in the sound file you 
wish to use as a reference point. Markers make it easier to get around the sound file, as they are often 
used to tag important locations.

Creating a Marker with the Ruler Shortcut Menu
A marker can be created in the same ways discussed earlier for making regions. The quickest way is to 
place the cursor where you want the marker and then right-click anywhere on the Ruler. This will bring up
the Ruler Shortcut Menu, where you then select the Marker/Region option. In the Add Region/Marker 
dialog, type in a name for the marker and select OK. If you had no selection in the Data Window, Sound 
Forge will automatically create a marker at the cursor position. If you have a selection, Sound Forge 
defaults the Type to Region in the Add Marker/Region dialog.

Editing markers
Markers can be edited in the same way as regions. The marker tags in the Ruler can be moved back and 
forth, and Shortcut Menus appear when you right-click on the tag.

Starting playback from a marker location
To play the sound file beginning at a marker location, press the small play button to the left of the marker 
name in the Regions List window.

Dropping Markers while listening to a sound file
Another useful feature in Sound Forge is the ability to create markers as you listen to the sound file. To do
so, first start playback on any sound file. A marker will be created each time you press the M-key or the 
Mark-In toolbar button. When finished, you can then rename each marker to whatever you wish. The 
most accurate method for creating markers during playback is to use the M-key.



Sampler Tools
Sound Forge has been designed to allow for integration with samplers, MIDI, and SMPTE devices in your 
studio.    In this section, we will cover how you can use Sound Forge along with other music hardware or 
software.

The MIDI Keyboard

Creating and editing loops
Editing a loop without the Loop tuner
Looping Techniques
The Loop Tuner

Using the Sampler Tool to download and upload samples



The Sound Forge MIDI Keyboard
With the Sound Forge MIDI keyboard, you can control internal or external synthesizers and samplers from
Sound Forge. For example, you might want to test a sound in a sampler after sending (downloading) it 
from Sound Forge. You can also use the MIDI keyboard to listen to the different sounds on a synthesizer, 
in the synthesis section of your sound card, or to practice your mouse-keyboard chops.

Opening the MIDI Keyboard
First, open the MIDI Keyboard window by selecting Keyboard from the Window menu. Like any other 
toolbar or pop-up window in Sound Forge, you can resize it, move it around, or dock it to any side of the 
Sound Forge window. Depending on how you resize the keyboard, the keys will be arranged horizontally 
or vertically.

When you left-click on any of its keys, the keyboard automatically turns on if it is not already on. If you 
don't hear anything, its probably because its output has not been connected to a MIDI output device.

Configuring the MIDI keyboard output port and channel
To select a MIDI device, left-click on the MIDI OUT button. A Shortcut Menu will appear listing all the 
devices available for output, like your sound card or other MIDI port. Select the desired device. At the 
bottom of the list is an option to have the MIDI Keyboard send program changes or not. Check it if you 
want to be able to select instruments in the device from the keyboard.

Next, you must select the MIDI channel to be used on the chosen device. Most MIDI devices are 
configurable to accept MIDI commands on any channel.

Still don't hear anything?
If after selecting the correct device, you still can't hear anything when you play on the keyboard, check the
following things:

- Set the MIDI Output Velocity of the keyboard to a high value (above 100).
- Set MIDI input channel in sound module to the same channel as the Keyboard channel. Also, make 
sure the device is set to receive MIDI input.
- Check the device output volume level (is the mixer level for your sound card or the output volume of 
the sampler and speakers at a high enough setting?)
- For external devices, check your MIDI cables.

Selecting Instruments
To change to a different voice in the synthesizer, select the instrument name from the Instrument List. 
Patch names are arranged as specified in the General MIDI standard (with synthesizers not using the 
General MIDI convention, use the patch number instead of the instrument name). Make sure that you 
have the Send Program Changes option under the MIDI Out Shortcut Menu checked, otherwise you 
won't be able to switch between patches.

You can also have Sound Forge generate chords instead of single notes by selecting a chord structure 
from the Chord Structure drop-down list. A chord is then generated using the pressed note as the root of 
the selected chord or interval.

A loop is a region in your sound file which is repeated on playback. In most samplers, since samples are 
not infinite in length, loops are used to create sounds which sustain for a long time. For example, when a 
sampler is told to sustain a flute sound for a long period of time, it loops a short section of the sample over
and over. Loops are also used to repeat sections of music, although for these purposes it is 
recommended that you use the Playlist.

Ways to create loops
To create a loop, first select a section of the sound file. You can hear how this section will sound in looped
mode by selecting the Play Looped button. Next, select the Edit Sample item from the Special menu. In 



the Edit Sample dialog, set the Sample Type to sustaining and switch the loop count from infinite to three
and select OK. You could have also created the loop by right-clicking on the Ruler and selecting Sample 
Loop or dragging and dropping the selection on to the ruler (right above the Waveform Display)

The Data Window now has tags in the Ruler specifying the loop end-points. You can play the sound file 
with the loop counts by selecting the Play as Sample button. This plays the entire file, with the looped 
section repeated three times.

Editing a loop without the Loop Tuner
Once you've created a loop, you can change its length, start, or end-points by sliding the loop markers in 
the Ruler. Left-click on the loop-start marker. While holding the left-button down, slide the marker to a new
location and then release the button. It's as simple as that. You can accomplish the same thing by right-
clicking on the marker and selecting Edit from the Shortcut Menu. In the Edit Sample dialog, you can 
then enter manually start and end-points for the sample.

Other options available when right-clicking on a loop point marker are:

Select: Modifies the current selection to be equal to the loop end-points.

Delete: Deletes the loop markers.

Update: Modifies the loop end-points to be equal to the current selection.



Creating and editing loops
A loop is a region in your sound file which is repeated on playback. In most samplers, since samples are 
not infinite in length, loops are used to create sounds which sustain for a long time. For example, when a 
sampler is told to sustain a flute sound for a long period of time, it loops a short section of the sample over
and over. Loops are also used to repeat sections of music, although for these purposes it is 
recommended that you use the Playlist.

Ways to create loops
To create a loop, first select a section of the sound file. You can hear how this section will sound in looped
mode by selecting the Play Looped button. Next, select the Edit Sample item from the Special menu. In 
the Edit Sample dialog, set the Sample Type to sustaining and switch the loop count from infinite to three
and select OK. You could have also created the loop by right-clicking on the Ruler and selecting Sample 
Loop or dragging and dropping the selection on to the ruler (right above the Waveform Display)

The Data Window now has tags in the Ruler specifying the loop end-points. You can play the sound file 
with the loop counts by selecting the Play as Sample button. This plays the entire file, with the looped 
section repeated three times.



Editing a loop without the Loop Tuner
Once you've created a loop, you can change its length, start, or end-points by sliding the loop markers in 
the Ruler. Left-click on the loop-start marker. While holding the left-button down, slide the marker to a new
location and then release the button. It's as simple as that. You can accomplish the same thing by right-
clicking on the marker and selecting Edit from the Shortcut Menu. In the Edit Sample dialog, you can 
then enter manually start and end-points for the sample.

Other options available when right-clicking on a loop point marker are:

Select: Modifies the current selection to be equal to the loop end-points.

Delete: Deletes the loop markers.

Update: Modifies the loop end-points to be equal to the current selection.



Looping Techniques
Have you ever tried to create loops on an external sampler using the sampler's microscopic LCD display?
Only then will you fully appreciate the ease of use of Sound Forge's Loop Tuner. With it, you can create 
loop-points visually and avoid obvious sound wave glitches which result in annoying pops.

Creating a natural sounding loop is not something that comes naturally. There are many factors involved 
that can cause annoying pops and glitches. While experimentation is always required, here are a few 
basic guidelines to follow:

Match end-point amplitudes. It's most common to select the end-points with amplitude of zero (Zero 
crossings).

Match end-point waveform slope. If the waveform changes slope drastically, a pop will be heard.

Match end-point sound level. What this means is that the overall loudness near (~ 100 ms) the end-points
should be equal. It is often very difficult to avoid this with quickly decaying sounds, since the start point 
will always be greater than the end-point sound level.

Avoid very short loops. If the loop is smaller than ~50 ms (1/20 Hz), you will most likely create a loop with 
a pitch not equal to the sample pitch. You can experiment with pitch-tuning a loop by creating short loops 
with a length equal to 1/Frequency. For example, if you had a sample of pitch 440 Hz which corresponds 
to A5 on the keyboard, you can try making the loop 2.27 ms. Pitched loops, however, tend to not sound 
like the original sample.



Using the Loop Tuner
Before opening the Loop Tuner window, you must have created a loop in the sound file. For this 
demonstration, open the file TUTORSMP.WAV. This file has a sustain loop already specified in it.

Under the View Menu, select Loop Tuner. 

The Loop Tuner allows you to view both loop end-points at once. The left-hand side of the Loop Tuner 
window shows the end of the loop while the right hand side shows the start of the loop. A seamless loop 
will not have any discontinuities; in other words, the waveform should look smooth as it goes from the end
of the loop back to the start.

Playing from the Loop Tuner
There are three playback buttons in the Loop Tuner, the Play Before Loop , Play Loop, and Play After 
Loop. You can also still use the Play Sample button in the Data Window to hear the entire sample with 
repeated loops.

Switching between Sustain and Release Loops
To switch between sustain and release loops, press the left-most button in the Loop Tuner. An S indicates 
Sustain, while an R indicates Release. Keep this on Sustain for now (the S should be showing).

Fine-tuning loop end-points with the Loop Tuner
If you want to change the loop end-points by a small amount, you can use the Start Point and End-point 
Edit Box spinners. To increment the loop start point by one sample, click on the Start Point Edit Box 
spinner up arrow.

If you left-click on the center button of the spinner, you can increment or decrement the start point by 
larger amounts by sliding the mouse up and down while holding the left-button down. Notice how the start
point waveform (right side of the Loop Tuner display) and the Loop Marker in the Data Window slide along
horizontally in time.

On the lower right hand side of the Loop Window, the sample amplitude at the loop end-points is 
displayed. Although it is highly dependent on the waveform, a good rule of thumb is that the closer these 
two values are to each other the better.

Zero Crossing Finder
As we mentioned earlier, loop end-points should match amplitude and slope. The Zero Crossing Finder 
accomplishes this by finding the next zero crossing of the waveform with a positive slope (you can select 
the slope in the More folder in the Preferences dialog).

There are two Zero Crossing Finders for each loop end. One for finding the next zero crossing and one 
for finding the previous zero crossing. To use the finders, just left-click on one of the buttons. By trying out
different locations, moving the start and end-points forward and backward you should be able to quickly 
find loop ends that meet smoothly.

Press on the Play Loop button in the Loop Tuner to hear the current loop. If the loop still clicks when 
played, try moving to different zero-crossings. Remember, you can also use the Loop Point spinners to 
fine tune the end-point location.

Lock Loop Length
Let's assume that you want to shift a loop's position without changing its length. Pressing the Lock Loop 
Length button allows you to do so. When on, any operation you use to change a loop point affects both 
the start and end of the loop, therefore keeping the loop length constant.

For example, with the Lock Loop Length button down, drag the Loop Start Marker in the Data Window 
Ruler to the left. The start and end markers will slide together. Turning the Lock Loop Length off allows 



you to shift each end-point individually. The Lock Loop Length button works the same as the Lock 
Loop/Region Length item in the View menu.

Real Time Loop Tuning
The tools mentioned above for changing the loop end-points can be used while the loop is being played. 
This allows for instant feedback on how the loop sounds. To do so, start playback of the loop by selecting 
the Play Loop button and proceed to use any method to change the loop length. Sound Forge will play the
modified loop points.

Saving Loop Points
Loop points are automatically saved when you save your sound file in WAV, VOC, SDS, SMP, 
DIG, PAT, and AIF file formats. You are allowed to disable the saving of loop points when 
saving to the WAV format.



MIDI and SMPTE Synchronization
In this section, we will cover how you can synchronize Sound Forge with devices generating SMPTE Time
Code or use a MIDI sequencer or MIDI controller to trigger audio playback.

What is MIDI?
The Sonic Foundry Virtual Router
Using MIDI Triggers
MIDI/MTC synchronization



What is MIDI?
The Musical Instrument Digital Interface (MIDI) is a set of commands that many pieces of music software 
and hardware use to speak to each other. MIDI is most often used for sending commands such as Play 
Middle C Now but can also be used to send information like Current Time is: 00:00:01:23 SMPTE or even 
digital sound data (see Sampler Tools section).

The most common way to use MIDI is to have a Master device (such as a MIDI sequencer) to generate 
MIDI commands to a Slave device (such as a synthesizer which plays a note when instructed). If both 
were in separate hardware boxes, you would run a MIDI cable from the sequencer's MIDI OUT port to the
synthesizer's MIDI IN port.



Sonic Foundry Virtual MIDI Router
NOTE: If you have not installed the Sonic Foundry Virtual MIDI Router (VMR) driver yet, we recommend 
that you do so at this point. Refer to the Appendix labeled Installing the Sonic Foundry Virtual MIDI 
Router for installation instructions.

The VMR allows you to route MIDI signals between software programs such as a MIDI sequencer and 
Sound Forge in much the same way that you would run MIDI cables between MIDI hardware devices. 
The only difference is that there's no need for patch cords or extra hardware.

A complete discussion of the Sonic Foundry VMR can be found in the Appendix labeled The Sonic 
Foundry Virtual MIDI Router.



Sound Forge and MIDI Triggers
There are many different ways to generate MIDI commands, including MIDI sequencers, MIDI keyboards,
MIDI guitars, and there's probably MIDI maracas out there somewhere. Whatever their source may be, 
MIDI commands can be used to trigger audio playback in Sound Forge.

Triggering file playback from the Sonic Foundry MIDI keyboard
To demonstrate how to use MIDI Triggers, we will first show you how to control Sound Forge using the 
internal MIDI keyboard. This might not be the most useful way of using MIDI triggers, but since everybody
using Sound Forge will have access to the Sonic Foundry MIDI keyboard, this will be a good 
demonstration of using triggers and the VMR. We are assuming that you have the driver installed.

First, open the Keyboard Window by selecting Keyboard under the Window menu or by pressing Alt+3. 
Even though the Keyboard Window is intended for controlling MIDI devices like sound cards or samplers, 
it can also be used to trigger Sound Forge itself. Next, open a sound file that you wish to trigger.

The first step in setting up MIDI triggering is to make sure that the output of the Master goes to the input 
of the Slave. In this case, the Sound Forge MIDI Keyboard is the master and Sound Forge is the slave. 
Left-clicking on the MIDI Out button in the Keyboard allows you to set were the Keyboard will send its 
MIDI commands. For this example, set it to 1 Sonic Foundry MIDI Router. Also, make sure that the 
output channel is set to Channel 1. You won't be able to hear anything at this point when you press on the
keyboard because nothing is connected to the other end of the VMR.

Now, go into the MIDI/Sync folder under Preferences in the File menu. For Sound Forge's MIDI In, also 
select 1 Sonic Foundry MIDI Router. At this point, we've connected the two devices, much like running a
MIDI cable between them.

Next, you must select MIDI Triggers under the Special menu to determine what you want to trigger in 
Sound Forge. For this example, select Play All from the Event list box. In the Trigger section, select 
Note. Type in the note C4 and set the channel to 1. What this does is tells Sound Forge to play the 
current sound file when it receives a C4 Note-On command on MIDI channel 1.

Finally, you must tell Sound Forge to begin waiting for MIDI commands. In the Regions/Playlist Toolbar, 
select the MIDI Input Sync/Trigger button to enable synchronization to MIDI input. (If the toolbar is not 
open, go to the Toolbars folder under Preferences in the File menu and check the Regions/Playlist 
option). The MIDI Input Sync/Trigger button will remain pressed down and Waiting... will appear in the left-
hand status box. Sound Forge is now ready to accept MIDI commands. 

To test triggering, press the C4 key in the MIDI keyboard (the key with the number 4 on it). The sound file 
should start playback and play all the way through. Notice that when you press C4, the status box 
displays that it has received a C4 Note On message on channel 1. 

Its important to understand the difference between triggering playback with the MIDI keyboard and 
selecting the play button in Sound Forge. When you press a note in the MIDI keyboard, MIDI commands 
are sent from Sound Forge to an external device (in this case the VMR) and then back to Sound Forge's 
MIDI input port. The MIDI commands which arrive at the Sound Forge MIDI input port could be coming 
from any software or hardware device that generates MIDI.

There are a few other commands in the MIDI Triggers dialog you can experiment with. They are 
explained in more detailed in the Sound Forge Reference Section.

Triggering region playback from the Sonic Foundry MIDI keyboard
Let's now trigger regions from the Regions List. First, go to the MIDI Triggers dialog (Special menu) and 
set all the triggers to NONE by selecting the All triggers off Preset. If you have triggers in both the MIDI 
Triggers dialog and the Regions List, make sure that they correspond to different MIDI notes if you don't 
want unexpected results to occur. Next, open a file which has regions specified in the Regions List. 



Double-click on the first region in the Regions List and select MIDI Note-On Play. Also, set the note to C4.

Make sure that the output of the MIDI keyboard and the MIDI Input of Sound Forge are set to Virtual MIDI 
1 and all channels set to 1 as in the previous section. Press down the MIDI Input Sync/Trigger toolbar 
button to Synchronize MIDI Input (you can also do this in the Special Menu).

If everything has been done correctly, when you press C4 in the keyboard the first region will be played.

By repeating the previous steps, you can give each region a MIDI trigger. Set the MIDI notes to different 
values, like C3 and C5 so that notes on the keyboard correspond to different regions. Note: Sound Forge 
can play only one region at a time. Overlapping causes the earlier region to cut-off and the new region to 
be played back.

Triggering from internal sequencers
The basic concepts of MIDI In and MIDI Out routing used in triggering from the internal MIDI keyboard 
apply to any hardware or software device which can generate MIDI commands. You should be able to 
follow the instructions for triggering with the MIDI keyboard and substitute your device's output port and 
channel number.

Suppose you have a MIDI sequence in you sequencer to which you wish to add a vocal track starting at a
set time. You could accomplish this most easily by attaching a MIDI Trigger note to the sound file in 
Sound Forge and having the sequencer play the trigger note at the correct starting time. You can also 
accomplish this using SMPTE times as shown in the next section.

Triggering from external devices
The same procedure applies for triggering with external devices. You will have to set Sound Forge's MIDI 
input port (under MIDI\Sync Preferences) to the external device output port.



Sound Forge and MIDI Time Code synchronization
MIDI Time Code (MTC) is a way to transmit SMPTE timing signals between devices for synchronization. 
For an overview of SMPTE , check out Appendix E which explains the differences in 29.97 FPS, 30 FPS , 
Drop and Non-Drop, and other confusions. Although MIDI Time Code is most often used to sync audio 
tracks to visual action on video, it can also be used to synchronize other playback devices, like a MIDI 
sequencer, to Sound Forge. 

Sound Forge has the ability to synchronize to external MTC or generate MTC for other devices to follow.

Playing regions using MIDI Time Code from a software MIDI sequencer
It is possible to specify start times for each region in your Regions List for synchronizing digital sounds 
with other timed events. For example, if your MIDI sequencer or other device generates SMPTE Time 
Code, Sound Forge can make its SMPTE time accurately follow the device's SMPTE time and play the 
regions at the specified times. 

Synchronizing to MTC is very similar to synchronizing to other MIDI events. However, if you just want to 
trigger a few sounds in Sound Forge from your sequencer, it might be easier to use Note-On MIDI 
Triggering and not worry about MTC or SMPTE synchronization (refer to the section on Triggering from 
internal sequencers). MTC synchronization uses up more of your computer's processing power, yet its the
only way to go if you don't want to (or can't) generate MIDI triggers. Also, MTC synchronization allows you
to specify accurate SMPTE start times in Sound Forge instead of in other software or hardware devices.

Here are the basic steps to follow when triggering a sound region in Sound Forge from a sequencer using
MTC:

1. In Sound Forge, open a file and create a region in both the Regions List and the Playlist.
2. Double-click on the region in the Playlist. Select Play at SMPTE Time from the Trigger drop down 
list.
3. Set the SMPTE start time for the Region. Sound Forge displays SMPTE time as 
Hours:Minutes:Seconds:Frames. Make sure that you are using the same SMPTE Time format and 
frames per second in both Sound Forge and the sequencer. Refer to Status Format and Status 
Preferences
4. Now, in the MIDI/Sync folder under Preferences, make sure that the Sound Forge MIDI input port 
is set to the same port as the output of the sequencer. For example, set both ports to 1 Sonic 
Foundry MIDI Router. 
5. Verify that in the MIDI Triggers dialog (Special Menu) all the triggers are set to None. This 
prevents other MIDI commands from also creating triggers.
6. Enable MIDI Input Sync/Trigger mode by either pressing the MIDI Input Sync/Trigger toolbar 
button or selecting MIDI Input Sync/Trigger from the Special menu. Now, Sound Forge is ready and 
waiting for synchronization to MTC.
7. Switch to your sequencer. Set the MIDI Out port to be the same as Sound Forge's MIDI Input port. 
Refer to the sequencer's manual for information on setting MIDI ports.
8. Enable MTC output in your sequencer. (Refer to the sequencer's manual for information on how to 
do this.) If your sequencer supports generating MTC you should now be ready to sync.
9. Press play in the sequencer. In Sound Forge, you should see the MIDI In status box display the 
same SMPTE Time as the sequencer's time. At the set SMPTE time, Sound Forge should play the 
region without interrupting your sequencer's output to any other devices.

Playing regions using MIDI Time Code from an external device
If you have a hardware device (i.e. SMPTE Time Code to MTC card) that generates MTC, the procedure 
is basically the same as outlined above. In Sound Forge's MIDI/Sync Preferences folder, you should be 
able to directly select the device's MTC output driver as Sound Forge's MIDI input port.

Using Sound Forge to generate MTC for a MIDI sequencer



Follow these step if you want Sound Forge to generate MTC for other devices to follow.

1. Open a large sound file. Sound Forge only generates MTC while playing a sound file or the Playlist.
2. Now, in the MIDI/Sync folder under Preferences, make sure that the Sound Forge MIDI output 
port is set to the same port as the output of the sequencer. For example, set both ports to 1 Sonic 
Foundry MIDI Router. 
3. Verify that in the MIDI Triggers dialog (Special Menu) all triggers are set to None. This prevents 
other MIDI commands from also creating triggers, which might create unexpected results.
4. Enable MIDI Output Sync mode by either selecting the MIDI Output Sync toolbar button or 
selecting MIDI Output Sync from the Special menu. Now, Sound Forge will output MTC whenever 
you start playback.
5. Switch to your sequencer. Set the sequencer's MIDI In port to be the same as Sound Forge's MIDI 
Output port. (Refer to the sequencer's manual.)
6. Set the sequencer's SMPTE Offset Time as required. Sound Forge always uses 00:00:00:00 as its 
output start point. For some sequencers, it is suggested that the SMPTE Offset Time be set to at least
four seconds to ensure correct synchronization.
7. Enable MTC input (again, check the sequencer's manual). This usually entails switching the timing 
generator in the sequencer from Internal to MTC. You should now be ready to sync.
8. Press play in the sequencer (some sequencers don't require you to do this). The sequencer should 
not start playback. Instead it should switch to a Waiting for MTC mode.
9. In Sound Forge, start playback in the Data Window or Playlist. The sequencer should start 
following Sound Forge's SMPTE Time when the SMPTE Offset Time is reached.

Using Sound Forge to generate MTC for an external device
If you want Sound Forge to send MTC to an external device, follow the previous instructions for sending 
MTC to a sequencer with a few changes. Instead of sending to the VMR, have Sound Forge's MIDI output
port send directly to the device's MIDI driver. Check the device's manual for more detailed information on 
using MTC.



Optimizing Sound Forge
This chapter contains information on how to configure your system to maximize Sound Forge's 
performance.

Hard-Drive Use
Configuring your display
Setting up Wave Devices
Background Processing

Crash Recovery



Hard Drive Use
Sound Forge is a disk based sound editor which means that all editing operations are performed on your 
hard drive (rather than in your computer's memory). This allows Sound Forge to edit sound files of almost 
unlimited size. Sound Forge also stores Undo information and Clipboard data on the hard drive.

The drive you specify for Temporary Storage (refer to the Storage Preference folder) must have enough 
free space to store the data for each opened sound file, as well as Undo information, and the Clipboard. 
Although this can use a lot of disk space, it allows you to edit long sound files that could never fit into your
computer's memory (RAM). And hard drives are typically much cheaper than memory.

Since Sound Forge is hard drive intensive, the faster your disk access, the faster Sound Forge will be. 
Here are a few things you can do to improve your performance without buying new hardware:

Defragment your Hard Drive: Over time, and especially with heavy use, a hard drive can become 
fragmented. What this means is the data stored on the hard drive gets scattered across the surface of 
the disk (your files become discontiguous). When files are discontiguous on the surface of your hard 
drive's disk, the hard drive must 'jump around' to retrieve the data. This jumping around can slow down
access to your files and can be very noticeable on older hard drives. DOS 6.0 and above come with a 
program called Defrag that will defragment your hard drive.

Use 32-Bit Disk Access: When running Windows in Enhanced Mode, most PC's can be configured to
use 32 bit disk access for Virtual Memory in Windows. Enabling this option can dramatically improve 
overall system performance--especially if you have less than 8 Megabytes of RAM. This option can be 
found in the Enhanced option of the Windows Control Panel. Select the Virtual Memory button and 
enable 32 bit disk access (if it is not already enabled). Note that you will need to select the Change 
button before you can see this option. Windows will inform you if 32 bit disk access cannot be used on 
your computer.

Use 32-Bit File Access: Windows for Workgroups 3.11 provides greatly enhanced file access 
performance. Enabling this option can dramatically decrease the time it takes to access data in a file. 
This option can be found in the Enhanced option of the Windows Control Panel. Select the Virtual 
Memory button and enable 32 bit file access (if it is not already enabled). Note that you will need to 
select the Change button before you can see this option. The default cache size should be sufficient. 
Refer to your Windows for Workgroups 3.11 documentation for more information on selecting a cache 
size.



Configuring your Display
Maximum zoom ratio on open
If you are editing large files (i.e. greater than 1-2 megabytes) you may wish to adjust your Maximum 
zoom ratio on open option. This option can be found in the Display folder of the Preferences dialog. This
option sets the maximum amount of data that Sound Forge will initially display in the Waveform Display 
when opening a new file. The smaller the number the less of a file you will see when initially opening it. 
You can always decrease the magnification after the file is opened to see more data.

You will want to set this option to a smaller ratio (for example 1:256 or 1:512) on slow machines. On fast 
machines, ratios of 1:2,048 or 1:4,096 may be appropriate. Try experimenting with smaller and larger 
ratios when opening large sound files. Note that this zoom resolution is also used for the Zoom Out Full 
command (unless the Shift key is held down).



Setting up Wave Devices
The Sound Mapper/Wave Mapper
Sound Forge allows you to choose any Windows compatible sound card in your machine for Playback 
and Record. It also provides one more option for Playback and Record called the Sound Mapper 
(depending on your configuration, this may be called the Wave Mapper). The Sound Mapper is a special 
device which attempts to select the most appropriate sound card (map) on which to play a sound, or it will
translate the sound into a format that can be played on your sound card.

If you are having problems with breakups, make sure that your sound card supports the data format you 
are playing or recording. The easiest way to do this is to choose a Playback and Record device that is not
the Sound Mapper. If Sound Forge is able to play and record the sound using the real Wave device, then 
the Sound Mapper is not the problem.

However, if the Sound Mapper must be selected to play or record the format you are having trouble with, 
then you should convert your sound data to a format that is directly supported by your sound card. Doing 
this will remove all overhead required to translate the sound data for your sound card.

Note that there is nothing wrong with using the Sound Mapper when the sound data format is directly 
supported by your sound card. The Sound Mapper will simply pass the data through to your sound card 
which requires negligible overhead. For more information on the Sound Mapper, refer to the Appendix 
called Sound Forge and The Microsoft Audio Compression Manager. The Sound Mapper is a 
component of the Audio Compression Manager (ACM).

Play and Record Counters
The Play and Record Counter options in the Wave Preferences folder allow you to configure whether the 
numeric counters (position information displayed in status fields) will be updated during playing and 
recording. If you are recording or playing at high sample rates (44,100 or 48,000 Hz) and are 
experiencing gapping or skipping problems in the data, try disabling the Play and/or Record counters to 
decrease overhead.

Buffer Alignment
Buffer alignment specifies the size of individual blocks of data which are passed to the sound card driver 
from Sound Forge. Typically the maximum value of 32,768 bytes (32 kb) is what you will want to use. 
However, there are instances where you may want to reduce this number. Refer to the Synchronous 
Wave Devices section below.

If you are experiencing gaps during playback or recording, make sure your Buffer Alignment is set to 
32,768 bytes (unless you are using a Synchronous Wave Device).

Total Buffer Size
The Total Buffer Size option, found in the Wave folder of the Preferences dialog, specifies the total 
amount of RAM that should be used for buffering when recording to or playing from the hard drive. For 
most systems 256 kb is a good number but you may want to use a larger size if you are experiencing 
gaps during playback or record at high sample rates (44,100 or 48,000 Hz).

The drawbacks to increasing the Total Buffer Size are it requires more of your computers memory and, 
especially if you have the Pre-load all buffers before starting playback option enabled, there can be 
small delays when starting and stopping playback.

Do not use large buffer sizes if you are using Sound Forge on a Synchronous Wave Device. See the 
section on this topic below.

Pre-load all buffers before starting playback
The Pre-load all buffers before starting playback option in the Wave Preferences folder tells Sound 
Forge to prepare all memory buffers and load them into your sound card driver before starting playback. 



This pre-loading is performed between the time you press the Play button and the time you hear the 
sound play.

Turning this option on may help skipping (audible gaps) when initially starting playback of a sound. These 
gaps are normally observed by people with slow or fragmented hard drives. The tradeoff for enabling this 
option is a slight delay before play begins; the delay time is greater if your Total Buffer Size is set to 
large values. This option does not affect operations other than playing.

Some Windows sound drivers do not support this option correctly. If you are experiencing noise or 
dropouts at the very start of playback, try disabling this option.

Synchronous Wave Devices (PC Speaker)
Synchronous Wave Devices (SWD) are sound devices which don't allow you to play audio in the 
background (i.e. when they're playing audio nothing else in the system is allowed to run). We're not 
kidding. The most popular SWD is the PC Speaker. There are several drivers available for the PC 
Speaker, with the most common developed by Microsoft and is available on the Windows Driver Library 
on CompuServe.

However, other SWD's do exist and normally attach to your computer's parallel port. These devices are 
useful for adding sound to Laptops without PCMCIA slots. Sound Forge fully supports SWD's, but there 
are special configuration options that improve usability of these devices. Note that SWD's invariably 
sound bad, so don't expect too much.

When using SWD's with Sound Forge, you will want to reduce the Buffer Alignment to 2,048 bytes (2 
kb). The reason for this is that SWD's stop all other activity while playing (and recording), and most even 
disable hardware interrupts! Thus you won't be able to stop the sound until the end of each buffer. As an 
example, playing an 8 kHz sound with a Buffer Alignment of 32,768 byte blocks you will only be able to 
stop the sound every four seconds. And this lag time goes up with higher samples rates. Using the 
smallest Buffer Alignment possible will keep this lag time to a minimum.

You should also set your Total Buffer Size to the smallest value possible (4 kb). There is no benefit to 
using a large buffer size with SWD's.

Finally, disable the Pre-load all buffers before starting playback option, since this will cause an even 
greater delay before letting you stop playback after pressing play.



Background Processing
When Sound Forge is performing operations that take a long time, such as opening a file or performing 
audio processing, a Progress Meter is displayed on the Status Bar. While this Progress Meter is visible 
Sound Forge is doing it's work. You can cancel the operation at any time by pressing the Cancel button to
the left of the Progress Meter, or you can press the Escape key.

All processing performed by Sound Forge is done in the background. What this means is you do not have
to wait for Sound Forge to finish its work before you can use other applications. If an operation is taking a 
long time in Sound Forge, simply switch to another application and work on something else. Sound Forge 
will continue processing while you work in another application.

If you minimize Sound Forge while it is processing, the percentage processed will update in the title of the
Sound Forge icon. This allows you to keep an eye on Sound Forge's progress while using other 
applications.

You may have noticed that Sound Forge displays the amount of processing time an operation required in 
the Status Bar when it completes. This processing time is intended for entertainment purposes only--this 
value is not intended for accurate profiling. The accuracy of this processing time value is heavily 
dependent on what other activity is being performed by your computer while Sound Forge is working. 
Using other applications while Sound Forge is working can cause the processing time to increase 
substantially.



Crash Recovery
If for some reason Sound Forge is terminated improperly (this occurs when Sound Forge or, most likely, 
another program crashes), all the opened and unsaved sound files can be recovered. Sound Forge never 
works directly on the original file until you select to save your work. Instead, temporary files are created 
and any edits made are stored in these files. When an improper termination of the program occurs, these 
temporary files remain on your hard drive and can be reopened to recover any work done to the sound 
files before crashing. Also, the original sound files will remain unchanged until you save your work.

When starting the program, any temporary files detected in your temporary file directory are an indication 
that something went wrong. Sound Forge will ask you if you want to rename these temporary files to 
recover your work. You also have the option to delete these files if no important work had been done, or to
just ignore these files. Ignoring the files leaves them in tact on your hard drive.

Rename
Use this to change the ending of all file names from SOUND FORGExxx.TMP to SOUND 
FORGExxx.RAW. You can then open the raw files using the File Open dialog. The files will be placed in 
the directory specified under the Storage Preferences folder.

Delete
This command deletes all the temporary files regardless of selection in the list box. Use this only when 
you are sure that no important work is in the file.

Ignore
If you don't want to deal with the temporary files left over from an improper termination at this moment, 
use this command. However, it is recommended that you either rename the files and check their contents 
or delete them, since they are taking up valuable disk space.

 



Auto Trim/Crop
The Auto Trim/Crop function is useful for removing unnecessary silence in a sample and automatically 
fading in and out the end-points of a phrase. There are three modes of operation:

Keep edges outside of the selection
Silence between the selection points and the sound material is deleted. Use this to remove silence from 
the edges of a selection.

Remove edges outside of the selection
Silence between the selection points and the sound material is deleted. Anything outside of the selection 
is also deleted. Use this to trim a sound from a larger file.

Remove silence between phrases (build regions)
All silence between phrases inside of the selection is deleted. Regions are created between phrases. Use
this to delete the silence between sound effects and automatically create regions.

Attack Threshold (0-100%)
Instantaneous threshold level used for the detection of the trim/crop start point. Zero percent is 
complete silence, one hundred percent is a maximum amplitude level.
Release Threshold (0-100%)
Instantaneous threshold level used for the detection of the trim/crop end point. Zero percent is complete
silence, one hundred percent is a maximum amplitude level.
Fade In Time (0-100 ms)
After the trim/crop start-point is detected, this is the length of fade in applied to the sample. This is 
useful for preventing glitches at end points.
Fade Out Time (0-100 ms)
The length of the fade out applied to the sample after the detected trim/crop end point.
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Swap Channels
Use this to swap the right and left channels.
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DC Offset
Use this command to change the base line of a sample section. A sample wave that is not centered 
around the zero baseline in the Waveform Display is said to have a DC Offset. To correct for offsets, a 
constant value is added to each sample.

DC offsets are usually caused by electrical mismatches between your sound board and microphone. 
Noise and unexpected results can occur when sound effects are applied to files which contain DC offsets.

Offset Value
Enter the offset value. The offset can be from -32768 to 32767 for 16 bit data and from -128 to 127 for 8
bit data..

Tips
An easy way to spot DC offset is to zoom close up to a spot in the sample containing only silence and 
seeing if the silence waveform matches the centerline in the Waveform Display.
An approximation of the DC offset of the waveform can be obtained by running the Statistics function 
under the Tools menu. For example, if a DC offset of 100 exists, then you should apply a -100 DC offset 
to cancel out the existing offset.
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Dither to 8 Bit
Dithering is used to reduce the audible effects of quantization noise which are most audible in 8-bit 
samples. This is accomplished by adding a small amount of Gaussian noise to the signal to mask the 
more obtrusive 8-bit quantization distortion. 

Bit Depth (0.00 to 2.00 bits)
Amplitude of the added noise in terms of the least significant bits of the sample. 

Tips
Use very small amounts of dithering and listen to whether to quantization noise is less obtrusive. Increase
the dither amount until the dither noise is louder than the quantization noise.
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Fade Graphic
The Graphic Fade window allows you to draw a fade envelope which will be applied across the current 
data selection.    Up to 16 envelope points are allowed.

Draw the envelope by pulling the small square boxes (drag points) up or down. You can create a new 
drag point by left-clicking on any point of the fade envelope. To delete a drag point, single click on it with 
the right mouse button, or double-click on it with the left-mouse button. Once you have finished with the 
envelope, press the OK button to apply the fade.
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Fade In
Use this command to linearly fade a selection from a volume of 0 to a volume of 100%. 
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Fade Out
Use this command to linearly fade a selection from a volume of 100% to a volume of 0. 
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Insert Silence
Use this command to insert a section of silence into a sample.

Silence Length
Enter the length of the silence block in seconds.

Insert at
Start of Sample
Inserts the silence at the beginning of the file.
End of Sample
Inserts the silence at the end of the file.
Cursor
Inserts the silence at the current insertion point.

Note: You cannot insert silence to a single channel of a stereo file since the length of each channel must 
always remain equal.

Tip
If you wish to insert silence into a single channel you can use the Delay/Echo function to delay one 
channel forwards or backwards in time.
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Invert/Flip
Use this command to invert the sample about the base line. Although this does not make an audible 
difference, it can be useful for matching a sample transition when executing certain pastes, mixes, or 
loops.
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Mute
Use this command to set a selection to a volume of 0 (silence).
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Normalize
Use this command to maximize the volume of a selection without clipping.

When using Normalize on stereo data, if the selection includes both channels, normalization 
is computed on the loudest sample found in either channel. If a single channel is selected in 
a stereo file then Normalization will effect only that channel.
                                                    
See also
Process Menu
Sound Processing and Other Tools



Pan Graphic
The Graphic Pan window allows you to draw a pan envelope which will be applied across the current data
selection. You can create up to 16 envelope points.

Draw the pan by pulling the small square boxes (drag points) up or down. You can create a new drag 
point by single clicking with the left mouse button on any point of the pan envelope. To delete a drag point
single click on it with the right mouse button. Once you have finished with the envelope press the OK 
button to apply the pan.

Half Volume
Checking this box guarantees that clipping will not occur by reducing the volume of the channels by a 
factor of 2 prior to summing and panning.    If you experience clipping when performing a pan set this 
box to on. If the level after a pan is too low turn this box off and retry the pan.

Note: Panning can only be used on stereo files.
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Pan Left to Right
Use this command to pan the sound data in a stereo file from the left channel to the right channel.

Panning the data will mix both channels and then perform a fade across the channels which simulates 
sound moving from the left to the right.

Note: Panning can only be used on stereo files.
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Pan Right to Left
Use this command to pan the sound data in a stereo file from the right channel to the left channel.

Panning the data will mix both channels and then perform a fade across the channels which simulates 
sound moving from the right to the left.

Note: Panning can only be used on stereo files.
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Resample
Use this function to change the sampling rate of an existing sample.

Output Sample Rate (2,000-60,000 Hz)
Sample rate which the sample will be converted to.

Anti-alias filter (On/Off)
Apply an anti-aliasing low-pass filter to the sample before resampling when changing to a lower 
sampling rate. 

Tips
Resampling data consists of changing the number of recorded sample values per second. When 
changing to a higher sample value, extra values are interpolated and the file size increases.
When changing to a lower sample value, some samples are removed and the file size decreases.
Since the maximum frequency that can be represented by a particular sample rate is one-half of the 
sampling rate (the Nyquist frequency), high frequencies in a sample cannot be represented if the sample 
is resampled to a lower sampling rate. Therefore, when changing to a lower sampling-rate, if the sample 
has a strong high-frequency content, anti-aliasing should be used to prevent these high-frequencies from 
becoming low-frequency distortion.
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Reverse
Use this command to reverse a selection. 
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Smooth
Use this command to smooth a sample selection. This function will remove some of the high frequency 
content of the sample selection. It is equivalent to a very fast low pass filter.

                                                    
See also
Process Menu
Sound Processing and Other Tools



Time Compress/Expand
The Time compress/expand function changes the duration of a sample without altering the pitch.

Final Length (50% - 150% of Original Length)
Desired length of the sample. 

Tips
This function works best on rapidly changing sound material (like speech) and when the desired change 
in duration is less than ten percent.
If a small change in pitch is acceptable, the Pitch Change function allows for a very precise change in 
sample duration without creating any sound artifacts.
Note: You cannot perform this function to a single channel of a stereo file since the length of each 
channel must always remain equal.
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Volume
Use this command to change the volume of a selection.

Scale by (1% - 200%)
Select a percentage from 1 to 200%. A value of 50% will change the volume to 1/2 of its original. A 
percentage of 200% will double the volume.
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Amplitude Modulation
The amplitude modulation effect applies a sinusoidal or square shaped periodic gain to the input signal. 
The frequency of the gain waveform can be specified to create effects varying from a slow tremolo to 
unusual sound distortions.

Dry Out (0-100%)
Amount of unprocessed signal mixed into the output.
Modulated Out (0-100%)
Amount of processed signal mixed into the output.
Frequency (0.1-5,000 Hz)
Frequency of the gain waveform to be applied to the input signal. To achieve a slow tremolo, use a low 
frequency (Period = 1/Frequency). With faster frequencies, the amplitude modulation is audible not as a
change in amplitude, but as additional frequency side bands.
Shape (Sine or Square)
Shape of the gain waveform. Sine wave amplitude modulation is smooth, while square wave 
modulation creates drastic on/off changes.
Stereo Pan (On/Off)
When on, the two channels amplitude gain envelopes are out of phase. This creates the effect of 
panning back and forth between the two channels. Panning is only available for stereo files.
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Chorus
The chorus effect creates the illusion of two or more sound sources playing together. This is done by 
adding a pitch-modulated and delayed version of the input signal to the unprocessed input signal. The 
effect simulates the variances in pitch and timing that occur naturally when two or more people try to play 
the same thing at the same time.

Input Gain (1-100%)
Gain applied to the signal before processing.
Dry Out (-100-100%)
Amount of unprocessed signal mixed into the output.
Chorus Out (-100-100%)
Amount of processed signal mixed into the output.
Chorus Size (1-3)
Number of times the sample is processed with the chorus algorithm. Larger numbers create a fuller 
sound.
Rate (0.1-20 Hz)
Frequency, in Hertz, of the modulating signal.
Depth (0-100%)
Amount of frequency modulation applied to the signal.
Delay (0.1-100 ms)
Time, in milliseconds, that the chorused signal is delayed from the input signal.
Feedback (0-100%)
Percentage of the processed signal which is fed back for re-processing.
Lowpass (1-4,999 Hz, Off)
Cutoff-frequency, in Hertz, of the low-pass filter used on the processed signal. Setting to OFF means no
low-pass filtering occurs.

Tips
A wide variety of non-chorus-like effects can be created with this function. If the modulation depth is high, 
a vibrato effect will occur. If the delay is small, flanging occurs.
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Delay/Echo
The Delay/Echo effect adds a delayed copy of the sound signal to the file. A single delay or decaying 
multiple delays can be added before or after the sound signal.

Dry Out (0-100%)
Amount of unprocessed signal mixed into the output.
Delay Out (0-100%)
Amount of delayed signal mixed into the output.
Multiple Echo (On/Off)
When Off, a single delayed copy is added to the file.
When On, multiple delayed copies are added by using feedback (delaying the delayed signal, and so 
on...), which creates a decaying echo effect.
Pre-Delay/Echo (ON/OFF)
When Off, the delayed copy is added after the sound, as heard in everyday life echoes.
When On, the delayed copy is added before the sound, as heard in the twilight zone.
Delay Time (0.0000 - 5.0000 Seconds)
Determines the time after or before which the delayed copy of the sound is added to the file. Also, if 
Multiple Echo is turned On, subsequent echoes occur at intervals specified by the Delay Time.
Decay Time (0.000 - 20.000 Seconds)
Determines the time it takes the multiple echoes to become nearly inaudible. Technically speaking, this 
is the time it takes an echo to decrease in amplitude by a factor of 30 dB.
If the Decay Time is less than the Delay Time, no echo will be created.

Tips
You can also use the delay function to shift one channel of a stereo file backwards or forwards in time. 
For example, if you have a file with music in the right channel and voice in the left, make a selection in 
only the left channel around the voice. Set the following parameters: Dry Out level at 0%, Delay out level 
at 100%, no multiple delays, no pre-delay. You can then use the Delay Time parameter to determine the 
time-shift. If you want to shift the vocals backwards in time, check the Pre-Delay checkbox.
To simulate a stereo sound from a mono file, copy the sound to both left and right channels of a stereo 
file and then do a very small time-delay of a single channel (Dry Out level at 0%, Delay out level at 100%, 
no multiple delays, no pre-delay). This simple technique often works in making the sound have a more 
realistic stereo image. When a sound wave comes from your side, your right and left ears receive sounds 
at different times, which is what this effect simulates.
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Distortion
The distortion effect can simulate the overloading of an amplifier or mangle a waveform into submission.

Dry Out (0-100%)
Amount of unprocessed signal mixed into the output.
Distorted Out (0-10,000%)
Amount of distorted signal mixed into the output.
Threshold Level (1-100%)
Signals above this level will be distorted.
Hard clip for maximum speaker thrashing (On/Off)
When On, signals over the threshold level will be set to the Clamp level. When Off, signals over the 
threshold level will be soft clipped according to the Curvature.
Curvature (0-100%)
Determines the curvature of the limiting above the threshold level. Zero percent corresponds to hard 
clipping (no curvature) while one hundred percent corresponds to a very smooth curve, with little 
distortion.
Clamp level (0-100%)
Signals over the Threshold Level are set or clamped to this level. For normal limiting, set the clamp 
level to be equal to the threshold level. Setting this level anywhere else will make your speakers do 
things theyve never done before.
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Dynamics
Compression, Expansion, and Limiting, affect the dynamic range of the sampled sound by varying the 
gain as a function of the input sound level.

A compressor lowers the dynamic range of a signal by reducing the level of high volume signals and 
raising the level of low volume signals. Compression is often used in vocals and music to get even 
volume levels which often results in a smoother, fuller sound.

A limiter is a compressor with a greater dynamic range reduction. Limiters are used in broadcasting for 
making sure that the volume level does not go over a certain threshold which overdrives electrical 
equipment. Also, limiters are used by guitarists to create a distorted, sustaining tone.

An expander increases the dynamic range of a signal by increasing the level of high volume signals and 
decreasing the level of low volume signals. Expanders are commonly used for noise reduction or for 
emphasizing the dynamics of a piece.

Ratio (Compressor 1:1 - 10:1, Expander 1:1 - 100:1, Limiter 
10:1 - 100:1)
Ratio of input to output dynamic range, also known as the compression or expansion ratio. This ratio 
determines how much a signal will be boosted or faded as a function of its level.
Center (-40 dB to 0 dB)
Signal level which determines the point between low and high level signals. 
In compression or limiting, a signal with a level above the center point will be attenuated, while a signal 
with a level below the center point will be boosted.
In expansion, a signal with a level above the center point will be boosted, while a signal with a level 
below the center point will be faded.
Threshold (-40 dB - 0 dB)
Signal level below which the gain is held constant, and no compression or expansion occurs.
Pre-Threshold Gain (0-100%)
A constant gain which is applied to a signal with a level below the threshold level. When set to zero, 
signals below the Threshold Level will be completely gated (muted).
Max. Gain (0-1,000%)
The maximum gain the compressor/expander is allowed to apply to the input signal. When set to 100%,
the compressor/expander will attenuate but not boost signals.
Attack Time (1-500 ms)
Time, in milliseconds, required for the compressor/expander to change the gain from the pre-threshold 
to the expansion/compression gain level.
Release Time (1-2,000 ms)
Time, in milliseconds, required for the expander/compressor to change the gain from the active 
expansion/compression to the pre-threshold gain level. 
Output Gain (0-10,000%)
The gain applied to the signal after processing, which is used to compensate for effects on the overall 
signal level. The Output Gain is not affected by the Max Gain parameter.

Tips
Both compression and limiting often lower the overall volume level, while expansion sometimes raises the
peak levels above the maximum allowed level. Use the output gain to compensate accordingly.
When compressing or limiting, setting the center level and the threshold level to the same value keeps the
gain always at or below unity gain. This can also be achieved by setting the Max. Gain control to one. 
Keeping the gain always below unity prevents low-level signals from being overly amplified and is useful 
when all that is required is a reduction of high level signals.
A simple noise gate is achieved by setting the pre-threshold gain to zero, setting the threshold level to be 
just above the noise floor, and setting the ratio to 1:1.
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Envelope
With the envelope effect, the amplitude envelope of a waveform can be forced to match a specified 
envelope shape. Unlike the graphic fade, which simply fades a waveform by a specific amount over time, 
the gain at each point is dynamically calculated to achieve the exact specified envelope.

Envelope Graph (2-16 points, 0-100%)
Specifies the amplitude envelope over time. Click the left mouse button to define a point and drag to 
change its position. Click the right mouse button over an existing point to remove the point.    You can 
create up to 16 envelope points.
The reset button removes all points except the outermost two.
Smooth Gain (On/Off)
When on, prevents the gain from changing too fast, which might result in unwanted distortion.    Also, 
when this option is on the gain will always begin at 0%.
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Flange
The flanging effect is heard in many 60s and 70s recordings. It is the result of mixing a varying delay 
signal with the original signal to create a sweeping sound where high frequencies are accentuated on and
off.

Dry Out (-100-100%)
Amount of unprocessed signal mixed into the output. A negative percentage means that the signal is 
also inverted.
Flange Out (-100-100%)
Amount of processed signal mixed into the output. A negative percentage means that the signal is also 
inverted.
Rate (0.1-20 Hz)
Frequency, in Hertz, of the modulating signal, which determines the period of the flange. Low 
frequencies create a slow, sweeping flange while higher frequencies create fast flanging.
Depth (0-100%)
Amount of frequency modulation applied to the signal.

Tips
Flanging is best heard with long, sustaining sounds so that the entire sweep can be heard.
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Gapper/Snipper
The Gapper/Snipper cuts chunks from the sample or inserts silence in the sample periodically at a set 
frequency to create unusual (if not useful) effects.

Insert/Cut
In Cut mode, chunks are removed from the sample. In Insert mode, chunks of silence are inserted into 
the sample.
Frequency (0.1-1,000 Hz)
Times per second a chunk is inserted or cut from the sample.
Size (1-1,000 ms)
Size of the chunk to be inserted or cut.
Fade (0-50%)
Percentage of the chunk not cut or between inserts that is faded in and out. Zero percent corresponds 
to no fade, while 50% is maximum fade. Use fading to prevent glitches.

Tips 
This process changes the size of the original file. Be aware of the final size indicated, since it is easy to 
set the parameters to create a very large output.
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Noise Gate
A noise gate removes signals below a set threshold. It is used to remove noise from silent breaks in a 
sample.

Threshold (0 to -40 dB)
Signals below this level will be removed from the sample. Zero dB is a very high level, while -30 dB is 
very low. Noise levels are usually around -20 dB.
Attack Time (1-500 ms)
Time it takes the gain of the gate to change from zero to one once the level rises above the threshold.
Release Time (1-2000 ms)
Time it takes the gain of the gate to change from one to zero once the level falls below the threshold.

Tips
To get an estimate of the noise level, select a region of silence (which also contains noise) and run the 
Statistics tool. The maximum value (positive or negative) shown is a good estimate of the threshold noise 
level required. For example, if the maximum positive value is 1.0% and the maximum negative value is -
1.5%, use a number a bit higher than 1.5% (maybe 2%) as the noise threshold level.
The attack time is best kept to a minimum if percussive attacks are to be preserved. Higher attack times 
make sounds slowly swell up in volume.
The release time is usually kept high to allow for natural sounding decays, otherwise long decays will be 
cut off.
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Pitch Bend
Pitch Bend is used to draw an envelope which corresponds to increasing or decreasing the pitch of a 
sample over time.

Envelope (2-16 points, -Range to +Range)
Specifies pitch change over time. The vertical axis represents pitch change, with zero being no change. 
The horizontal axis represents the length of the selected region.
Click the left mouse button to define a point and drag to change its position. Click the right mouse 
button over an existing point to remove the point. You can create up to 16 envelope points.
The reset button removes all points except the outermost two.
Range (1-24 semitones)
Maximum and minimum pitch change in semitones (half-steps). Example: A range of twelve half steps 
(one octave) allows an increase or decrease of the pitch by an octave.

Tips
Pitch change is accomplished in the same manner as changing the playback speed on a tape deck. 
Therefore, the length of the file will be changed.
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Pitch Change
This effect changes the pitch of a sample with or without preserving the duration of the sample.

Semitones (-50 to +50)
Number of semitones (half-steps) to raise or lower the pitch. 
Cents (-100.0 - 100.0)
Fine tune above and below a semitone. One-hundred cents is equal to one semitone.
Preserve Duration (On/Off)
If on, the sample length will remain the same; otherwise, the length of the sample will change by 
1/Ratio. 
When the length must be preserved, the sample is decomposed into its frequency components (FFT) 
and the frequencies are multiplied by the specified ratio. This algorithm is computationally intensive (i.e.
slow) and can produce audible side-effects when processing complex waveforms.
Accuracy (Low/High)
Determines the accuracy and speed of the algorithm used to do a pitch change without change of 
duration. Low accuracy is faster, but breaks the sound up into larger frequency channels, thereby 
reducing the number of computations necessary and creating more audible artifacts.
Ratio
Fraction by which all frequencies will be multiplied by. If the Preserve Duration button is off, the length 
of the file will be multiplied by 1/Ratio.

Tips
Pitch change without preserving duration is accomplished in the same manner as changing the playback 
speed on a tape deck. Therefore, the length of the file will be changed. A pitch change can be used to 
accurately change the time duration of a sample if the change in pitch is not audible or important. 
This is useful if a very small change in time duration is necessary to, for example, correct for 
playback/record speed discrepancies on a tape deck.
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Reverb
The Reverb effect is used to simulate reverberation and other delay-related effects. It accomplishes this 
with a multi-tap delay, pitch modulation, and filtering.

You can use up to eight independent delay taps. Each delay tap consists of a delay time and amplitude 
specification for a particular echo of the original sound. These are used to simulate the Early Reflection 
echoes which are the result of the first sound reflections in a room. Feedback, in combination with filtering
and modulation, is then used to simulate the thousands of other reflections that combine to form what we 
hear as reverberation.

Echogram
The echogram represents the amplitude of sound reflections over time (impulse response) as 
determined by the current settings. Each vertical line represents an echo of the original sound. The 
length of each line corresponds to its amplitude (as a percentage of the original sound), while its 
horizontal distance from the left edge represents the time elapsed after the original sound. The red line 
is the currently selected tap, blue lines are the other active taps, and black lines are echoes resulting 
from feedback.
The echogram can be used to get an estimate of the reverbs decay time. The right-most horizontal 
point corresponds to a delay time equal to the Graph Resolution. This value can be changed between 
500, 1,000, 3,000, and 5,000 milliseconds.
Input Gain (0-100%)
Gain applied to the signal before processing.
Dry Out (0-100%)
Amount of unprocessed signal mixed into the output.
Reverb Out (0-100%)
Amount of processed signal mixed into the output.
Feedback (0-150%)
Percentage of the processed signal which is fed back for re-processing and thus creating more echoes.
Large feedback values allow for longer decay times but can cause ringing.
Rate (0.1-10 Hz)
Frequency, in hertz, of the modulating signal. 0.1 Hz is slow while 10 Hz is very fast modulation.
Depth (0-100%)
Amount of frequency modulation applied to the reverberation. Zero signifies no modulation, and 100% 
is a large amount of modulation. Modulation is used to create a fuller sound or chorusing effects.
Lowpass (0-5 kHz, Off)
Cutoff-frequency, in Hertz, of the low-pass filter (high frequency damping) used on the processed 
signal. Setting to Off means no low-pass filtering occurs. A high frequency setting (or Off) will result in 
live room reverberation, while lower settings will deaden the sound by simulating the high-frequency 
damping which many materials impart on sound.
Number Of Taps (1-8)
Number of delay taps used to create the reverberation.
Tap (1-Number of Taps)
Use to select the delay tap to be modified.
For each active tap there is a corresponding:

Delay (1-500 ms)
Delay time of the tap.
Gain (-100 - 100)
Loudness level of the echo.
Pan (-100-100%)
Channel placement of the echo, with -100% being hard left and 100% being hard right. Panning 
echoes to different channels creates the illusion of reverberation coming from all directions in 
stereo files.

Tips



In most rooms, the first echoes (often called the Early Reflections), arrive at least 20 ms after the original 
sound. Echoes heard within 20 ms of the original sound often create a chorused/flanged sound.
Avoid setting the tap delays evenly or too close together to prevent unnatural ringing caused by 
resonances.
Use only a very slight amount of pitch modulation to simulate realistic reverberation. Modulation can be 
used to lower the amount of ringing. Larger amounts of modulation are used to create a chorused or 
detuned echo effect.
In a large room, sound must travel further to reach the reflection surfaces. Therefore, setting the echoes 
further apart creates a sense of being in a larger space. 
Most building materials and air itself absorb more high frequencies then low frequencies, so using a low-
pass filter is often necessary to prevent the reverberation from sounding too live.
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Vibrato
Vibrato is the periodic pitch modulation often used by vocalists and instrumentalists. Very fast pitch 
modulation creates wacky FM effects unlike any vibrato.

Rate (0.1-1,000 Hz)
Frequency, in Hertz, of the modulating signal. Determines the period of the vibrato. 
Low frequencies (0.1 - 2 Hz) create a slow vibrato while higher frequencies (2 Hz-15 Hz) create fast 
pitch bends. Even higher frequencies (15 Hz and up) modulate the sample so fast that instead of 
hearing pitch changes, new sideband frequencies are heard. 
Depth (0.1-100.0%)
Amount of pitch change applied to the sample.
Trim end if change of duration occurs (On/Off)
When On, if the output sample is shorter than the input sample, the sample is trimmed. This is used to 
prevent glitches when using a slow vibrato inside a selection.
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Statistics
This tool displays statistical information about the selected sample region.

Cursor Position and Sample Value
Cursor position (in samples from start of file) and the sample value (instantaneous amplitude) at this 
position.
For 16-bit samples, the range of values is -32,768 to 32,767.
For 8-bit samples, the range of values is -128 to 127.
Maximum/Minimum Position and Sample Value
Maximum and minimum sample values and the location, in samples, where they occur. 
This is useful for determining if any clipping occurs in the sample.
This value can also be used to determine the noise-level of a signal for use on the Noise Gate effect. 
For example, to find the noise amplitude, run the Statistics function on a region of noisy silence.
Average Value
This is a sum of all of the sample values in the selected region divided by the number of samples. If 
non-zero, this might indicate that there is a DC-offset in the recording process.
RMS Power
Root Mean Square of the sample values relative to the RMS value of a maximum-amplitude sine wave. 
When used on short intervals, this value represents the power, or volume, level of the sample.
Zero Crossings
Times per second that the waveform changes from a negative value to a positive value. This value can 
be used as a rough estimate of the frequency of the sample.
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Simple Synthesis
Simple synthesis can be used to generate a simple waveform of a given shape, pitch, and length.

Length (0.001-60.0 Seconds)
Output length of the generated waveform.
Insert At (Start, End, Cursor)
Point where the generated waveform will be placed within the existing sample.
Waveform (Sine, Square, Triangle, Saw, Absolute Sine, Noise)
Shape of a single period of the waveform.
Frequency (0.01 Hz - Sampling Rate/2)
Frequency of the waveform. This parameter does not affect the noise waveform.
Note that aliasing occurs with many of these waveforms when using high frequencies because they are 
not band-limited.
Amplitude (0-100%)
Peak level of the waveform.
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Search
The Search tool is used to find clicks and pops, volume levels, or silence breaks in a sound signal. 

Glitch Search
Clicks and pops are unwanted sounds often found in vinyl recordings or from bad splice-editing, and are 
seen as sharp glitches in the normal curve of a waveform.

The Glitch Search algorithm looks at a waveform, starting at the cursor position, moving forward in time, 
and determines when a glitch occurs depending on the threshold and sensitivity settings. Then, the cursor
position is moved to the detected glitch to allow for further editing.

Threshold (0.1-50.0%)
Minimum slope (steepness) of the glitch. A high setting will only detect glitches with a high slope, while 
a low setting will detect both low and high sloped glitches.
Sensitivity (0-100)
With a high setting, the glitch finder will detect as a glitch any part of the waveform with a slope above 
the Threshold slope. 
A lower setting forces the Glitch finder to further verify that the high-sloped waveform is in fact a glitch 
and not part of the original, smooth waveform.

Tips
If no glitches are detected, but you can hear clicks or pops, try lowering the threshold and/or raising the 
sensitivity.
If the Glitch finder is falsely detecting glitches, lower the sensitivity and/or raise the threshold.
To find the next glitch, you can use the Ctrl+Y shortcut key to repeat the last operation.

Level Search
Use this to find the next point in time after the cursor position when the waveform reaches a particular 
level.

Threshold Level (0.1-100.0%)
Determines the sound level to search for.

Silence Search
Use this to move the cursor to the end of the next silence break.

Threshold Level (0.1-15.0%)
Determines the silence sound level. The Silence Search will move the cursor to the next position where 
the level goes below and then back above the silence threshold level. 
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Sampler
The Sampler dialog (Tools menu) allows you to send and receive data to and from a sampler. To set up 
sampler/computer communications, press the Configure button.

Configuration
This drop-down list contains Preset Sampler setups (saved in the Sampler Configuration dialog). Once 
you save different configurations, the settings can be conveniently selected from this list.
Logical send/receive sample number (0 - 16,383)
This is the number your sampler uses as its location reference for samples sent or received. This 
number can be biased for specific samplers with the Sampler Bias option in the Sampler Configuration 
dialog.
Actual send sample number
This text field contains the actual sample number to be used by your sampler to store the sample. This 
number is based on the Logical sample number combined with the Sample Bias for sending, set in the 
Sampler Configuration dialog.
Actual receive sample number
This text field contains the actual sample number to be retrieved from your sampler into the current data
window. This number is based on the Logical sample number combined with the Sample Bias for 
receiving set in the Sampler Configuration dialog.
Send Sample
Press this button to begin transmitting the active Data Windows sample to the sampler.
Get Sample
Press this button to begin receiving a sample from the sampler into the active Data Window. This will 
replace all data in the active window. Note that a message box will be displayed requesting 
confirmation if there is already data in the active window.
Configure
Opens the Sampler Configuration dialog where you can determine the settings for communications with
your samplers.

Sampler Configuration Dialog
The Sampler Configuration dialog is used to create and save sampler communications configurations.

Name
The name of the sampler configuration that is saved as a Preset.
Send to
Lists supported samplers and methods of communication for sending samples. If your sampler is not 
listed here, try Generic MIDI/SDS or Generic SCSI/SMDI.

MIDI output (MIDI/SDS)
Select the MIDI interface connected to the input of the sampler to which you wish to send 
samples.
MIDI input (MIDI/SDS)
Select the MIDI interface connected to the output of the sampler to which you wish to send 
samples.
SCSI Host (SCSI/SMDI)
Select the SCSI card used to send data between the computer and sampler.
SCSI Sampler (SCSI/SMDI)
Select the SCSI compatible sampler which will receive the data.
Sample Bias (-16,383 - 16,383)
This is a numbering offset that allows you to add or subtract a value to the Logical sample 
number to compensate for differing sampler storage schemes. It is often easiest to set the 
Sample Bias so a Logical sample number of zero corresponds to the first available sample 
storage number in your sampler.
MIDI Channel (MIDI/SDS) (1-16)



The MIDI channel the sample data will be sent on when using SDS.
Wait for request (MIDI/SDS)
Selecting this option tells the Sampler Tool to wait for a request (handshake) from the sampler 
before beginning an SDS sample transfer.
Open loop (MIDI/SDS)
Selecting this option will cause the Sampler Tool to send SDS sample data immediately upon 
clicking the Send Sample button. This is an unconditional transfer of sample data (no 
handshake). When using Open Loop for send, the samplers MIDI Out does not have to be 
connected to your computers MIDI In. However, open loop decreases sample dump 
performance..

Receive from
Lists supported samplers and methods of communication for receiving samples. If your sampler is not 
listed here, try Generic MIDI/SDS or Generic SCSI/SMDI.

MIDI output (MIDI/SDS)
Select the MIDI interface connected to the input of the sampler from which you wish to receive 
samples.
MIDI input (MIDI/SDS)
Select the MIDI interface connected to the output of the sampler from which you wish to receive 
samples.
SCSI Host (SCSI/SMDI)
Select the SCSI card used to receive data from your sampler.
SCSI Sampler (SCSI/SMDI)
Select the SCSI compatible sampler which will send the data.
Sample Bias (-16,383 - 16,383)
This is a numbering offset that allows you to add or subtract a value to the Logical sample 
number to compensate for differing sampler storage schemes. It is often easiest to set the 
Sample Bias so a Logical sample number of zero corresponds to the first available sample 
storage number in your sampler.
MIDI Channel (MIDI/SDS) (1-16)
Select the MIDI channel on which the sample data will be received when using SDS.
Send request (MIDI/SDS)
Selecting this option tells the Sampler Tool to send a request to your sampler asking for a sample 
when you press the Get Sample button. If you turn this option off, you will always have to initiate 
transfers to the Sampler Tool from your sampler after pressing the Get Sample button. In other 
words, you will have to press a button on your sampler to start the actual transfer.
Open loop (MIDI/SDS)
Selecting this option will cause the Sampler Tool to wait for sample data after pressing the Get 
Sample button. You must initiate all sample transfers from your sampler. This is an unconditional 
transfer of sample data (no handshake). When using Open Loop for receive, the samplers MIDI 
In does not have to be connected to your computers MIDI Out. However, open loop decreases 
sample dump performance.
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Parametric EQ
The Parametric Equalizer is a set of four frequency selective filters which allow for very precise changes 
in the frequency content of a sound signal. 

Filter Type (Low Pass, High Pass, Band Pass, Band Reject)
Frequency response characteristic of the filter.

Low Pass: Frequencies above f2 are attenuated by the Reject ratio.
High Pass: Frequencies below f1 are attenuated by the Reject ratio.
Band Pass (peak): Frequencies below f1 and above f4 are attenuated by the Reject ratio.
Band Reject (notch): Frequencies between f1 and f2 are attenuated by the Reject ratio.

f1 - f4 (1 - Nyquist frequency)
Cutoff frequencies for each filter type corresponding to the graph.
Graph
A visual representation of the frequency response curve of the filter is displayed. The virtual horizontal 
and vertical axis correspond to frequency and gain.
Reject (0 to -60 dB)
Amount of attenuation applied to the region specified by the filter type and cutoff frequencies. (0 dB is 
no attenuation, -60 dB is maximum attenuation)
Total Gain (-15 dB to 15 dB)
Amount of gain applied to the signal after processing. (-15 dB is maximum attenuation, 15 dB is 
maximum boost)
Accuracy  (Low, Medium, High)
Determines a compromise between filter precision and processing speed. Low precision is not 
recommended for performing very sharp filtering, when filtering very low frequencies, or when using a 
high sample rate.

Tips
A low pass filter is used to restrict the high frequencies of a channel. Possible uses are electrical noise or 
hiss reduction. Lowpass filters are also used for anti-aliasing a sample before downsampling.
A high pass filter removes the low frequencies of a channel. This can be used to remove low-frequency 
rumbles such as wind, electrical hum, or traffic noise.
A band pass filter restricts frequencies higher and lower than a specified band. This is useful when trying 
to isolate or boost a particular frequency range of, for example, voice.
A band reject filter attenuates a selected frequency band and is often used to remove narrow-bandwidth 
noise such as amplifier/microphone feedback or 60 Hz electrical hum.
By running a filter several times, you can create sharper cutoff curves.
A zero-phase filter can be created by using the following procedure: Run a filter on a file.    Reverse the 
file by using the Reverse function. Run the same filter on the reversed file.    Reverse the file once again. 
By running a filter in both time directions, filter phase shifts are canceled.

Note: The filters designed are FIR Chebychev linear phase filters with 15 to 512 coefficients (the number 
of coefficients determines both the accuracy and processing time of the filter).
In some circumstances, the specified filter parameters will be too stringent for the filter design algorithm. 
This occurs when: filter frequencies are set too close together or too far apart; reject attenuation is set too
low; or the total gain is set too high or low.
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Graphic EQ
The graphic equalizer can boost or attenuate selected frequency bands to correct or enhance a signals 
frequency spectrum.

Band Attenuation/Gain Faders (-15 dB to 15 dB)
Each of the nine sliders corresponds to the gain or attenuation factor that will be applied to the specified
frequency region.
The frequency on the bottom of the fader is the center frequency of the frequency band affected by the 
fader.
The value of the fader affects the frequency band as follows:

+15 dB Maximum boost
0 dB No effect

-15 dB Maximum attenuation
Accuracy  (Low, Medium, High)
Determines a compromise between filter precision and processing speed. Low precision is not 
recommended for performing very sharp filtering, when filtering very low frequencies, or when using a 
high sample rate.
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FM Synthesis
FM Synthesis uses frequency modulation (FM) to create complex sounds from simple waveforms. 
Frequency modulation is the varying of the frequency of a waveform (the carrier) as a function of the 
output amplitude of another waveform (the modulator). If the frequency of the modulator is low, the carrier
will be slowly detuned over time. However, if the frequency of the modulator is high, the carrier will be 
modulated so fast that many additional frequencies, or sidebands, are created.

In this implementation, up to four waveforms (operators) can be used in a variety of configurations. 
Depending on the configuration, an operator can be a carrier, a modulator, or a simple, unmodulated 
waveform. 

Length (0.001-60.0 seconds)
Output length of the generated waveform.
Insert At
Point where the generated waveform will be placed within the existing sample.
Configuration Figure
Determines the arrangement and number of operators to be used.
The output of operators joined horizontally are simply mixed together. The output of the bottom 
operators are mixed together to form the final output. Mixing together different simple waveforms is 
called Additive Synthesis.
Two operators joined vertically are FM carrier-modulator pairs. Operators which have another operator 
stacked above them are carriers, with the operator directly above being the modulator. 
Operators which have no other operator directly above are simple waveform generators.
When three or more operators are stacked, this means that the highest operator modulates the 
operator below it, which then in turn modulates the following operator below, and so on.
Operator (1-Number of Operators)
Determines the active operator being modified.
Each operator has the following parameters:

Waveform (Sine, Square, Triangular, Saw, Absolute Sine, Noise)
Shape of a single period of the waveform.
Frequency (0.0 - Sampling Rate/2)
Frequency of the waveform. This parameter does not affect the noise waveform.
Note that aliasing occurs with many of these waveforms when using high frequencies because 
they are not band-limited.
If the frequency is set to 0.00, a DC (zero frequency) waveform is produced regardless of the 
waveform specified.
When using Noise, the frequency determines the high-frequency content of the noise.
Feedback (0-100%)
Amount of the output of the operator which is used to modulate itself. If the operator is being 
modulated by another waveform also, the feedback path and the modulator output are mixed 
together to modulate the carrier.
Envelope (2 - 8 points, each 0-100%)
Amplitude envelope of the active operator over time. Click the left mouse button to define a point 
and drag to change its position. Click the right mouse button over an existing point to remove the 
point. You can create up to 8 envelope points for each operator.
The reset button removes all points except the outermost two.
Amplitude (0-100%)
Output gain of operator after amplitude envelope. If the operator is a modulator, this control, along
with the envelope, determines the amount of frequency modulation applied to the carrier.

Tips



Start out with the simplest, single operator configuration and try out all the waveforms at different 
frequencies, with the feedback factor set at zero.
Experiment using feedback on each waveform to hear the different effects of self-modulation.
Now move to the next configuration, with two unmodulated operators mixed together (horizontal 
connection) to hear two operators simultaneously (Additive Synthesis).
Now change the configuration to two stacked operators (vertical connection) and again experiment using 
different waveforms and frequencies on the carrier (bottom operator) and the modulator (top operator). 
With the modulator frequency set low (1-5 Hz), lower the modulator amplitude to create slight detuning. 
Raising it creates big pitch bends.
If the modulator frequency is set high, many unusual sounds can be achieved.
Setting the modulator frequency to 0.00 (DC) allows for direct control of the carriers pitch by using the 
modulators amplitude envelope.
Adding more operators increases the complexity of the waveform. Both FM and additive synthesis can be 
combined to generate an endless variety of sounds.
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ACM Filter
Sound Forge has the ability to use Audio Compression Manager (ACM) filters to process audio files. No 
ACM filters come installed with Sound Forge, but ACM filters can be obtained from various manufacturers
for a variety of different functions. Just a note here, the word filter in this case does not necessarily mean 
sound frequency filtering. ACM filters can perform a number of different functions like delay, volume, 
reverb, and sample rate conversion. Filter in this case means any function which modifies audio data in 
some way.

Filter
Any installed ACM filters will be displayed here.
Attributes
If the selected filter has predefined parameters, they will be displayed here.
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Auto Region
The Auto Region function automatically creates regions in a sample for the Regions List and Playlist. 
These regions are defined according to fast sound attacks (like drum beats or words) or a selected 
musical time interval.

Use Beats Per Minute (On/Off)
When On, regions are created according to the current Beats Per Minute (see Edit Tempo function 
under the Special menu to change this value) Otherwise, regions are created by using an algorithm that
finds sound level changes to determine where a sound attack or release occurs.
Beats, Measures (0-100)
Determines the musical time interval between regions according to the specified BPS. For example, if 
you want a region to be created at every beat, set Beats to 1 and Measures to 0. To have a region 
created at every measure, set Measures to 1 and Beats to 0. If you wanted to have a section at every 7
beats, you could set Beats to 7 and Measures to 0, or set Beats to 3 and Measures to 1, if you have 
defined a measure to be 4 beats. You can set the number of beats per measure in the Status folder of 
the Preferences section. You can also set the number of beats per measure using the Edit Tempo 
command.
Attack Sensitivity (1-100%)
Determines how sensitive the attack-detection algorithm is to fast increases in volume. With a high 
setting, regions are created when the sound level increases by very small amounts, therefore creating 
more regions. With a low setting, the sound level must increase by a large amount before a new region 
is created and therefore less regions are created.
Release Sensitivity (0.1-100.0%)
Determines the minimum decrease in sound level which must occur before a region end is created. 
High values indicate that the sound level does not have to decrease very much before a region end is 
created, and therefore more regions will be found. When set low, the sound level must decrease to a 
greater extent before a region end is found. A low setting is useful if you only want a regions to be 
created after very silent breaks.
Minimum Level (0.1-100.0%)
Threshold sound level which must be found before a new region is created. With a high setting, only 
high level sounds will trigger the creation of a new region. This is useful if you want only the loud 
instrument attacks in a song (like the bass drum) to be at the beginning of a region, since they often 
correspond to the beginning of a measure or beat. Low threshold settings will allow low-level sound 
attacks to also create new regions.
Minimum Beat Duration (.01 - 3.00 Seconds)
Specifies the minimum length in seconds that must elapse before a new region can be created. A low 
setting will allow very short regions to be created if sound attacks occur in fast succession. This is 
useful for fast-tempo music. A higher setting will prevent quick sound attacks from being separated into 
different regions.
Use Release Point for End of Region (On/Off)
When On, a region will end when the sound level drops by a factor determined by the Release 
Sensitivity. This is useful if you dont want the silence in between sounds or phrases to be included in 
the regions.
When Off, region ends are only created when attacks are detected.

Tips
When using the attack-detection algorithm, more beats will be detected if you: raise the Attack 
Sensitivity, raise the Release Sensitivity, lower the Minimum Level, or lower the Minimum Beat 
Duration. The opposite is true for detecting less beats.
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Sound File Formats
The file formats recognized by Sound Forge are listed below along with the extension used to identify 
them to the user. An arbitrary extension has been assigned for each of the formats used by computers 
other than the PC. Many of these formats when found on another type of computer will tend to use the 
extension .SND. Thus, even if a file has the .SND extension it may not be a Sounder/ SoundTool file. 
Ad Lib Sample (.SMP)
This format is used by the Ad Lib Gold card, for its sampled instruments. It supports, 8/16 bit, 
stereo/mono, and 4 bit Yamaha ADPCM compression.
Amiga SVX File (.SVX)
This file type is found on the Commodore Amiga and is similar in substance to the Microsoft RIFF Wave 
format.
Atari Sound Designer 1    (.DIG)
This format is used by Sound Designer for the Atari.
Covox 8 Bit File (.V8)
This format is used with Covox software. It is an 8 bit mono uncompressed file format.
Creative Labs VOC File (.VOC)
This is one of the more commonly found sample sound formats found on PC compatible computers. The 
VOC format supports packed data which Sound Forge will unpack prior to importing the file. The VOC 
format also supports information for silence, looping, and varying sample rates. When Sound Forge 
imports a VOC file it uses the first sample rate found and ignores such information as looping and silence.
Sound Forge will save VOC files as unpacked data with none of the additional information such as 
looping or silence. Sound Forge gives you the ability to save VOC files in either the Old or New VOC 
standard. The New VOC standard supports 16 bit data. Refer to the Preferences section in the Sound 
Forge Reference for information on configuring Sound Forge to always use the New VOC standard.
Dialogic VOX File (.VOX)
This format is used with specialized voice data boards. It is a 4 bit Mono ADPCM file format which 
expands to 16 bit data.
Gravis Patch File    (.PAT)
This format is used by the Gravis UltraSound Card. Sound Forge can only read and write Gravis Patch 
files which have single samples stored in them. Patch files with multiple samples are not recognized. 
Sound Forge recognizes Gravis Patch files which are of version 1.10. Older versions such as 1.00 are not
supported.
Macintosh AIFF    (.AIF; .SND)
This format is used on the Apple Macintosh to save sound data files. AIFF files are best when transferring 
files between the PC and the Mac using a network, since most network software will delete any resource 
information in a Macintosh file. Sound Forge can also read an AIFF with a Mac binary header attached 
but will identify the file as a Macintosh Resource instead.
Macintosh Resource (.SND)
This format is used on the Apple Macintosh to save sound resources. When reading a file of this type it 
must have a Mac-Binary header. This header is attached to binary files transferred with common 
Macintosh file transfer programs. Sound Forge does not save to this file format.
Microsoft Wave File    (.WAV)
This is the format for sampled sounds defined by Microsoft for use with Windows. It is an expandable 
format which supports multiple data formats and compression schemes.
MIDI SDS File    (.SDS)
This format is a file which contains the exact data that would be transferred to a sampler when using the 
MIDI Sample Dump Standard (SDS) protocol. It is a series of MIDI SysEx messages. MIDI SDS supports 
mono files only.
NeXT / Sun Sparc File (.AU; .SND)
This is the standard format of sound files found on the NeXT and Sun Sparc station computers. This 
format has a large number of sub types of file data. Sound Forge reads and writes the most common data
formats for these files, 8 bit linear, 16 bit linear, and u-Law.



SampleVision File    (.SMP)
This format is used with Turtle Beach's SampleVision software. It is a 16 bit Mono file format. The SMP 
format is meant to be used with sampling keyboards.
Sonic Foundry Sample Resource (.SFR)
This format is an old format defined by Sonic Foundry and is supplied for compatibility. It is not 
recommended for use in saving files.
Sounder/SoundTool File (.SND)
This format is used with the Shareware applications Sounder and Sound Tool. It is very popular on 
Bulletin Boards and various On-line services.
Raw Files (.*)
Raw files can be composed of any sound data. If the data is any form of 8 or 16 bit PCM (uncompressed) 
or G.711 A-Law or u-Law (a form of companded compression), then Sound Forge can open and save the 
file.

 Indicates this file format supports the saving of sample looping information. The following is a list of 
summary information fields for Wave files supported by Sound Forge.



Summary Information Fields

IARL Archival Location
Indicates where the subject of the file is archived.
IART Artist
Lists the artist of the original subject of the file. For example, "Bach."
ICMS Commissioned
Lists the name of the person or organization that commissioned the subject of the file. For example, 
"XYZZY Records."
ICMT Comments
Provides general comments about the file or the subject of the file. If the comment is several sentences 
long, end each sentence with a period. Do not include newline characters.
ICOP Copyright
Records the copyright information for the file. For example, "© Copyright Sonic Foundry, Inc. 1994." If 
there are multiple copyrights, separate them by a semicolon followed by a space.
ICRD Creation Date
Specifies the date the subject of the file was created. List dates in year-month-day format, padding one-
digit months and days with a zero on the left. For example, "1964-03-02" for March 2, 1964.
ICRP Cropped
Describes whether an image or sound has been cropped and, if so, how it was cropped. For example, 
"third movement, first through fourth bars."
IDIM Dimensions
Specifies the size of the original subject of the file. For example, "8.5 in h, 11 in w."
IDPI Dots Per Inch
Stores dots per inch setting of the digitizer used to produce the file, such as "300."
IENG Engineer
Stores the name of the engineer who worked on the file. If there are multiple engineers, separate the 
names by a semicolon and a blank. For example, "Sayre, Jack; Feith, John."
IGNR Genre
Describes the original work, such as, "landscape," "portrait," "still life," etc.
IKEY Keywords
Provides a list of keywords that refer to the file or subject of the file. Separate multiple keywords with a 
semicolon and a blank. For example, "Madison; aerial view; scenery."
ILGT Lightness
Describes the changes in lightness settings on the digitizer required to produce the file. Note that the 
format of this information depends on hardware used.
IMED Medium
Describes the original subject of the file, such as, "computer image," "drawing," "lithograph," and so forth.
INAM Name
Stores the title of the subject of the file, such as, "Madison From Above."
IPLT Palette Setting
Specifies the number of colors requested when digitizing an image, such as "256."
IPRD Product
Specifies the name of the title the file was originally intended for, such as "Encyclopedia of Midwest 
Geography."
ISBJ Subject
Describes the contents of the file, such as "Aerial view of Madison."
ISFT Software
Identifies the name of the software package used to create the file, such as "Sound Forge."
ISHP Sharpness



Identifies the changes in sharpness for the digitizer required to produce the file (the format depends on 
the hardware used).
ISRC Source
Identifies the name of the person or organization who supplied the original subject of the file. For 
example, "Sonic Foundry, Inc."
ISRF Source Form
Identifies the original form of the material that was digitized, such as "slide," "paper," "map," and so forth. 
This is not necessarily the same as IMED.
ITCH Technician
Identifies the technician who digitized the file. For example, "Palmer, Curt."



Sound Forge and the Microsoft Audio Compression Manager

Sound Forge for 32 Bit Windows Note: The Microsoft Audio Compression Manager
(ACM) is currently not available under Win32s. This is a limitation of Win32s, not Sound

Forge for 32 Bit Windows.

The Microsoft Audio Compression Manager (more commonly referred to as the ACM) is a standard 
interface for Audio Compression and Filtering in Windows and Windows NT. This interface allows 
applications like Sound Forge to use compression and filtering algorithms provided by other companies.
Sound Forge fully supports audio compression and filtering through the ACM. This enables you to use 
any ACM compatible compression and filter driver with Sound Forge. The best part of this support is you 
don't have to learn anything new to use it! Sound Forge transparently opens compressed WAV files and 
provides all available compression formats for WAV files in the Save As dialog. There are no silly Import 
and Export commands. 
There are roughly three pieces to the ACM (though these pieces are tightly coupled). It is not necessary 
for you to know any details about these pieces to use the ACM from Sound Forge, so this information is 
supplied for those who want to know more. That being said, the three pieces of the ACM are:
Audio data compression and decompression
Audio data filtering
Transparent Playback and Recording of non-hardware supported audio files
                                                         
See also
Installing the ACM



Audio data compression and decompression
The first piece of the ACM allows you to compress and decompress audio data. Audio compression is 
used to decrease the amount of data required to represent a sound; this ultimately results in smaller 
sound files. However, there are drawbacks to using audio compression on your sound files:

- Most audio compression algorithms will degrade the quality of the sound. This is referred to as 'lossy' 
compression since information contained in the sound is 'lost' when it is compressed. The amount of 
sound degradation is entirely dependent on the algorithm.
- Audio compression requires more processing time than uncompressed data. The amount of 
processing time is dependent on the algorithm as well as your hardware setup. The result is opening 
and saving compressed files will usually take longer than uncompressed files.
- Compressed files are not as 'portable' as uncompressed files. If you are distributing WAV files in a 
compressed format, you must make sure the person receiving the files can use them. Also, not all audio
software can use compressed WAV files, which could make using other programs with Sound Forge 
inconvenient.

Keep these points in mind when you are deciding whether to use audio compression. Experimentation is 
probably the most important step in deciding what works best for you and your projects.
In Sound Forge, any compressed WAV file can be opened as long as a compatible ACM driver is installed
and enabled. If there is no compatible ACM driver available for a compressed WAV file, Sound Forge will 
inform you of the problem when you try to open it.
Saving compressed WAV files is as simple as choosing the compression algorithm in the Format drop-
down list of the Save As dialog. Once a file has been saved as compressed, Sound Forge will always 
save changes to the file using the selected compression algorithm; you do not need to re-select the 
compression format each time you save. Of course you can change the compression format at any time 
with the Save As dialog. You can also revert to an uncompressed format.



Audio data filtering (Digital Signal Processing)
The second piece of the ACM provides access to Digital Signal Processing (DSP) algorithms. The ACM 
refers to these DSP algorithms as Filter drivers. Though the term Filter in this context is more generic 
than just frequency filtering (like Parametric or Graphic EQ). An ACM Filter can implement almost any 
type of audio DSP algorithm. Reverb, distortion, and time change are several possibilities.
Sound Forge allows you to use any ACM Filter installed and enabled on your computer to process sound 
files. Simply select the ACM Filter option under the Tools Menu to choose the Filter and its Attributes 
that you wish to apply to your sound data. The ACM Filter Tool works exactly like all other Sound Forge 
DSP functions including the option to save Presets and set custom selections.
Sound Forge does not come with any ACM Filters. You must obtain ACM Filters from other sources. 
However, since the ACM Filter architecture is fully documented by Microsoft, it is possible that many types
of Filters will become available on BBS's and other places for use with Sound Forge.



Transparent Playback and Recording of non-hardware supported audio files
The third part of the ACM is probably the most significant (or at least the coolest). It is called the Sound 
Mapper and allows audio data formats that are not directly supported by your sound card to be played 
and recorded. Sound Forge lets you use the Sound Mapper by selecting it for Playback and Record in the
Wave folder of the Preferences dialog. Additional configuration of the Sound Mapper for your system can
be done using the Windows Control Panel.
If the ACM is not installed on your computer, the Sound Mapper option will be called the Wave Mapper 
instead. The Wave Mapper and Sound Mapper can be thought of as the same device (to a computer 
program, they are one and the same). However, the Sound Mapper, which requires the ACM to be 
installed, is much more powerful than the Wave Mapper. Keep this in mind when you hear people talk 
about the Wave Mapper and Sound Mapper.
Let's go through some examples of what the Sound Mapper can do. If you have a sound file that is 
recorded at a bizarre sample rate like 22,257 Hz (perhaps a file that came from an external sampler), and 
the closest sample rate that your sound card supports is 22,050 Hz, then the sound file normally cannot 
be played. You would have to change the sample rate of the file to 22,050 Hz before you could play it. 
However, changing the sample rate (without re-sampling) would cause the sound to play at a lower pitch.
The Sound Mapper can play this sound file correctly without forcing you to re-sample the file first. The 
Sound Mapper will map the sound to the best format possible and perform the re-sampling in real-time. 
Yes Virginia, there is a Santa Claus!
Other examples include the ability to play 16 bit sounds on an 8 bit only sound card. or playing stereo 
sounds on a mono only sound card. And believe it or not, you can record stereo files on a mono only 
sound card. However, this last example is essentially useless because the Sound Mapper will simply 
duplicate the mono input of your sound card in both channels. So keep in mind that the Sound Mapper 
cannot create something that is better than what the sound card can supply.
The usefulness of the Sound Mapper for non-compressed sound files can be surmised as convenience. 
You do not have to convert the sound to a supported format before you listen to it. Some of the tasks that 
the Sound Mapper can perform (like format conversions while recording) are available not because they 
are useful in real world situations, but because the developers of the ACM knew it could be done. Much 
like climbing a mountain for no better reason than it's there.
So what about compressed sound files? Yes, the Sound Mapper allows you to play (and sometimes 
record) compressed sound files. Even on sound cards that do not support compression directly. So you 
can play a sound file that is compressed with Microsoft ADPCM or The DSP Group's TrueSpeech on any 
sound card without decompressing the sound file first. Many multimedia and entertainment software titles 
use compressed sound files to save disk space. The software then plays the files through the Sound 
Mapper.
We stated above that the Sound Mapper can sometimes record compressed sound files. The reason for 
not always being able to record compressed files (even when the compressed file can be played) is 
simple. Compressing sound data can be very computationally expensive (it takes a long time); the 
amount of time required is completely dependent on the compression algorithm and how it is 
implemented. Decompressing sound data is almost always faster than compressing the same sound data
which makes it possible to play it back in real-time.
It should be noted that Sound Forge does not play and record compressed sound files directly. Rather, all 
compression and decompression is performed while opening and saving the sound files. This limitation is 
actually insignificant; Sound Forge is the perfect tool for authoring compressed sound files for the ACM 
and many software authors are using Sound Forge for exactly this. Sound Forge saves compressed 
sound files using the best quality possible--something that cannot always be done in real-time. So saving 
compressed sound files with Sound Forge will usually sound better than those recorded with audio 
compression.
Notes on Sound Forge's sound file compression support:

- The Open dialog allows you to preview compressed WAV files if you have an appropriate ACM driver 
is installed. However, you must have your Playback device set to the Sound Mapper for this to work.
- When saving uncompressed audio data to a compressed format with the Save As dialog it is a good 
idea to close the file and re-open it after saving. Since Sound Forge does the compression and 



decompression during saving and loading you will not be able to hear what the file sounds like with 
compression until after you've saved and re-loaded the file.



Installing the Microsoft Audio Compression Manager
This section contains information on installing the Microsoft Audio Compression Manager (ACM) on your 
computer. Sound Forge fully supports the ACM for audio compression and signal processing, and for your
convenience we have included the ACM on Disk 2 of the Sound Forge disk set.
Note that you only need to install the ACM if you are running Windows 3.1 (or Windows for Workgroups 
3.11). Windows NT 3.5 comes with the ACM pre-installed (there is no ACM available for Windows NT 3.1).
Installing the ACM is optional, but highly recommended. For more information on what the ACM is and 
how it can benefit you, refer to the Appendix labeled Sound Forge and the Audio Compression Manager.
To Install the ACM, do the following:

1. If you are not in Windows start Windows by typing WIN at the DOS command prompt.
2. Insert Sound Forge Disk 2 in your floppy disk drive.
3. Choose "Run..." from the Windows Program Manager "File" menu.
4. In the Command Line field type a:\acm\setup if you're installing from drive A or b:\acm\setup if 
you're installing from drive B. Click OK to continue.
5. Follow the instructions in the setup program.



The Sonic Foundry Virtual MIDI Router

Sound Forge for 32 Bit Windows Note: The Sonic Foundry Virtual MIDI Router is only
available in 16 bit format. Therefore, it cannot be installed in Windows NT. The VMR can
be installed under Windows 3.1, Windows for Workgroups 3.11 and Windows 95. It may

also be used from Win32s.

This section contains information on the Sonic Foundry Virtual MIDI Router (VMR) included with Sound 
Forge. This software only driver allows you to control Sound Forge from other MIDI capable applications 
and vise versa without using MIDI hardware. We have included the Sonic Foundry Virtual MIDI Router on 
Disk 2 of the Sound Forge disk set.
Refer to the Appendix labeled Installing the Sonic Foundry Virtual MIDI Router for installation and setup 
instructions.
A MIDI Router simply transfers MIDI data from one port to another. The Sonic Foundry VMR driver does 
exactly this but requires no hardware. The driver provides four devices for MIDI Output and four devices 
for MIDI Input. Each of the Output devices sends all MIDI data to its corresponding Input device.
If one application sends MIDI data through the 3 Sonic Foundry MIDI Router output device, another 
application can receive this MIDI data as input from the 3 Sonic Foundry MIDI Router input device. Note
that the first character of the device name is a device number from 1 to 4. The device number is placed at
the beginning of the name for compatibility with sequencer software that tries to display device names in 
very small places.
The Sonic Foundry VMR can be very useful for synchronizing two MIDI capable applications. You can 
Trigger Sound Forge from your MIDI sequencer, or you can drive your MIDI sequencer from Sound Forge
using SMPTE/MTC. This and more can be accomplished without using MIDI hardware for routing.



Installing the Sonic Foundry Virtual MIDI Router

Sound Forge for 32 Bit Windows Note: The Sonic Foundry Virtual MIDI Router is only
available in 16 bit format. Therefore, it cannot be installed in Windows NT. The VMR can
be installed under Windows 3.1, Windows for Workgroups 3.11 and Windows 95. It may

also be used from Win32s.

This section contains information on installing the Sonic Foundry Virtual MIDI Router (VMR) on your 
computer. This software only driver allows you to control Sound Forge from other MIDI capable 
applications and vise versa without using MIDI hardware. We have included the Sonic Foundry VMR on 
Disk 2 of the Sound Forge disk set.
Installing the Sonic Foundry VMR is optional, but highly recommended. For more information on what this
driver is and how it can benefit you, refer to the Appendix labeled The Sonic Foundry Virtual MIDI Router.
To Install the Sonic Foundry Virtual MIDI Router, do the following:

1. Open Control Panel and double-click the Drivers icon.
2. Click the Add button.
3. Select Unlisted/Updated driver and click OK.
4. You can now insert Sound Forge Disk 2. Click the Browse button and select the drive in which you 
inserted the disk. Double click the SFVMID directory. Click OK.
5. The driver should now be listed as Sonic Foundry Virtual MIDI Router. Click once on the driver to 
select it and click OK.
6. Windows will now install the driver. When it is finished you will be prompted to restart Windows to 
complete the driver installation. There are no further setup procedures.
7. Once you have restarted Windows, all programs that support MIDI (including Sound Forge) can use 
the Virtual MIDI Router.



SMPTE Time Code
The Society of Motion Picture and Television Engineers (SMPTE) time code may be one of the most 
misunderstood concepts among individuals within the music industry. After working with SMPTE time 
code for years, many people are still confused by the concept, so don't feel bad if you haven't got it all 
figured out. Hopefully this discussion will clear the mud.
The biggest problem with SMPTE time code is that, depending on whether you sit on the video or audio 
side of the fence, SMPTE time codes may mean different things to you. When dealing with SMPTE you 
will probably see five, perhaps six, different types of time codes formats (six is for the people who are 
really confused).
Here is a description of each SMPTE time code format:
SMPTE 25 EBU
This SMPTE code runs at 25 frames per second and is also know as SMPTE EBU (European 
Broadcasting Union). The reason for having this rate is that European television systems run at exactly 25
frames per second.
SMPTE 24 Film Sync
This SMPTE code runs at 24 frames per second and is also know as SMPTE Film Sync. This rate 
matches a nominal film rate of 24 frames per second (the slowest speed possible for apparent continuous
motion).
OK, those two are easy. Now things start to get a little crazy.
SMPTE 30 Non-Drop (as used in the audio world)
In the US, the 60 Hz power system makes it easy to generate a time code rate of 30 frames per second. 
This rate is commonly used in audio environments and is typically known as 30 Non-Drop. You will 
probably use this rate when synchronizing audio applications like a multi-track recorder or your MIDI 
sequencer.
If all you care about is working with audio and not dealing with video, stop reading right here. We 
mean it! All you really need to know is that there are three different SMPTE rates you might want to use: 
SMPTE 24, SMPTE 25, and SMPTE 30 Non-Drop. However, be aware that SMPTE 30 Non-Drop in the 
video world runs at 29.97 frames per second.
True SMPTE 30 Drop and SMPTE 30 Non-Drop (as used in the video world)
If you are planning to work with video, the frame rate of exactly 30 frames per second is never used. 
When NTSC color systems were developed, the frame rate was changed by a tiny amount to eliminate 
the possibility of crosstalk between the audio and color information. Even though it is still referred to as 
SMPTE 30 Drop or Non-Drop, the actual frame rate that is used is exactly 29.97 frames per second. This 
poses a problem since this small difference will cause SMPTE time and real time (what your clock reads) 
to be different over long periods. Because of this, two methods are used to generate SMPTE time code in
the video world: Drop and Non-Drop.
In SMPTE Non-Drop, the time code frames are always incremented by one in exact synchronization to 
the frames of your video. However, since the video actually plays at only 29.97 frames per second (rather 
than 30 frames per second), SMPTE time will increment at a slower rate than real world time. This will 
lead to a SMPTE time versus real time discrepancy. Thus, after a while, we could look at the clock on the 
wall and notice it is farther ahead than the SMPTE time displayed in our application.
SMPTE Drop time code (which also runs at 29.97 frames per second ) attempts to compensate for the 
discrepancy between real world time and SMPTE time by dropping frames from the sequence of SMPTE 
frames in order to catch up with real world time. What this means is that occasionally in the SMPTE 
sequence of time, the SMPTE time will jump forward by more than one frame. The time is adjusted 
forward by two frames on every minute boundary except 00, 10, 20, 30, 40 , and 50. Thus when SMPTE 
Drop time increments from 00:00:59:29, the next value will be 00:01:00:02 in SMPTE Drop rather than 
00:01:00:00 in SMPTE Non-Drop. In SMPTE Drop, it must be remembered that certain codes no longer 
exist. For instance, there is no such time as 00:01:00:00 in SMPTE Drop. The time code is actually 
00:01:00:02.



When synchronizing audio to video, it is crucial that the SMPTE time code (30 Drop or Non-Drop) used in 
your sequencer or digital audio workstation is the same as the SMPTE time code striped onto the video. 
Only then will the SMPTE times on the video screen and computer monitor match exactly during 
playback.
In the audio world, people have started to call 30 Non-Drop (which runs at 29.97 frames per second) 
29.97-Non-Drop to distinguish it from the 30 Non-Drop used between audio applications (which runs at a 
true 30 frames per second). SMPTE 30 Drop (as used in video) may also be referred to as SMPTE 29.97 
Drop just to reiterate that the frame rate is actually 29.97 frames per second. It just depends on who you 
talk to.
However, you must remember that there is no difference between 30 Drop and 29.97 Drop time code. 
There are those who have tried to say that there is such a thing as a SMPTE time code which actually 
runs at 30 frames per second and generates drop frames. This practice would be silly, as the whole point 
of a SMPTE Drop time code is to make up for the discrepancy between the 29.97 frames per second 
"video" rate and the 30 frames per second "real time" rate.
How Sound Forge deals with the issue
For SMPTE 24, SMPTE 25, and SMPTE 30 Drop time codes, Sound Forge behaves as you would 
expect. The 24, 25 and 30 Drop frame rates are calculated and generated at exactly 24, 25, and 29.97 
frames per second respectively. In 30 Drop rate, the dropped frames are inserted to make up for the time 
discrepancies with real world time.
For SMPTE 30 Non-Drop, the default method for Sound Forge is to calculate all SMPTE values at exactly
30 frames per second. If you are working with video and need SMPTE Non-Drop running at 29.97 frames 
per second, you can turn off the Use 30 frames per second for SMPTE Non-Drop option in the 
MIDI/Sync Preferences folder. This will cause Sound Forge to use 29.97 frames per second instead of 
30 frames per second for SMPTE 30 Non-Drop.
Some calculations for your benefit:
SMPTE 30 fr = 33.3333 ms per frame; SMPTE 29.97 fr = 33.3667 ms per frame
1 minute = 60 seconds * 30 = 1,800 frames per minute
1 minute = 60 seconds * 29.97 = 1,798.2 frames per minute
Difference per minute = 1.8 frames.
1 hour = 3,600 seconds * 30 = 108,000 frames per hour
1 hour = 3,600 seconds * 29.97 = 107,892 frames per hour
Difference per hour = 108 frames.
Thus in drop frame we need to catch up by 108 frames per hour
For example, in Non-Drop mode the SMPTE time code of 01:00:00:00 will equate to a real world time of 
01:00:03:18. Therefore, there is a lag behind real world time of 3 seconds and 18 frames after 1 hour.
Here is a nifty chart to show how SMPTE Drop works. As time progresses, two frames are dropped each 
minute except at the 00, 10, 20, 30, 40 , and 50 minute points. Notice that after one hour, 108 frames 
have been dropped. This number corresponds to the number of drop frames we calculated above needed
to match SMPTE 30 (29.97 fps) time to real time.

Number of dropped frames versus minutes elapsed over one hour
Minutes 00 10 20 30 40 50

xx:00:00:00 xx:10:00:00 xx:20:00:00 xx:30:00:00 xx:40:00:00 xx:50:00:00
0 0 frames 18 frames 36 frames 54 frames 72 frames 90 frames
1 2 20 38 56 74 92
2 4 22 40 58 76 94
3 6 24 42 60 78 96
4 8 26 44 62 80 98
5 10 28 46 64 82 100
6 12 30 48 66 84 102
7 14 32 50 68 86 104
8 16 34 52 70 88 106
9 18 36 54 72 90 108



General MIDI Patch Map

1-8
PIANO 

9-16
CHROM PERCUSSION 

17-24
ORGAN 

1              Acoustic Grand Piano 9                Celesta 17            Drawbar Organ
2              Bright Acoustic Piano 10            Glockenspiel 18            Percussive Organ
3              Electric Grand Piano 11            Music Box 19            Rock Organ
4              Honky-tonk Piano 12            Vibraphone 20            Church Organ
5              Electric Piano 1    13            Marimba 21            Reed Organ
6              Electric Piano 2    14            Xylophone 22            Accordion
7              Harpsichord 15            Tubular Bells 23            Harmonica
8              Clav    16            Dulcimer 24            Tango Accordion

25-32
GUITAR    

33-40
BASS 

41-48
STRINGS

25            Acoustic Guitar 
(nylon)    

33                Acoustic Bass    41                Violin

26            Acoustic Guitar 
(steel)

34                Electric Bass 
(finger)

42                Viola          

27            Electric Guitar (jazz) 35                Electric Bass (pick)  43                Cello 
28            Electric Guitar 
(clean)

36                Fretless Bass    44                Contrabass

29            Electric Guitar 
(muted)

37                Slap Bass 1        45                Tremolo Strings

30            Overdriven Guitar 38                Slap Bass 2    46                Pizzicato Strings
31            Distortion Guitar 39                Synth Bass 1    47                Orchestral Strings
32            Guitar Harmonics 40                Synth Bass 2 48                Timpani 

49-56
ENSEMBLE 

57-64
BRASS

65-72
REED

49                String Ensemble 1 57                Trumpet      65            Soprano Sax
50                String Ensemble 2 58                Trombone    66            Alto Sax
51                Synth Strings 1 59                Tuba 67            Tenor Sax 
52                Synth Strings 2 60                Muted Trumpet 68            Baritone Sax 
53                Choir Aahs 61                French Horn 69            Oboe
54                Voice Oohs 62                Brass Section 70            English Horn 
55                Synth Voice 63                Synth Brass 1 71            Bassoon
56                Orchestra Hit 64                Synth Brass 2 72            Clarinet    

73-80
PIPE 

81-88
SYNTH LEAD    

89-96
SYNTH PAD

73            Piccolo 81            Lead 1 (square) 89            Pad 1 (new age)
74            Flute 82            Lead 2 (sawtooth) 90            Pad 2 (warm) 
75            Recorder 83            Lead 3 (calliope) 91            Pad 3 (polysynth)
76            Pan Flute 84            Lead 4 (chiff)    92            Pad 4 (choir) 
77            Blown Bottle 85            Lead 5 (charang) 93            Pad 5 (bowed) 
78            Shakuhachi 86            Lead 6 (voice)    94            Pad 6 (metallic) 
79            Whistle    87            Lead 7 (fifths) 95            Pad 7 (halo)
80            Ocarina 88            Lead 8 (bass+lead) 96            Pad 8 (sweep) 

97-104
SYNTH EFFECTS

105-112
ETHNIC

113-124
PERCUSSIVE

97                FX 1 (rain) 105              Sitar 113              Tinkle Bell
98                FX 2 (soundtrack) 106              Banjo 114              Agogo
99                FX 3 (crystal) 107              Shamisen 115              Steel Drums



100            FX 4 (atmosphere) 108              Koto 116              Woodblock
101            FX 5 (brightness) 109              Kalimba 117              Taiko Drum
102            FX 6 (goblins) 110              Bagpipe 118              Melodic Tom
103            FX 7 (echoes) 111              Fiddle 119              Synth Drum
104            FX 8 (sci-fi) 112              Shanai 120              Reverse Cymbal

121-128
SOUND EFFECTS
121              Guitar Fret Noise 124              Bird Tweet 127              Applause
122              Breath Noise 125              Telephone Ring 128              Gunshot      
123              Seashore 126              Helicopter

PERCUSSIVE Channel 10 Note Values and Patches

35      Acoustic Bass Drum 51      Ride Cymbal 1 67      High Agogo
36      Bass Drum 1 52      Chinese Cymbal 68      Low Agogo
37      Side Stick 53      Ride Bell 69      Cabasa
38      Acoustic Snare 54      Tambourine 70      Maracas
39      Hand Clap        55      Splash Cymbal 71      Short Whistle
40      Electric Snare 56      Cowbell 72      Long Whistle
41      Low Floor Tom 57      Crash Cymbal 2 73      Short Guiro
42      Closed Hi Hat 58      Vibraslap 74      Long Guiro 
43      High Floor Tom 59      Ride Cymbal 2    75      Claves          
44      Pedal Hi-Hat 60      Hi Bongo 76      Hi Wood Block
45      Low Tom 61      Low Bongo 77      Low Wood Block
46      Open Hi-Hat 62      Mute Hi Conga 78      Mute Cuica
47      Low-Mid Tom 63      Open Hi Conga 79      Open Cuica
48      Hi-Mid Tom    64      Low Conga 8O      Mute Triangle
49      Crash Cymbal 1 65      High Timbale 81      Open Triangle
50      High Tom        66      Low Timbale

MIDI Notes and Frequencies
Note MIDI Hz Note MIDI Hz

C 0 0 8.176 E 5 64 329.63
C# 0 1 8.662 F 5 65 349.23
D 0 2 9.177 F# 5 66 369.99
D# 0 3 9.723 G 5 67 391.99
E 0 4 10.301 G# 5 68 415.31
F 0 5 10.913 A 5 69 440.00
F# 0 6 11.562 A# 5 70 466.16
G 0 7 12.250 B 5 71 439.88
G# 0 8 12.978 C 6 72 523.25
A 0 9 13.750 C# 6 73 554.37
A# 0 10 14.568 D 6 74 587.33
B 0 11 15.434 D# 6 75 622.25
C 1 12 16.352 E 6 76 659.26
C# 1 13 17.324 F 6 77 698.46
D 1 14 18.354 F# 6 78 739.99
D# 1 15 19.445 G 6 79 783.99
E 1 16 20.601 G# 6 80 830.61
F 1 17 21.826 A 6 81 880.00
F# 1 18 23.124 A# 6 82 932.32
G 1 19 24.499 B 6 83 987.77



G# 1 20 25.956 C 7 84 1046.5
A 1 21 27.50 C# 7 85 1108.7
A# 1 22 29.135 D 7 86 1174.7
B 1 23 30.867 D# 7 87 1244.5
C 2 24 32.703 E 7 88 1318.5
C# 2 25 34.648 F 7 89 1396.9
D 2 26 36.708 F# 7 90 1480.0
D# 2 27 38.890 G 7 91 1568.0
E 2 28 41.203 G# 7 92 1661.2
F 2 29 43.653 A 7 93 1760.0
F# 2 30 46.249 A# 7 94 1864.7
G 2 31 48.999 B 7 95 1975.5
G# 2 32 51.913 C 8 96 2093.0
A 2 33 55.000 C# 8 97 2217.5
A# 2 34 58.270 D 8 98 2349.3
B 2 35 61.735 D# 8 99 2489.0
C 3 36 65.406 E 8 100 2637.0
C# 3 37 69.295 F 8 101 2793.8
D 3 38 73.416 F# 8 102 2960.0
D# 3 39 77.781 G 8 103 3136.0
E 3 40 82.406 G# 8 104 3322.4
F 3 41 87.307 A 8 105 3520.0
F# 3 42 92.499 A# 8 106 3729.3
G 3 43 97.998 B 8 107 3951.1
G# 3 44 103.82 C 9 108 4186.0
A 3 45 110.00 C# 9 109 4434.9
A# 3 46 116.54 D 9 110 4698.6
B 3 47 123.47 D# 9 111 4978.0
C 4 48 130.81 E 9 112 5274.0
C# 4 49 138.59 F 9 113 5587.7
D 4 50 146.83 F# 9 114 5919.9
D# 4 51 155.56 G 9 115 6271.9
E 4 52 164.81 G# 9 116 6644.9
F 4 53 174.61 A 9 117 7040.0
F# 4 54 184.99 A# 9 118 7458.6
G 4 55 195.99 B 9 119 7902.1
G# 4 56 207.65 C 10 120 8372.0
A 4 57 220.00 C# 10 121 8869.8
A# 4 58 233.08 D 10 122 9397.3
B 4 59 246.94 D# 10 123 9956.1
C 5 60 261.63 E 10 124 10548.1
C# 5 61 277.18 F 10 125 11175.3
D 5 62 293.66 F# 10 126 11839.8
D# 5 63 311.13 G 10 127 12543.9

RIFF Wave Chunks
The following is an overview of the defined RIFF Wave File chunks which Sound Forge 3.0 stores and 
recognizes. Although Microsoft recommends that the audio data be stored after all other chunks, the only 
chunks stored by Sound Forge prior to the data are the fmt, fact, and PAD chunks. 
The reasoning proposed for storing the data after all other chunks is if the data is modified, the other 
chunks do not have to be rewritten to disk. However, since the auxiliary chunks are usually much smaller 
than the data, the associated time to rewrite them is usually negligible. For example if a play list chunk is 
modified to add a new region we have to rewrite the complete contents of the data to insert the new 
Playlist chunk. However if it is stored at the end of the data only the play list chunk and any chunks 



following it need to be rewritten. If we were operating with 3 minutes of 44k stereo data then we would 
need to rewrite 30 megabytes of data to insert 1 region change. The auxiliary chunks typically are less 
than 100k so we only have to move 100k with changes to the audio data itself.
Another reason for storing additional chunks after the data is that some non-robust software packages 
assume that all that will be found in a WAV file prior to the data is the fmt chunk. This allows you to still 
read WAV files to some degree with these packages.
Chunk Use
PAD This chunk is used by Sound Forge to align the DATA chunk on a 

sector boundary for use with products like Digidesign's Session 8.
fact Used to specify the length of audio data in samples when data is 

stored in a format other than PCM.
cue Used to specify the start of Markers and Regions.
plst Used to specify a Playlist within a single wave file.
adtl Used to specify region lengths and to provide text names for regions 

and markers.
smpl Used to specify information for files used with samplers. Includes 

information on release and sustain loops.
tlst Used to specify external trigger events for regions and Playlist entries.
inst Unsupported, but documented for consistency.
For more information on the above chunks, refer to the RIFF specification available from Microsoft.
The following chunk has been proposed by Sonic Foundry but has not been registered with Microsoft. 
This chunk is used to save trigger information in WAVE files created by Sound Forge.
tlst (Trigger List) Chunk

Added: ??
Author: Sonic Foundry
Defined for : WAVE form

The <tlst-ck> trigger list chunk specifies a list of triggers which can be used to trigger playback 
of a series of cue points or play list entries. The <tlst-ck> is defined as follows:

|<tlst-ck>| () tlst(
<dwTriggers:DWORD> // count of triggers
<trigger(s)>...) // trigger table

<trigger> struct
{
FOURCC fccListReference;
DWORD dwName;
DWORD dwType;
DWORD dwTriggerOn;
DWORD dwFunction;
DWORD cbExtra;
}

The <trigger> chunk:



fccListReference Specifies the list which this entry references. A trigger 
can reference either the <cue-ck> or the <plst-ck>.

dwName When the trigger references the <cue-ck> this field 
specifies the cue point name. This value must match one
of the names listed in the <cue-ck> cue-point table. 
When the trigger references the <plst-ck> this field 
references a play list entry by index. This value must be 
less than the total count of <plst-ck> entries.

dwType Specifies the type of trigger.
0 - SMPTE Trigger
1 - MIDI Command Trigger.
2 - MIDI SysEx Trigger. (SysEx message)

dwTriggerOn Specifies the value which will cause a trigger to be 
generated. This value will change value depending on 
the type of trigger.

For triggers of type SMPTE (0)
Specifies a SMPTE time offset for the cue. The 
format of this value is 0xhhmmssff. hh is an 
unsigned Hours value [0..23]. mm is an 
unsigned Minutes value [0..59]. ss is an 
unsigned Seconds value [0..59]. ff is an 
unsigned Frames value [0..numFrames].

For triggers of type MIDI Command (1)
Specifies a MIDI Command.

Specified as :
Channel Command Param1 Param2
Byte 0 Byte 1 Byte 2 Byte 3

Where Byte 0 is the MSB and Byte 3 is the 
LSB.

For channels a value of FF signals trigger on all
channels.
For any other param other than the MIDI 
command byte FF signals a don't care value.

For triggers of type MIDI Sysex (2)
Unused, should be set to 0.

dwFunction Specifies the function of this trigger.
0 - Play
1 - Stop
2 - Queue

Trigger functions which are unsupported or unknown 
should be ignored.

cbExtra Specifies the size in bytes of additional trigger information. For 
the case of a MIDI Sysex Trigger, this is the size of the 
matching MIDI sysex command immediately following the 



structure. 
Any value within a sysex that is set to FF is treated as a 
don't care. This allows response on multiple channels, 
values, etc.

Examples:
Play when any MIDI note on is received:

FF 90 FF FF
Play when MIDI note 60 is received on channel 1.

00 90 3C FF
Play when MIDI note 60 is received on channel 1, stop when note off received for same note

00 90 3C FF
00 80 3C FF

Queue when MIDI note 60 is received on channel 2, Play when note off received for same note
01 90 3C FF
01 80 3C FF

Markers, Regions, and Playlist Entries as used by Sound Forge 3.0 
When creating or reading markers, regions and playlist entries in WAV files, the RIFF documentation can 
be a little confusing. We have added this section to give software developers a better idea of how to deal 
with these chunks.
Markers
Markers are a position within a wave file which can also have an associated text name. Each marker in 
Sound Forge is stored as an entry within the <cue> chunk. The entry within the <cue> chunk stores the 
position as well as a DWORD name field. The name field is used to reference the text name entry which 
can be found within the <adtl> chunk. For instance if we had a Marker at 0 which had a name of Start 
there would be an entry within the <cue> chunk with a Sample Offset of 0 and a Name entry of 0x0001 
(we have chosen 0x0001 for the example. The Name entry can be any value from 0x00000000 to 
0xFFFFFFFF) Within the <adtl> chunk we would have an entry of type <labl> (label chunk) with a name 
of 0x0001 and a text field of Start.
Regions
Regions are much like a marker but they also include an associated length as well as a start position and 
text name. Each region is stored as an entry within the <cue> chunk which stores the position as well as a
DWORD name field. The name field is again used to reference the text name entry which can be found 
within the <adtl> chunk. The difference between the marker and the region is that instead of using a 
<labl> chunk in the <adtl> chunk we use a <ltxt> chunk which allows us to store a length as well as a text 
name. For instance if we had a region at 0 with a length of 1000 samples and a name of Beat 1 there 
would be an entry within the <cue> chunk with a sample offset of 0 and a name entry of 0x0001. (Again 
we are using the name value of 0x0001 as an example.) Within the <adtl> chunk we would have an entry 
of type <ltxt> with a name of 0x0001, a text field of Beat 1, and a length of 1,000. Within the <ltxt> chunk 
there is also a field of type FOURCC which specifies the purpose of this entry. For all regions in Sound 
Forge the FOURCC type is set to rgn .
Playlist Entries
Playlist regions are stored a little differently. They specify a reference to a <cue> for the start of each play 
list region and a length and number of loops for each entry. Thus, our play list entries can actually have 
lengths that are different than those stored within the region list. To handle this, for every playlist entry 
there will exist a corresponding region of the exact same length when a wave file is created by Sound 
Forge. This is to simplify the overall use and interface to the user. If we were to have a playlist which 
contained our previous example of a region of Beat 1 playing 4 times, it would be stored in the play list 
with a Name field of 0x0001, a length of 1,000 samples, and a loop count of 4.



Configuring Windows Drivers
Since Sound Forge is capable of performing many tasks within the Windows environment, it can and will 
talk to a wide variety of different hardware items (CD-ROM, Sound cards, MIDI interfaces, etc.). Each of 
these devices requires that a Driver be configured in Windows so that any Windows program will have 
access to them.
A driver is a small program that usually translates software commands and usage to and from a hardware
device (some drivers are software only). Drivers can be specific to a particular piece of hardware/software
or might be general to certain types of applications. For instance, Sound Forge is shipped with the Sonic 
Foundry Virtual MIDI Router driver. This is a software only driver that will allow any Windows MIDI 
program to send and receive MIDI data to and from any other MIDI program without using MIDI hardware.
Your sound card and MIDI interface(s) will also require a driver to be installed in Windows. All of these 
drivers are installed and configured in the Windows Control Panel using the Drivers option. The following 
is a step by step guide to installing drivers in Windows. 
First, go to the Windows Control Panel. Double click the Drivers icon. 
You will now see a list of drivers installed in your system. If you are installing a new piece of hardware, 
you will most likely need to install a driver that came with the device. The manufacturer should have 
included a floppy disk containing the driver. It is possible that the piece of hardware is compatible and 
your Windows disks may contain the necessary driver (for example, an MPU-401 driver is included with 
Windows 3.1). In any case, if you need the driver, you will have to install it.
To install a driver:

1. Open Control Panel and double-click the Drivers icon.
2. Click the Add button.
3. If the driver is not listed in the list that appears here, select Unlisted/Updated driver and click OK.
4. You can now insert the disk containing the driver that you wish to install and enter the drive letter that 
corresponds to the disk that you just inserted. You can also click Browse and search the directory and 
drive letters to find the driver location if it is to be found somewhere else in your system. Click OK.
5. The driver(s) should now be listed. Click once on the driver name to highlight it and click OK.
6. Windows will now install the driver. When it is finished it may be necessary to restart your computer. 
Also, for some drivers, there may be a setup involved. In other words, when installing the driver you 
may be prompted to fill in some information concerning Port Address and IRQ (sometimes called 
Interrupt) information, as well as any options that are unique to the operation of the driver/hardware.
7. Some drivers will allow you to change the setup in Control Panel/Drivers after the driver has been 
installed. 
8. Once the driver is installed, Windows programs that can utilize the device or driver will now list it in 
the appropriate device lists within the program.

A note on hardware conflicts.
If a driver requires configuring IRQ and Port Address settings they must match the jumper settings that 
are physically set on the hardware itself (not all hardware uses jumpers--refer to your sound card 
documentation for proper configuration steps). These settings are unique to each piece of equipment and 
must not match any other piece of hardware in your system. The documentation that came with the 
device you are installing should have a section on setting these parameters.
You will need to know the settings of the other devices in your system that use such settings so as to not 
conflict with the driver you are now installing. This point is one of the most irksome aspects to using an 
IBM compatible and the cause for many a Technical Support call. If your hardware/drivers have conflicts, 
some strange things can happen. Common symptoms of hardware conflict is system lock-up, failure of 
devices to respond, and erratic behavior of previously stable programs.
Please be sure that you do not have a hardware conflict before calling for Technical Support on 
Sound Forge. This is one of the first avenues that we will investigate when called about problems that 
involve hardware inactivity and system lock-up.



Windows Sound Setup
The following section includes a few tips which will help you get your system set up for correct use of 
sound with Windows.
Installing the Correct Driver.
When installing a sound card driver the control panel provides a very limited selection of drivers. It is up to
each sound card vendor to provide you with a driver that works with Windows. Although your card may be
Sound Blaster compatible, installing the Sound Blaster driver may limit you from using the full features of 
you new card. For example if you use one of the supplied Sound Blaster drivers with your Sound Blaster 
Pro you won't be able to play stereo sound. Check the manual and the disks that come with your sound 
card for a Windows Driver. These days, very few manufacturers are not providing drivers.
Tip: Many manufacturers maintain Computer Bulletin Boards where you can download the latest version 
of Windows Drivers. Another source for the latest sound drivers is CompuServe. It's also a good place to 
meet other people who are using the same sound card.
Get Rid of Old Drivers
Windows allows you to have multiple sound card drivers on your system. This is in case you have multiple
sound cards installed in your system. This can be a problem for people who install a new driver for their 
sound card but forget to take the old one out. This can cause all sorts of problems, from erratic sound 
behavior to Windows completely crashing. The rule of thumb is if you are installing a driver for the first 
time then you don't have to take one out. Anytime after that you're going to have to remove one before 
installing a new one.
Tip: Many sound cards install a driver which most people don't know about (and probably don't want to 
know about) known as a Virtual Device Driver (VxD). This is a driver that handles DOS boxes trying to 
access the sound card at the same time Windows does. When removing a sound driver from the system 
this "special" driver is almost always left installed. Usually this isn't a problem if you are just upgrading the
same driver to a newer version as companies rarely change the name of their virtual drivers. However, 
this will almost always occur when you change to a new type of sound card. Depending on the situation 
this can again cause erratic behavior in Windows. The solution for this problem is not for the weak of 
heart. The only way to fix this is to remove the entry for the virtual driver from the [386Enh] section in 
SYSTEM.INI. If you aren't familiar with the SYSTEM.INI file please do not attempt to edit it without the 
help of someone who is. This is an important file to Windows and if you mess it up you will probably end 
up reinstalling Windows. 
Setting Up Your Hardware.
This one is critical folks! When installing a sound driver for the first time Windows will usually ask you for 
at least the following three settings, DMA Channel, Port or IO Address, and Interrupt (IRQ). These are 
hardware settings used by the sound card. Some boards won't ask for a DMA channel as it's set to a fixed
value (usually 1). Most sound cards come set up in a default configuration described in the sound card 
manual. If for some reason you have to change these settings, you will have to configure Windows to 
have the same settings. Here is a another quick set of rules for setting up your hardware.
After Installation:

Windows won't play sound at all.
- Make sure that your speakers are plugged in and the volume on your board is turned up loud 
enough to hear the sound.
- Make sure that the settings in the Drivers section of the Windows Control Panel match those of 
your sound card. When no sound occurs it usually indicates that either the sound I/O Port is set 
wrong or the wrong DMA channel is selected. Some less expensive boards do not support multiple 
DMA channels. These boards will not have an option for DMA setup in their configuration section.
- Make sure that you do not have multiple drivers installed. Many people have made the mistake of 
installing two sound drivers when they have only one sound card. For example, a person owns a 
Sound Blaster Pro and installs the drivers for the Sound Blaster. He then receives the drivers for the 
Sound Blaster Pro and installs them but forgets to remove the original Sound Blaster drivers. 



Although Windows will not alert you to the problem, you may start to notice erratic behavior in 
Windows, especially when using sound. This is due to the fact that the two sound drivers are 
"fighting" for control of the sound card. This situation can also occur when you change sound cards in 
your system. People often forget to remove the old drivers before installing the new ones.
- If you have a board which provides a mixer section for volume control, make sure that the mixer 
volume is turned up loud enough to be heard. Boards of this type provide a mixer application which 
loads in the Windows Control Panel or a separate mixer application either of which controls input 
and output levels of the sound card

Windows plays sound but only part of it or it plays but won't stop.
- Make sure that you do not have your sound card interrupt set to an interrupt in use by another board
in your system. We have run across people who have had their sound card interrupt set to the same 
interrupt as their COM port for years. Although the sound had always sounded funny to them they 
always thought that was the way it was supposed to sound, as they had no source of reference. 
Another common problem is printer ports that use interrupt 7. Since many of the sound cards come 
with a default interrupt of 7 this can cause a conflict with some systems. Although most printer boards 
do not use the interrupt, some do.
- Some software vendors provide software which does automatic detection of the interrupt setting on 
the sound card. This can lead to problems especially for users with complex hardware setups and 
especially network boards. These products attempt to generate a hardware interrupt and then look for
the interrupt which is generated. These algorithms can fail if another interrupt is already pending. The 
best way to check your interrupt settings is to check the jumpers on the board and then refer to the 
sound card manual.
- Make sure that you do not have multiple drivers installed. Many people have made the mistake of 
installing two sound drivers when they have only one sound card. For example, a person owns a 
Sound Blaster Pro and installs the drivers for the Sound Blaster. He then receives the drivers for the 
Sound Blaster Pro and installs these but forgets to remove the original Sound Blaster drivers. 
Although Windows will not alert you to the problem, you may start to notice erratic behavior in 
Windows. Especially when using sound. This is due to the fact that the two sound drivers are 
"fighting" for control of the sound card. This situation can also occur when you change sound cards in 
your system. People often forget to remove the old drivers before installing the new ones.

Selecting the Correct MIDI Driver.
MIDI has become the standard for transferring music data between computers and musical devices as 
well as a standard for saving musical scores on computers. When installing a sound card your driver set 
will often include MIDI In and MIDI Out devices. MIDI In devices supply data to the computer typically 
from a musical instrument like an electric keyboard. MIDI Out devices take data from the computer and 
send it to an external device. MIDI Out devices can also emulate an external synthesizer on the sound 
card itself. For instance the Sound Blaster Pro includes a MIDI In as well as two MIDI Out devices. The 
MIDI In device and one of the MIDI Out devices transfer data through the external MIDI cables to and 
from musical instruments. The other MIDI Out device takes data from programs and sends it to the on 
board synthesizer. When using musical software such as a sequencing program you often have to select 
the MIDI device you want to accept the MIDI data. If you select the MIDI Out device which sends data out 
the attached MIDI cables and you don't have anything attached you won't hear anything! Thus, If you 
don't have an external keyboard make sure when using software that uses MIDI that you select the on 
board synthesizer rather than the external MIDI device.



Using Sound Forge with other applications
Cubase
Cakewalk
Vision
Session 8



Cubase
Cubase is a great working environment for MIDI sequencing. It can, however, be difficult to configure with 
other Windows programs without knowledge of how Cubase is handling MIDI. Sound Forge and Cubase 
can work well together. But there are a few problems the user should be aware of when attempting to do 
so.
When Cubase is started, it will open all MIDI devices found in Windows Control Panel/Drivers. This may 
cause the following problems.
Cubase Sequences (.ALL and .ARR) created before the installation of the Sonic Foundry Virtual 
MIDI Router device, might cause system lock-up when opened. Sequences created after 
installation of the Sonic Foundry driver should work fine.
Here is a way to remedy this problem if you need to open an older sequence:

1. Before running Cubase, remove the Sonic Foundry Virtual MIDI Router from Windows/Control 
Panel/Drivers.
2. Next, open Cubase and the sequence file that you want to work on.
3. Now export the file as a MIDI file (Export MIDI file in Cubase File menu).
4. Quit Cubase and open the Cubase Setup MIDI program and add the Sonic Foundry VMR again to 
Windows/Control Panel/Drivers. 
5. Open Cubase and Import the MIDI file that you just Exported. (Yes to merge into current file).
6. It is recommended that before playing the file, change all references to MIDI drivers throughout the 
program to something other than the Sonic Foundry Virtual MIDI Router and select it only when 
needed. Remember that Cubase allows you to select MIDI drivers in many places(Synchronization, 
MIDI Setup, Inspector, etc.).
7. You can now save the file as a regular Cubase file (.ALL or .ARR).

If you have an Arrangement (.ARR) version of your Song (.ALL), you might try loading it into the DEF.ALL 
and immediately (before hitting play) change all references to the Sonic Foundry VMR to something else 
or to none. Then save as a new song. Again, only reference the VMR in the place(s) that you need it.
When Cubase and Sound Forge are open at the same time, selecting MIDI Input Sync/Trigger or 
MIDI Output Sync yields a message that the VMR is in use by another application. This will occur 
even though you have set Cubase to not use the VMR anywhere in the programs MIDI device 
select fields. This happens because Cubase will open all Multimedia MIDI drivers when it is started
(whether the .ALL is set to use them or not). 
To get around this one:

1. With no applications open, start Sound Forge first and select MIDI Input Sync/Trigger or MIDI 
Output Sync (having set the Preferences MIDI/Sync to the desired VMR device).
2. Now open Cubase and choose the Sonic Foundry VMR device in the appropriate spot for your uses 
(Synchronization, Track, Inspector, etc.).
3. The setup should now work fine. 

If when using MIDI Time Code to either sync Cubase to Sound Forge or vice versa through the 
Sonic Foundry VMR, there seems to be no response:

1. In Cubase Preferences, select the option Play in Background.
2. Cubase may need a SMPTE offset greater than 00:00:00:00 (probably at least 00:00:01:00) in order 
to catch the Sync.

Syncing Cubase to Sound Forge via SMPTE/MTC.
1. In Sound Forge Preferences MIDI/Sync, set the Input to one of the Virtual MIDI Router devices and 
the Output to a different VMR device.
2. In Cubase Synchronization, set Sync Source Timebase to MTC and from should be set to the 
VMR device chosen for output in Sound Forge. Set the Frame Rate to match that being output from 
Sound Forge. The Tempobase is most likely going to be set to internal.
3. On the Cubase transport bar click the Sync button to on.
4. Now, in Sound Forge, select MIDI Output Sync from the Special menu (or toolbar).



5. Cubase should now respond to the MTC being output from Sound Forge automatically when you 
invoke play from Sound Forge.

Syncing Sound Forge to Cubase via SMPTE/MTC.
1. In Sound Forge Preferences MIDI/Sync, set the Input to one of the Sonic Foundry VMR devices 
and the Output to a different VMR device.
2. In Cubase Synchronization, set Sync Source Timebase to Internal and From should be set to M-
ROS. Set the Frame Rate to the method you prefer (make sure this matches the method selected in 
Sound Forge). The Tempobase is most likely going to be set to internal. Set Sync Output - MIDI 
timecode to the VMR device you selected as input in Sound Forge.
3. Now, in Sound Forge you must create a playlist consisting of Regions that will begin playing at 
designated MTC cue points (for more information, see Playlists elsewhere in this manual). Be sure to 
establish different cue points for each region and that they do not overlap in time.
4. Select MIDI Input Sync/Trigger from the Special menu(or toolbar).
5. Now, invoking play from Cubase will trigger the Sound Forge regions as the SMPTE/MTC time 
arrives at their designated Play at Time.

Triggering Sound Forge Regions with a MIDI note from Cubase.
1. In Sound Forge Preferences MIDI/Sync, set the Input to one of the Sonic Foundry VMR devices and
the Output to a different Sonic Foundry VMR device.
2. You must create a Regions list and give each region a unique MIDI note (see Regions list elsewhere 
in this manual). The MIDI channel you set here will correspond to the MIDI channel of a track in 
Cubase. It is recommended that you use MIDI: Note on - Queue / Note off - play method for most 
accurate triggering.
4. Select MIDI input Sync/Trigger from the Special menu(or toolbar).
5. In Cubase, create a track and input the notes according to your needs. These notes should match 
those setup in the Sound Forge Regions List (note that Cubase references MIDI notes two octaves 
below that of Sound Forge; C5 in Sound Forge = C3 in Cubase). The Sonic Foundry VMR device 
selected for this track's output should match that set in Sound Forge as the MIDI/Sync input.
6. Now, invoking play from Cubase will trigger the Regions as their SMPTE/MTC time arrives.



Cakewalk
Cakewalk is a very popular MIDI sequencer. It is relatively simple to Sync and trigger with other MIDI 
applications. There are a few points the user should be aware of when attempting to use Cakewalk with 
Sound Forge.

- Cakewalk does not transmit MIDI Time Code (MTC). Therefore, it is not possible to synchronize 
Sound Forge to Cakewalk via MTC. If you want to use Cakewalk as the master, you will have to use the
MIDI trigger method.
- Some sound cards do not report an accurate timing reference to Sound Forge. This may become most
apparent when trying to sync Cakewalk to Sound Forge. If Cakewalk seems to be playing back at an 
incorrect tempo and/or loses the sync (MTC), you will probably need to select Interpolate position 
between buffers in the Sound Forge Wave Preferences (File menu) and adjust the Position bias. 
See Reference/Preferences for more information on Interpolating.
- Cakewalk will most likely require a SMPTE offset of at least 00:00:05:00 when syncing to Sound Forge
(especially on slower machines). The offset may make it necessary to insert some silence into the 
beginning of the sound file so that Cakewalk is running by the time your audio material starts to play.

To Sync Cakewalk to Sound Forge via MTC:
1. In Cakewalk MIDI Devices, select one of the Sonic Foundry Virtual MIDI Router devices for Input 
port. Since Cakewalk will not transmit MTC, do not select a VMR device for Output port.
2. In Sound Forge Preferences MIDI/Sync, set the output to the same VMR device chosen as 
Cakewalk's MIDI input. And also select MIDI Output Sync.
3. Now, in Cakewalk select MTC on the clock source button (next to the transport controls), and press 
play. You should now get a message that Cakewalk is waiting for timecode.
4. Pressing play in Sound Forge will start the playback of Cakewalk in Sync.

To trigger Sound Forge Regions from Cakewalk via MIDI notes:
1. In Sound Forge Preferences MIDI/Sync, set Input to one of the Sonic Foundry VMR devices and 
select MIDI input Sync/Trigger from the Special menu.
2. Also setup a Regions list to include the various regions that you want triggered and setup the 
necessary MIDI note information by double clicking on a region in the list to open the edit region dialog. 
MIDI notes transmitted by Cakewalk are consistent with the naming of MIDI notes in Sound Forge. It is 
recommended that you choose the MIDI: Note on - Queue / Note off - play method as this will insure 
consistent timing results.
3. Now, in Cakewalk, select the MIDI devices Output port and choose the Virtual MIDI Router that you 
selected in Sound Forge's Preferences MIDI/Sync Input.
4. Create a track and choose the MIDI channel that matches the Sound Forge Regions MIDI channels. 
And enter the note(s) to the track that correspond to the appropriate Sound Forge Region(s).

Playing back Cakewalk should now trigger the appropriate Regions in Sound Forge when each note 
arrives in the sequence.



Vision 1.4
Vision for Windows is Opcode's entry into the Windows sequencer market. It can be synchronized to 
Sound Forge via MIDI Time Code and can trigger regions via a MIDI note. Note that Vision 1.4 does not 
output MIDI Time Code.
Beware of using Vision's Send Clock to sync Sound Forge to Vision. This may cause a General 
Protection fault in Vision. Sound Forge does not respond to MIDI Clocks, so there is really no reason to
do this.
Syncing Vision to Sound Forge via SMPTE/MTC.

1. In Sound Forge Preferences MIDI/Sync, set the Output to one of the Sonic Foundry Virtual MIDI 
Router (VMR) devices.
2. In Vision Receive Sync Device (Options menu), select the VMR device chosen as the Sync output 
in Sound Forge. Select Time Code from Vision's Receive Sync Mode (Options menu). Also, select the 
SMPTE format (also on the Options menu) that matches the SMPTE format that you will select in 
Sound Forge.
3. Make sure that Time Code is displayed on the Vision Control bar (just to the right of the Tempo 
display).
4. Now, in Sound Forge, select MIDI Output Sync from the Special menu (or toolbar). Also, select the 
SMPTE format that you would like to use from the Status Format pop-up menu of the View menu (this 
should match the SMPTE format selected in Vision).
5. Click the Play button on the Vision Control bar. It should blink awaiting Time Code.
5. Vision should now respond to the MTC being output from Sound Forge when you invoke play from a 
Sound Forge transport bar.

Triggering Sound Forge Regions with a MIDI note from Vision.
1. In Sound Forge Preferences MIDI/Sync, set the Input to one of the Sonic Foundry Virtual MIDI 
Router (VMR) devices.
2. You must create a Regions list and give each region a unique MIDI note (see Regions list elsewhere 
in this manual). The MIDI channel you set here will correspond to the MIDI channel of a track in Vision. 
It is recommended that you use MIDI: Note on - Queue / Note off - play method for most accurate 
triggering.
3. Select MIDI Input Sync/Trigger from the Special menu or toolbar.
4. In Vision, create a track and input the notes according to your needs. These notes should match 
those setup in the Sound Forge Regions List. Note that in Vision's Preferences you can set the Middle 
C reference to C3(Yamaha) or C4(Standard). If you select C4(Standard), the MIDI notes will be 
consistent with Sound Forge. If you select C3(Yamaha), the Vision reference to Middle C will be one 
octave lower than that of Sound Forge. The VMR device selected for this track's output should match 
that set in Sound Forge Preferences as the MIDI/Sync input.
5. Now, invoking play from Vision will trigger the Sound Forge Regions as their SMPTE/MTC time 
arrives.



Session 8
The Session 8 has real time equalization but little else in terms of processing sound file data. Sound 
Forge supports the .WAV sector alignment scheme used by Digidesign's Session 8 for the PC and can 
therefore be used to apply processing functions to Session 8 sound files. There a few points to note: 

- In Sound Forge Preferences, make sure that the Sector align data for Digidesign's Session 8 
option in the General folder is checked. This tells Sound Forge to save WAV files in a special format 
used by Session 8.
- Sound Forge cannot control the Session 8 hardware, nor can its processing functions be applied in 
real time to Session 8 tracks.
- To listen to edited Session 8 sound files from Sound Forge, a Windows compatible sound card needs 
to be installed in your computer.
- Once a Session 8 sound file has been edited in Sound Forge, Session 8 needs to be made aware of 
the changes made to the sound file. To do so, save the file in Sound Forge and re-open it in Session 8. 
Doing this is relatively straightforward (although admittedly not elegant, yet). There are two different 
ways to approach this. Each time you edit a sound file in Sound Forge you must either:

- Delete the regions referencing the edited sound file in Session 8 and re-add them.
- Quit and restart Session 8. This will make the changes to the sound file current in Session 8. In this 
way, it will not be necessary to delete any regions and then re-add them.

If you have enough space on your hard drive, it might be preferable to save altered Session 8 sound 
files from Sound Forge as new sound files. This will leave the original Session 8 sound file/region intact.
You can then add the new sound files as you would any other sound file/region in Session 8.



Tips and Ideas
Pseudo-quantizing digital audio with MIDI sequencers
Realistic MIDI drum parts with MIDI triggering
Randomizing a Drum Loop



Pseudo quantizing digital audio with MIDI sequencers
There are many ways to use Sound Forge with MIDI sequencers. The following two tips deal with drum 
patterns , though any type of material could be adapted to these techniques. These examples are some 
of many possible uses for the MTC sync and MIDI triggering capabilities of Sound Forge and MIDI 
sequencers. For information on setting up the Sync/triggers with specific sequencers, see Appendix M: 
Using Sound Forge with MIDI Sequencers.
Using MIDI note triggering to pseudo-quantize a Regions.

1. Record some drum tracks into Sound Forge that are in a consistent tempo and measure scheme. 
2. Split up the sound file into regions that are a measure in length. In the Regions List, assign a different
MIDI Note On trigger to each region.
3. Select a region and open the Edit Tempo dialog in Sound Forge's Special menu. By selecting 
Measure, you can now see what the approximate tempo (BPM) is according to the number of beats you
have entered and the length of the selection. Examine a number of different regions in this way and 
take an average BPM.
4. Now, set the sequencer's tempo to match the BPM found in Sound Forge's Edit Tempo. 
5. Next, create a MIDI track with whole notes that correspond to the note numbers selected in the 
Sound Forge Regions List for each separate region. These notes should fall on downbeats of the 
measures so there is one note per measure. It is a good idea to make their lengths a few clock pulses 
shy of the next downbeat. Also, it may be necessary to set a negative time offset for the whole track to 
allow for any slight delay that MIDI note triggering is prone to have.
6. Now, playing back the track in the sequencer while triggering Sound Forge should give you a 
pseudo-quantized version of the sound file. Each new measure in the sequencer should trigger a 
measure of audio material in Sound Forge. Although this method has potential for less accurate start 
points than MTC SMPTE triggering, it will allow for easier tweaking and alignment within the sequencer.

Using MTC synchronization to pseudo-quantize the Playlist.
1. Record some drum tracks into Sound Forge that are in a consistent tempo and measure scheme. 
2. Split up the sound file into regions in the Regions List and Playlist that are a measure in length.
3. Select a region and open the Edit Tempo dialog in from the    Special menu. By selecting Measure 
you can now see what the approximate tempo (BPM) is according to the number of beats you have 
entered and the length of the selection. Check a number of different regions in this way to find an 
average BPM.
4. Now, in the sequencer, set the tempo to match the tempo found in Sound Forge. Next, there should 
be a way (in the sequencer) to see what SMPTE time will correspond to whatever measure downbeat 
you choose. These times can be entered as the Sound Forge Playlist regions SMPTE start times. This 
procedure will allow the Playlist regions to start at the downbeat of the sequencer measures when 
Sound Forge is set to follow MTC. You will undoubtedly need to tweak the start times and possibly the 
sequencer tempo, but should be able to get it all to sound correct.
5. This method of triggering is quite accurate, since Sound Forge knows what region is to be triggered 
next and can pre-load the data accordingly. It is a little precarious, though, to have to adjust the SMPTE
start times every time the sequencer tempo is changed due to tweaking.



Realistic MIDI drum parts with MIDI triggering
If you do a lot of MIDI sequencing, you know how unconvincing and static MIDI drum parts can be, 
especially if you're not a drummer. Good results can be achieved through the use of triggering Sound 
Forge regions from a MIDI sequencer to go along with drum parts that have been created in the 
sequencer. If you have a sampler, here is a procedure that yields quite convincing drum tracks.

1. First, record into Sound Forge some drum tracks/sounds from an audio source that has an 
abundance of drums alone material.
2. Run Auto Region on the sound file to automatically breakup the events into easily manipulated 
regions. To audition each region, open the Regions List and click on the play button for each entry.
3. Create some MIDI drum tracks in your sequencer without worrying too much about fills, flams, etc. 
These things will be added by MIDI triggering Sound Forge.
4. Now that you have a basic drum track in the sequencer, go to Sound Forge and choose events that 
are distinctly Drummer-esque from your Regions List (you might need to edit the lengths and positions 
of the regions). These are the types of events that in themselves do not make good single drum 
samples or are too long to reasonably use with a sampler with limited amounts of RAM (for example, 
drum fills, flams, long crash cymbals and events that have a certain amount of Human variation).
5. For each region you want to use, select a MIDI Trigger event in the Edit Marker/Region dialog. It is 
recommended that you use MIDI: Note On - Queue / Note Off - Play as this will ensure that the timing 
will be accurate. The only drawback to this method of triggering is that the actual the start of the region 
playback will occur on the release of the MIDI note in the sequencer. That is, the place in time the 
triggered region should start playing will have to line up to the end of the MIDI event. In some 
sequencers, this is a little easier to deal with than others. This is a way for Sound Forge to pre-load the 
region data for accurate playback at the trigger point. See the Using Sound Forge section on MIDI 
triggering for a detailed explanation of setting up Sound Forge MIDI triggers.
6. Now, in your sequencer, assign a new track with the same MIDI channel as specified in the MIDI 
Triggers for the regions. At this point each of your drum regions in Sound Forge can be triggered from 
your sequencer with MIDI notes. You can decorate your drum parts with these events to add variation 
and Drummer-isms that are not possible with single drum samples and MIDI alone.



Randomizing Playlist regions
Some very interesting rhythmic patterns can be "discovered" by using the Region Scrambler (a.k.a. the 
Egg Beater) technique on a drum track outlined below:

1. Open a file with a drum pattern. Run the Auto Region tool using the "Drum Beats" Preset (minor 
tweaks may be necessary).
2. In the Playlist window, randomly rearrange the regions. The fastest (and most fun) way to do this is to
randomly drag and drop each region up and down the Playlist. Do this for about 10 seconds or until the 
regions are completely scrambled.
3. Now, listen to the rearranged regions in the Playlist.
4. Another thing you can do is to raise or lower the play count in some regions. You can do so by using 
the Numpad + and Numpad - key.
5. Repeat steps 2-4 until you're positive you've created the most complex rhythmic pattern known to 
man.
6. Create a new file from the playlist by using the Convert to New function. Now, play your new drum 
loop in Looped mode. Tap along to your new groove and try to figure out its time signature.
7. Cool, eh?
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Introduction
Without the convenience of a large computer monitor, an advanced operating system like Windows, and 
an intuitive interface, working with samples can be a nightmare. With the Sampler Tool Plug-In, you can 
now use Sound Forges powerful and easy to use sample editing capabilities to create and edit samples 
and then transfer them to your External and internal samplers.
This manual provides all the information you need to transfer (dump) samples between your computer 
and sampler using Sound Forge and the Sampler Tool Plug-In. In addition, we have included a section 
titled Tips and Ideas that may stir up some new and perhaps unconventional ways of using your sampler.
For a complete discussion on creating and editing samples and sample loops, refer to the chapter titled 
Sampler Tools in the Using Sound Forge section of your Sound Forge manual. The documentation that 
came with your sampler undoubtedly has insights on sampling and loop tuning as well, so you might want
to find it, dust it off, and browse through it. Many of these manuals can be very useful when you read 
them.
External Samplers
External samplers are devices that can play samples at different pitches for use as a musical instrument. 
Most external samplers allow you to record samples or transfer pre-recorded samples into their memory. 
There are two methods of transferring (dumping) samples to external samplers supported by the Sampler 
Tool:

MIDI Sample Dump Standard (SDS): The MIDI Sample Dump Standard (SDS) is used to send and 
receive digital samples with your normal MIDI hardware and cable connections. Because of the 
limited bandwidth of the MIDI protocol and the large amounts of data needed to store digital samples, 
performing a sample dump using the normal MIDI Sample Dump Standard (SDS) can be    slow, often
taking minutes to transfer short samples. SDS is also limited to mono only samples, though some 
samplers allow you to combine two mono samples to create a single stereo sample.
SCSI MIDI Device Interface (SMDI): The SCSI MIDI Device Interface (SMDI) is a relatively new 
standard for music hardware and software to communicate using SCSI hardware and cables. 
Because SCSI hardware has a much larger bandwidth than MIDI, SMDI sample dumps are many 
times faster than SDS dumps. Another advantage to using SMDI is that it supports mono and stereo 
sample dumps (unlike SDS).

Internal Samplers
Internal samplers are cards that are installed inside of your computer. Unlike most sound cards, internal 
samplers allow you to download your own sounds into the cards memory. These sounds can then be 
played at different pitches for use as a musical instrument, just like an external sampler.
The Sampler Tool currently supports only one internal sampler, the Digidesign SampleCell II. Refer to the 
SampleCell II documentation for installation instructions. Once installed, use the procedures outlined in 
the section labeled Digidesign SampleCell II - Sample transfer procedures.
Internal samplers that are not directly supported by the Sampler Tool could use the MIDI Sample Dump 
Standard (SDS). Though no Windows compatible samplers support SDS (that we know of), it would be 
very simple for a manufacturer to implement this feature. If nothing else, SDS could be supported using 
an Open Loop transfer which would eliminate the complexity of supplying an input device. Open Loop 
would also make it possible for an internal sampler to accept data at far greater speeds than MIDI 
normally allows.
If you own a Windows compatible internal sampler, you may want to contact the manufacturer about 
supporting SDS in their Windows drivers. SDS may not be the best solution, but it is far better than no 
solution.
Sampler Hardware Setup
If you do not have your sampler and MIDI or SCSI card set up for transferring samples, you should refer 
to the MIDI/SDS Setup and Troubleshooting or SCSI/SMDI Setup and Troubleshooting chapters in 
this manual. These chapters will help you install the necessary components for transferring samples using
the Sample Tool. There are also suggestions for trouble shooting problematic hardware configurations.
                                                         
See also
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Configuring the Sampler Tool
Creating a Sampler configuration
Internal sampler configuration options
MIDI/SDS configuration options
SCSI/SMDI configuration options
Selecting a Sample Bias for your sampler
Saving Sampler configurations
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Creating a Sampler configuration
After you have your sampler hardware installed and functioning correctly, you must configure the Sampler
Tool for sending and receiving samples from your sampler. Select Sampler from the Tools Menu and 
click the Configure button. Note that you must have at least one data window open to access the Tools 
Menu.
The Sampler Configuration dialog lets you select your sampler and sample transfer mode for both 
sending and receiving. The most common configuration is to have both the send and receive sampler and
transfer mode the same. This is not a requirement, however, and there are situations where differing send
and receive setups can be useful. One example is if you want to transfer samples from one sampler to 
another with editing in between. Multiple configurations can be saved as Presets to match different 
scenarios.
The first step to configuring your sampler setup is to choose the sampler and transfer mode from the 
Send To and Receive From drop-down lists. Several samplers and transfer modes are listed by name in 
these lists. For example, Peavey SP (SCSI/SMDI) specifies a Peavey SP using the SCSI/SMDI transfer 
protocol. If your sampler is listed, select it from the list.
If your sampler is not listed in the Send To and Receive From drop-down lists, try using the Generic 
(SCSI/SMDI) or Generic (MIDI/SDS) options. As long as your sampler properly supports the transfer 
mode (protocol) you select, the Sampler Tool should be able to work with your sampler. If you have 
trouble and you are certain your sampler is properly set to send or receive samples, contact your 
samplers manufacturer. They may have an updated ROM available to correct the problem.
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Internal sampler configuration options
Currently, only the Digidesign SampleCell II internal sampler is directly supported by the Sampler Tool. If 
you have a SampleCell II and you have selected it for the Send To Sampler, then there are no further 
configuration options.
Note that the SampleCell II is only available for the Send To option; you cannot receive samples from the 
SampleCell II. A complete discussion on the SampleCell II can be found in the section titled Digidesign 
SampleCell II - Sample transfer procedures later in this manual.
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MIDI/SDS configuration options
If you choose a sampler that uses the MIDI/SDS transfer protocol in the Send To or Receive From drop-
down lists, then you need to specify a few more options. These options include the MIDI input and output 
ports, the MIDI channel to transfer on, and whether handshaking should be used. You can also configure 
how a transfer will be initiated if handshaking is enabled. These options are discussed in detail below.
Select the MIDI Input and MIDI Output ports that are connected to your sampler from the drop-down 
lists. If Open Loop (discussed later) is being used for sending samples, then the MIDI Input port can 
optionally be set to (None). If Open Loop is being used for receiving samples, then the MIDI Output port 
can optionally be set to (None). If Open Loop is not being used, then you must supply both a MIDI Input 
and MIDI Output port.
Now select the MIDI Channel to use when transferring samples. This channel must match the channel 
configured in your sampler for SDS transfers. Note that a channel must be specified even if the sampler is
set to Omni (any channel) mode.
The last two options determine how the sampler and the Sampler Tool interact while transferring samples.
These options are Open Loop and Wait for Request (send) or Send Request (receive).
Open Loop is a term used to describe a unidirectional communication protocol (much like a one sided 
conversation). When Open Loop is enabled, the source for the data will send all data to the destination 
without listening for directions from the destination. The destination has no control over how the data is 
sent and cannot ask for information to be repeated. This lack of communication makes Open Loop 
transfers prone to errors.
If Open Loop is not enabled, we refer to the communication protocol as Closed Loop. A Closed Loop 
allows information to flow in both directions; the two communicators are said to be handshaking because 
they both agree on how and when data is transferred. When using Closed Loop transfers, the data is sent
from the source in small packets (one packet at a time). The destination receives the packet and keeps 
the data if it is valid or discards the packet and asks for the data to be resent. The source will not send the
next packet until the destination asks for it. This form of communication makes Closed Loop transfers 
much more reliable than Open Loop.
It should be noted that Open Loop transfers are not only more prone to errors, but they can be slower 
than Closed Loop transfers, especially when sending samples with the Sampler Tool. The reason for this 
is due to intentional delays placed between data packets. These small delays allow slow samplers to 
keep up with the data being sent, and since these delays are not fine-tuned to exact requirements for the 
sampler, idle time is bound to occur. A Closed Loop transfer guarantees the most efficient timing between 
packets making transfers faster than Open Loop.
Beware of using Open Loop to receive samples from a sampler. Since the Sampler Tool cannot 
control the flow of data packets being sent, there is a high probability that data will be missed. Using 
Closed Loop transfers guarantees that no packets will be missed.
You may be asking why Open Loop is an option if it is so unreliable. Good question. The answer is that 
there are cases that Open Loop is either necessary or more convenient than using Closed Loop. If a 
sampler does not support Closed Loop (handshaking), then you must use Open Loop for transfers. You 
may also want to use Open Loop if you are out of MIDI cables or are having problems with a MIDI port. 
See the chapter titled MIDI/SDS Requirements and Troubleshooting for further details on Open Loop 
transfers.
If you choose to use the recommended Closed Loop transfer, then you also have the option of 
determining how a sample transfer is initiated. For sending samples, you can specify that the Sampler 
Tool should wait for the sampler to request the sample transfer before sending the sample by enabling the
Wait for Request option. This means that the sampler Tool will not send the sample (after you press 
Send Sample) until the sampler requests the sample to be sent. This usually requires you to press a 
button on the sampler to start the transfer.
For receiving samples, you can specify that the Sampler Tool should send a request to the sampler 
asking for a sample to be sent by enabling the Send Request option. This means that the Sampler Tool 
will send a request for the specified sample to the sampler as soon as you press Get Sample. If you do 
not enable the Send Request option, you must initiate the sample transfer from the sampler after you 
press Get Sample.



Here is a brief summary of a typical setup for MIDI/SDS transfers:
Send To configuration (typical): Connect and select a MIDI Input and MIDI Output device. Use your
preferred MIDI Channel. Disable Open Loop. Disable Wait for Request.
Receive From configuration (typical): Connect and select a MIDI Input and MIDI Output device. 
Use your preferred MIDI Channel. Disable Open Loop. Enable Send Request.

The Sample Bias fields will be discussed in the Selecting a Sample bias for your Sampler section later 
in this chapter.
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SCSI/SMDI configuration options
If you choose a sampler that uses the SCSI/SMDI transfer protocol in the Send To or Receive From 
drop-down lists, then you need to specify two other options. These options are the SCSI Host and SCSI 
Sampler.
The SCSI Host drop-down list contains all Sampler Tool compatible SCSI cards found on your computer. 
You need to select the SCSI card that is connected to your sampler from this list. Note that most 
computers will have only one SCSI card listed.

Sound Forge for 32 Bit Windows Note: The Sampler Tool requires a special module
available from Adaptec for use under Win32s. When running under Windows NT without

Adaptecs EZ-SCSI software installed (no WinASPI for Windows NT), the sampler
configuration will function a little differently. The SCSI Host names are for logical devices
that are related to SCSI IDs of your SCSI devices. The SCSI Sampler list will then show
logical unit numbers for your samplers, of which any of them should work. Try it, it will

most likely work the first time and you cannot do any damage.

Once you have selected the SCSI Host, the SCSI Sampler list will contain all SCSI devices connected to 
that host. Select your sampler from this list (the number preceding the device name is its SCSI ID). 
Depending on your SCSI setup, you may notice that hard drives, CD-ROMs and other SCSI devices are 
listed along with your sampler. This is to help troubleshoot SCSI ID conflicts should one occur. If you 
accidentally select a device other than a sampler, no harm will be done. However, a message box will be 
displayed stating the problem if you try to send or receive samples from any device other than a sampler.
If your SCSI card or sampler does not show up in the SCSI Host or SCSI Sampler drop-down lists, refer 
to the section titled SCSI/SMDI Requirements and Troubleshooting to determine the cause. The 
problem may be as simple as you have turned on your computer and sampler in the wrong order. It may 
also be that your SCSI card is not compatible with the Sampler Tool or your SCSI card and sampler are 
installed incorrectly.

See also
Using the Sampler Tool



Selecting a Sample Bias for your Sampler
Those of you that have worked with samplers from different manufacturers know that the sample 
numbering scheme can vary dramatically between samplers. In an effort to simplify the confusion caused 
by working with different samplers, the Sampler Tool lets you specify a sample bias. A sample bias is 
simply a value that gets added to the Logical Sample Number to derive the Actual Sample Number used 
for sending or receiving. Dont panic, well explain everything.
When you want to send or receive a sample from a sampler, you must specify a sample number which is 
the location that the sample is stored within the sampler. This is pretty simple. However, not all samplers 
let you to use any sample number for storing and retrieving samples. samplers that have factory defined 
samples burned into their ROMs usually define a range of sample numbers for these samples. This range
cannot be used to store and retrieve your own samples.
These samplers will define one or more sample number ranges that are available for your own samples. 
For example, the Kurzweil K2000 uses sample numbers 1 though 199 as factory defined samples and 
does not allow access to sample number zero. Sample numbers 200 through 999 are available for user 
defined samples. Also note that a sample number of 200 specified in the Sampler Tool actually addresses
sample number 201 on the Kurzweil K2000 (confusing, isnt it?).
The Akai S1000 on the other hand uses sample numbers 0 through 3 to store its factory defined samples.
Sample numbers above 3 are available for user defined samples. And the list of inconsistencies goes on 
and on.
Wouldnt it be nice if you could simply use sample numbers 0 through n for your samples no matter what 
sampler you are using? This is what the sample bias allows you to do. Once you figure out what sample 
number range is available for your custom samples, and also determine whether the sampler counts in 
the same manner as the Sampler Tool, you can enter the sample bias and forget about it.
For the above examples, a sample bias of 199 works perfectly for the Kurzweil K2000 (remember it adds 
one, so sample number 199 actually addresses sample number 200), and a sample bias of 4 makes the 
Akai S1000 a tad easier to deal with. Once you have entered the sample bias for your sampler, you can 
use sample numbers 0 through n as the Logical Sample Number and the Sampler Tool will convert it to 
the Actual Sample Number automatically.
You can also use the sample bias to define different bases for multiple projects on which you are working.
For example, if you are composing two different pieces that use different samples, you might want to 
create a Sampler Configuration for each of these projects (see the Saving Sampler configurations 
section below). Within each configuration, you can define a different sample bias to keep your samples 
separated in the same sampler.
If you are still a little fuzzy on how the sample bias works, dont sweat it. As soon as you use it once or 
twice, itll become old hat. Try different bias values to see what happens (do this before you start working 
on a critical project). The worst that can happen is you will overwrite a sample that you didnt mean to, and
all writeable samples should be restorable from your disks. The chapter titled Sending and Receiving 
Samples also contains more information on using the Sample Bias.
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Saving Sampler configurations
After filling in all options for a sampler configuration, you can save it as a Preset by selecting the Save As
button in the Sampler Configuration dialog. Type a descriptive name into the Save Preset dialog and 
press OK. Once a sampler configuration Preset is saved, you can choose the configuration by name from
the Sampler dialog. Note that a Preset name can be anything you want, so use whatever names you are 
most comfortable with.
You can create and save as many sampler configuration Presets as you want. You might want to create 
configurations for all of your samplers and presets for specific projects you are working on. Having 
Presets for each of your samplers and projects allows you to quickly switch back and forth without 
reconfiguring the Sampler Tool.
If you want to get rid of a Preset, select it from the Name drop-down list at the top of the Sampler 
Configuration dialog and press the Delete button.
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Sending and Receiving Samples
Once your sampler setup is configured, you should be able to send and receive samples by using the 
Send Sample and Get Sample buttons in the Sampler dialog. Select the sampler you want to send to or 
receive from in the Configuration drop-down list, enter the sample number you want to transfer in the 
Logical send/receive Sampler number field, and press the Send Sample or Get Sample button.
Note that the Actual send sample number and Actual receive sample number are equal to the 
Logical send/receive Sampler number. This is because no Sample Bias is being used for this 
particular configuration.
Other areas of interest are the Send To and Receive From descriptions where all information relevant to 
the sampler configuration is printed. The fields on the bottom called MIDI Unity Note and Fine Tune 
display the current values for the active sample. The C5 (60) displayed for the MIDI Unity Note represents
that the sample is tuned for Middle C. The Fine Tune value is set to 0.0 cents, so no minor tuning 
differences exist. These values are set using the Edit Sample command under the Special menu and 
may be used by samplers that support tuning information for samples. It is important to note that Sound 
Forge does not use this information, it is for samplers only.
To send or receive a sample after selecting the sampler setup from the Configuration drop-down list, you
need only press the Send Sample or Get Sample button. The transfer will begin and a Progress Meter 
will be displayed in the Status Bar of Sound Forge. You can cancel a transfer at any time by pressing the 
Cancel button to the left of the Progress Meter or by pressing the Escape key.
Sending a sample will always send the entire contents of the active data window. Any selection contained 
in the Waveform Display is ignored. When receiving a sample, the entire contents of the active data 
window are replaced with the new sample data (a warning will be displayed before any data is replaced).
If youre having trouble, verify that the sampler is set up correctly for sending or receiving samples by 
referring to the samplers documentation on sample dumps. For further information on using your sampler 
with the Sampler Tool, refer to the sampler specific chapters at the end of this manual. These chapters 
contain detailed information about several samplers that have been used successfully with the Sampler 
Tool. You may want to read some or all of these chapters even if your sampler is not mentioned. There 
are tips you may find helpful when working with your sampler.
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MIDI/SDS hardware requirements and setup
To use the MIDI/SDS protocol with an external sampler that supports the MIDI Sample Dump Standard 
(SDS), you need a MIDI card (with MIDI input and output ports) installed in your computer.
Using MIDI cables, connect the MIDI Out port of your sampler to the MIDI In port of the card and the MIDI
In port of the sampler to the MIDI Out port of the card. This is the same configuration you would use to 
connect a MIDI keyboard to your computer for sequencing.
Internal samplers do not require a MIDI card and MIDI cables. However, you may need to use Open Loop
when sending samples to an internal sampler. The documentation that comes with your sampler should 
specify the requirements for performing SDS transfers if it is supported.



MIDI/SDS troubleshooting
When using MIDI/SDS to send or receive samples, it is usually in your best interest to not use the Open 
Loop option. The Open Loop transfer is slower and has a much greater chance of sending or receiving 
incorrect data. Reasons for using Open Loop are:

- Your sampler does not support Closed Loop transfers (handshaking).
- You don't have enough cables to connect both the MIDI In and MIDI Out ports.

Open Loop can also help with troubleshooting SDS hardware setup problems. If you cant get the Sampler
Tool to transfer data to (or from) your sampler, it may be helpful to try turning on the Open Loop option to 
see if single cable transfers work. If Open Loop works but closed loop does not, you probably have one of
the following problems.

- Your sampler does not support Closed Loop transfers (handshaking).
- Your MIDI cable or connection for MIDI Input (send) or MIDI Output (receive) to your computer is 
bad.
- Your MIDI card is not receiving MIDI Input (send) or sending MIDI Output (receive). Interrupt 
conflicts are a common problem for MIDI Input.
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SCSI/SMDI hardware requirements and setup
To use the SCSI/SMDI protocol with an External sampler that supports the SCSI MIDI Device Interface 
(SMDI), you must have an ASPI compatible SCSI card for your machine. The recommended setup is 
an Adaptec SCSI controller using the WINASPI software provided by Adaptec. The best way to acquire 
this setup is to buy an Adaptec SCSI controller with the EZ-SCSI software. The EZ-SCSI software 
provides the most reliable operation for the sampler Tool.
If you own an Adaptec card and it did not come with EZ-SCSI, you will need to contact your Adaptec 
dealer for information on purchasing EZ-SCSI. You may also contact Adaptec Pre-Sales directly at 1 (800)
959-7274.
If you do not own a SCSI card and are looking for an inexpensive solution transferring samples to your 
SMDI compatible External sampler, the Adaptec AVA-1505 TotalCD kit is an excellent choice. This kit 
comes with EZ-SCSI Lite which provides everything you need for using the Sampler Tool with an external 
sampler (except a SCSI cable).
Cabling
To connect your SCSI card to your external sampler, you will need to use a SCSI cable. There are several
types of SCSI cables, so make sure you get the right one for your SCSI card and sampler.
There are two types of connectors found commonly on external SCSI cables. One type is the Centronics 
50 pin. This connector is the beast of connectors and if you own an Adaptec card other than an AVA-1505 
or AVA-1515, this is probably the connector you will need to connect to your SCSI card. If you own an 
AVA-1505 or AVA-1515, the connector on your SCSI card is a DB-25 connector. This connector is a 25 pin
connector and looks like the connector found on serial and parallel cables. The DB-25 connector is most 
likely used by your sampler as well.
If you are buying a cable to connect your sampler to your system, it is important that you get the 
terminology right when ordering. If you have an Adaptec card other than the AVA-1505 or AVA-1515, you 
will need to order a Centronics to DB-25 SCSI cable. If you have the AVA-1505 or AVA-1515, you will 
need a DB-25 to DB-25 SCSI cable.

Do NOT use a serial, modem, or printer cables to connect your SCSI devices. You may
damage your equipment by using these cables.

Once you have a SCSI card installed (refer to the cards manual for installation instructions), connect the 
card and the samplers SCSI ports with a SCSI cable. Both your computer and your sampler must 
have the power turned off before connecting or disconnecting SCSI cables! Failing to turn the 
power off before connecting and disconnecting SCSI cables can damage your computer and/or hardware.
SCSI connections are much more fragile than MIDI connections.
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SCSI/SMDI troubleshooting
The following is a list of common problems encountered with SCSI and samplers
Conflicting SCSI IDs
Occasional Transfer failures
Sampler is recognized but transfers are unreliable
Adaptec 1540/1542CF Doesnt Recognize a Sampler
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Conflicting SCSI IDs.
When connecting devices on a SCSI chain, each device must have a unique device identifier (ID). SCSI 
allows you to set up to eight unique ID values from 0 to 7. Typically device ID 7 is used for the internal 
SCSI controller card which leaves IDs 0 through 6 available for other devices. Also, if you have a bootable
SCSI hard drive its ID must be set to 0.
Typical SCSI configuration:

ID Device
0 Hard Drive

1 CD-ROM Drive

2-6 Available for use by samplers

7 SCSI Controller Card
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Occasional Transfer Failures.
If you occasionally receive messages such as The SCSI Device is not responding or A problem was 
encountered while transferring the sample you may just have an upset SCSI bus. Try bringing up the 
Sampler Configuration dialog and re-selecting your SCSI Host from the drop-down list. Doing this 
causes a series of SCSI commands to be executed that in many cases will settle an upset SCSI bus. If 
this fails to work, power down and restart all equipment (computer, samplers, etc.).
If the above mentioned messages are encountered frequently, you may have a more serious problem. 
The following section discusses several possibilities.
                                                         
See also
Using the Sampler Tool
SCSI/SMDI Troubleshooting



The sampler is recognized but doesnt transfer reliably.
The following is a list of causes for unreliable SCSI transfers.

Synchronous Transfer Mode.
Some samplers (like the Kurzweil K2000) do not operate properly if there is a SCSI device set to 
Synchronous Transfer mode on the same SCSI chain. SCSI Hard Drives and CD-ROMs often have 
the option of using a Synchronous Transfer mode. If there is a Host vs. Device Synchronous Transfer 
option, make sure you select Host. Refer to your SCSI device manuals for more information.

SCSI termination.
If your SCSI chain is not properly terminated, you may experience unreliable SCSI transfers. Refer to 
your SCSI card and SCSI device manuals for more information.

Long or cheap SCSI cables.
SCSI cables that are very long or not properly shielded can cause unreliable operation. Keep in mind 
that SCSI cables are not as forgiving as MIDI cables; and overly long cables will not work reliably. 
Also beware of using cables that are not certified SCSI cables (such as tantalizingly cheap parallel 
printer cables); the extra money spent on a true shielded SCSI cable can save you endless hours of 
frustration.
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Adaptec 1540/1542CF Doesnt Recognize a Sampler
If you own the Adaptec 1540/1542CF (not the C version, the newer CF version) and it wont recognize 
your sampler you may need to make a change in the configuration of your Adaptec controller.
Some samplers do not want to operate when the Reset SCSI Bus at Power-On option of the Adaptec 
controller is enabled. This is the default operation for the 1540/1542CF and you will have to disable this 
option to allow your system to work with your sampler.
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Disabling the Reset SCSI Bus option

You should review your 1540/1542CF owners manual before proceeding with this
change.

1. Reset your machine by pressing the hardware reset button or turning the machine off and then 
back on.
2. While your system is booting it will display the message Press Control A for the SCSISelect Utility. 
Press Control-A when this message appears.
3. The screen will display the main screen of the SCSISelect utility and show the current IO port in 
use by the SCSI card. Press Enter to proceed to the Options menu.
4. In the options menu press Enter on the Configure/View Host Adapter Settings option to proceed 
to the Settings screen.
5. Move the cursor using the arrow keys until the Advanced Configurations Options item is selected. 
Press the Enter key to proceed to the Advanced Options screen.
6. Move the cursor using the arrow keys until the Reset SCSI Bus at Power-On option is selected. 
Press Enter to change this option.
7. Select the Disabled setting by moving the selection with the arrow keys, and then press Enter.
8. Press the Escape key twice to return to the previous screens.
9. Answer Yes to the Save Changes Made? prompt.
10. Press the Escape key again to exit the SCSISelect utility and answer Yes when the Exit Utility 
prompt is displayed.
11. SCSISelect will reboot your machine after you have made the changes.

Note: Disabling the Reset SCSI Bus at Power-On option may keep other devices on the SCSI chain from 
resetting correctly when using the Soft Boot feature of your machine (i.e. pressing Ctrl+Alt+Del). On some
systems this will cause the system to hang when pressing Ctrl+Alt+Del. To guarantee that devices are 
reset when rebooting with this option disabled, you should use the Reset button on your computer or turn 
the power off and back on to reset the machine.
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Sampler Tips and Ideas
Using FM synthesis with your sampler
Change the games but not the rules
Back-up and catalog your samples
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Using FM synthesis with your sampler
One nice use for the FM Synthesis Tool in Sound Forge is to Turn your sampler into an FM Synth! Well, 
not quite. This procedure will not turn your sampler into a true FM synthesizer, or at least the types that 
have become most familiar. While Sound Forge will produce four operator sounds, this is still sampling. To
get different pitches across the keyboard, the sampler will vary the sample rate of the original sample 
rather than produce a unique timbre based on the frequencies dictated by that pitch (key).
Also, any dynamic envelope and/or velocity control of the FM is not variable like that of true FM 
synthesizers. Nonetheless, sending samples to your sampler that were produced using the FM Synthesis
tool of Sound Forge can yield some very cool results. If you have a sampler with synthesis capabilities, 
this technique becomes quite powerful.

1. First, create a sample using the FM Synthesis tool found in the Tools menu. The sample can be 
rather short (0.2 - 1.0 sec) and it is probably a good idea to make sure that some portion of the 
envelope is static so that a good loop is easy to attain.
2. Once you have created the sample, create a sustaining loop and edit it with the Loop Tuner.
3. When you have your sample the way you want it, follow the sampler tool procedure to transfer the 
sample to your sampler.
4. From there any further manipulation will need to take place inside your sampler. Thats about it! 
Simple but effective.
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Change the game but not the rules
Its easy to see that you can expand the processing power of a sampler by using Get Sample to retrieve a
sample from the sampler, processing it with Sound Forge, and then using Send Sample to send the 
sample back to the same location in the sampler. This in itself is no mind blowing discovery. However, 
there may be some inspiring side effects waiting to be uncovered.
Most samplers will replace samples already in memory locations with new samples received from Sound 
Forge if the Logical send/receive sample number matches the original location. Other samplers will 
automatically put a received sample in an empty location regardless of the sampler number. The following
idea is only possible with a sampler that replaces a sample.
When the Kurzweil K2000 receives a sample via SCSI/SMDI, it will replace samples that have the same 
incoming send sample number (this is not true if you are using MIDI/SDS with the K2000). The interesting
part of this is all Keymaps that reference that sample location will remain intact even if the sample has 
been replaced with an entirely different one. This can lead to some very unique and sometimes spine 
tingling sounds.
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Back up and catalog your samples on your computer
Using the Sampler Tool, you can use your computer to store and catalog samples. Saving your samples 
as WAV files on your computers hard drive or normal floppy disks allows you to store detailed Summary 
Information with each sample. Summary Information can include descriptive titles, subject details, general
comments, and more.
Unfortunately, Keymaps and other sampler specific information are not transferred from the sampler to 
the Sampler Tool, so none of it gets saved with WAV files. If this is the case with your sampler and you 
still want to save your samples as WAV files, you might be able to save Keymaps and other information 
without the sample data on a floppy disk. By saving this special information without the sample data (or a 
very small sample if the sampler requires it), you could store quite a few on a singly floppy disk. Later, the 
Keymaps can be recombined with the sample data stored on your computer.
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Akai S1000 - MIDI/SDS procedure
The S1000 is capable of sending and receiving samples via MIDI/SDS in all methods implemented by 
Sound Forge. Provided that your MIDI connections are correct, the S1000 is basically ready to receive or 
send a sample.
A few things to keep in mind:

- The S1000 structures its sample memory in such a way that the Logical send/receive sample 
number in Sound Forge can be a little confusing. The problem is that the S1000 will name the newly 
received sample according to the Logical send number specified in Sound Forge. However, in the 
S1000, a new sample is placed into the next available memory location, not the Logical send 
location.
- For example, if you send the S1000 a sample with a Logical send number of 0, send another with 
the Logical send number of 2, and then send yet another with the Logical send number of 1, the 
S1000 will now have three samples next to each other in memory, one named MIDI 0 another named 
MIDI 2 and another named MIDI 1. Now, if you wanted to use Sound Forges Get Sample to retrieve 
these from the S1000, MIDI 0 would have to be referred to as Logical receive number 4, MIDI 2 
would be Logical receive 5, and MIDI 1 would be referred to as Logical receive number 6. Whats 
going on here?
- First of all, the S1000 has four waveforms permanently stored in memory location 0-3; sine, square, 
sawtooth, and pulse. The S1000 doesnt necessarily refer to these waveforms as being at these 
locations. We are referring to them as such because if you wanted to Get sample from Sound Forge, 
these are the Logical receive numbers you would use to get these waveforms. The S1000 is simply 
taking the Logical send number and using it as a naming convention for received samples. However,
the Logical send number has no bearing on where it puts the sample.
When the S1000 receives a new sample from Sound Forge, it puts it into its next available memory 
location, deriving its name from the Logical send number. In our example, it put our first sample sent 
in location number 4 and named it MIDI 0, the next one in location number 5 and named it MIDI 2, 
and finally put MIDI 1 in location number 6. So bear in mind that when invoking Get Sample in Sound
Forge, the Logical receive sample number does not necessarily correspond to the name of the 
sample in the S1000.
- The S1000 will replace any sample in its memory with an incoming sample of the same name. That 
is, if you have sent a sample into the S1000 with Logical send number 2 and the S1000 has named 
this MIDI 2, then if you send another sample and do not change the Logical send number, the original 
MIDI 2 will be replaced with a new MIDI 2.
- In order to audition the sample from a MIDI source (such as the Sound Forge keyboard), it will be 
necessary to go the S1000 EDIT SAMPLE page and select the sample that you want to hear. You will
need to be on this page in order to audition a sample that has not yet been incorporated into a 
program.
- While the S1000 is receiving the sample, the MIDI LED will flicker indicating that the transfer is in 
process.
- The S1000 supports SDS handshaking. Therefore, any method of MIDI/SDS transfer will work. It is 
recommended that you turn Open Loop off and Send request on. Be sure that the MIDI IN and OUT 
are connected between the S1000 and Sound Forge to use handshaking (Closed loop).
- On the S1000s MIDI EXCL page, set the type of transmission to SINGLE SAMPLE and sample 
protocol to STANDARD.

To transfer MIDI/SDS to the S1000 from Sound Forge
1. Having set the necessary Start/Sustain loop/Release loop points within Sound Forge. Select 
Sampler from the Tools menu.
2. Select Configure.
3. In the Send to section, select Akai S1000 (MIDI/SDS).
4. In the MIDI output section choose the MIDI driver that is connected the S1000s MIDI input.
5. Now select the MIDI Channel. (This should match the MIDI channel found in the S1000s 



MIDI/EXCL page).
6. Hit OK.
7. Hit Send Sample. The S1000 should now receive the sample.

To transfer MIDI/SDS to Sound Forge From the S1000
1. Having set the necessary Start/Sustain loop/Release loop points within the S1000. Select Sampler
from the Tools menu.
2. Select Configure.
3. In the Receive from section, select Akai S1000 (MIDI/SDS).
4. In the MIDI output section choose the MIDI driver that is connected to the S1000s MIDI input.
5. In the MIDI input section choose the MIDI driver that is connected to the S1000 MIDI output.
6. We recommend that you select Send request (MIDI/SDS).
7. Now select the MIDI Channel. (This should match the MIDI channel found in the S1000s 
MIDI/EXCL page).
8. Hit OK.
9. Hit Get Sample. Sound Forge should now receive the sample.
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Digidesign SampleCell II - Sample transfer procedures
The SampleCell II is capable of receiving samples via internal interaction between Sound Forge and the 
SampleCell software.
A few things to keep in mind:

- You must have SampleCell software version 1.02 or above to transfer samples from Sound 
Forge to your SampleCell II card. If you have an earlier version contact Digidesign to acquire an 
update.
- At present, Digidesign does not provide Windows NT compatible software. Transferring samples to 
the SampleCell II is therefore not supported in Windows NT.
- The SampleCell can only receive samples from Sound Forge. You can not retrieve samples from the
internal memory of the SampleCell. This is usually not a problem since the SampleCell does not allow
you to record new samples. All samples in its memory are supplied from files you already have on 
your computer
- Sending a sample to the SampleCell from Sound Forge will replace any previous samples sent by 
Sound Forge.
- In order to audition the sample from a MIDI source (such as the Sound Forge keyboard), it will be 
necessary to set the MIDI output device to SampleCell 1. If you have more than one SampleCell the 
number will be adjusted accordingly for each card in your system.
- You must be running the SampleCell application software to transfer samples from Sound Forge to 
the SampleCell.
- All samples sent to the SampleCell from Sound Forge have the name FRGSCNEW.
- The SampleCell ignores the Sample Number and Bias fields used by Sound Forge.

To transfer samples to the SampleCell from Sound Forge
1. Start the SampleCell software by double clicking on the Sample Cell icon.
2. Having set the necessary Start/Sustain loop/Release loop points within Sound Forge. Select 
Sampler from the Tools menu.
3. Select Configure.
4. In the Send to section, select Digidesign SampleCell II. You do not have to set any other options 
in the dialog. They are ignored by the SampleCell.
5. Hit OK.
6. Hit Send Sample. The SampleCell should now receive the sample.

When transferring samples to the SampleCell, a temporary WAV patch file is created prior to sending the 
data to the SampleCell. You should not save instruments or patches based on files transferred from 
Sound Forge to the SampleCell, as the SampleCell bases its instruments on the original WAV file name. 
The downloading of samples from Sound Forge is meant to be used to create and tune single WAV 
sounds within an instrument. If you save an instrument based on a temporary file created by Sound 
Forge, when you attempt to reload the instrument at a later time the SampleCell software will not be able 
to find the temporary file.
When creating samples for the SampleCell, do as much work as you can in Sound Forge. Download the 
sample to the SampleCell to listen to how it sounds on the SampleCell. If you are happy with your 
work ,save the file using the Save As item from the File menu and then load the new WAV file from 
SampleCell software to create new instruments.
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Kurzweil K2000 - MIDI/SDS procedure
The K2000 is capable of receiving a sample via MIDI/SDS. The K2000 will not send a sample via 
MIDI/SDS. In its manual there is mention of the K2000 bulk dump. This protocol is not supported by 
Sound Forge. Therefore, the Sound Forge Get Sample procedure does not work with the K2000 for 
MIDI/SDS transfers.
Sending samples to the K2000 via MIDI/SDS is really quite simple. Provided that your MIDI connections 
are correct, the K2000 is basically ready to receive a new sample. The K2000 can be sitting on any 
screen and will actually operate normally while the transfer is going on In the background.
A few things to keep in mind:

- The K2000 will automatically assign the incoming sample to the next available - Sample/RAM 
location if the Logical Send/Receive sample number is left at 0. This location is most likely going to 
be in the 200-299 range (unless these are already filled). If you choose a Logical Send/Receive 
sample number of 0-199, the K2000 will automatically add 200 to the selected number (plus any 
necessary to reach the next available sample number). If you choose a number of 200 or more, the 
K2000 will add 1 (again, plus any necessary to reach the next available sample number).
- In order to audition the sample from a MIDI source (such as the Sound Forge keyboard), it will be 
necessary to create a Keymap within the K2000. This is done by hitting Preview in the Master/Sample
page or by calling up the sample within the Keymap section of a pre-existing program.
- While the K2000 is receiving the sample, the MIDI LED will flicker indicating that the transfer is in 
process.

To transfer MIDI/SDS to the K2000 from Sound Forge
1. Having set the necessary Start/Sustain loop/Release loop points within Sound Forge. Select 
Sampler from the Tools menu.
2. Select Configure.
3. In the Send to section, select Kurzweil K2000 (MIDI/SDS).
4. In the MIDI output section choose the MIDI driver that is connected the K2000s MIDI input.
5. Now select the MIDI Channel. (This should match the Basic MIDI channel found in the K2000s 
MIDI/RECV page).
6. Hit OK. 
7. If you now hit Send Sample, the K2000 will start receiving the data.
8. To examine the new sample within the K2000, simply go to the Master/Sample page of the K2000. 
The sample that appears there as a default should be your newly received sample. Hit EDIT, and look
to see that the waveform appears in the K2000s screen. Hitting preview from the Master/Sample 
page will create a new program based on this sample and will allow you to audition the sample from 
an external MIDI source.
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Kurzweil K2000 - SCSI/SMDI procedure
Sound Forge is capable of sending and receiving samples via SCSI/SMDI to the Kurzweil K2000. This 
method is very fast and very simple once you have configured the SCSI hardware properly. 
A few things to keep in mind:

- Unlike in MIDI/SDS sample transfers, the K2000 will not automatically adjust for sample number 
locations (adding 200, etc.). There are two ways of handling this fact;

You can select the specific Logical send/receive sample number as you would like it to appear 
in the K2000. Since the K2000 will add 1 to whatever number you have entered here, set the 
Sample bias in the Configure menu to -1.
If you set the Sample bias to 199, you can then refer to the Logical send receive sample 
number as 0 through x. This will make the Sound Forge send of sample number 0 locate to the 
K2000 at 200, sample number 1 locates to 201 and so on.

- When sending a sample to a K2000 RAM location that is already filled, the K2000 will not warn you 
that the location is already filled. Instead, it will replace the sample with the new one being sent. Be 
very careful when doing a lot of sample transfers (SCSI/SMDI), so that you do not wipe out your hard 
work by neglecting to select a new Logical send/receive sample number for each separate sample.
- When Choosing SCSI/SMDI in the Sampler dialog or if it was last set to SCSI/SMDI, Sound Forge 
will verify that the SCSI bus is operational and may therefore take a second or two to respond to any 
user interaction.
- When the SCSI/SMDI method is selected in the Configuration dialog, you only need to be concerned
with setting the SCSI host and SCSI sampler. Any SCSI device that appears in these lists, is being 
recognized by Sound Forge and should work correctly.
- Make sure that your SCSI adapter is supported by Sound Forge for sample transfer procedures. If 
you are unsure as to whether your adapter is supported for SMDI transfers with Sound Forge, see 
SCSI/SMDI Setup and Troubleshooting at the beginning of this section.
- The K2000s SCSI ID is set in its MIDI/RECV page.

To transfer SCSI/SMDI to the K2000 from Sound Forge
1. Having set the necessary Start/Sustain loop/Release loop points within Sound Forge. Select 
Sampler from the Tools menu.
2. Select Configure.
3. In the Send to section, select Kurzweil K2000 (SCSI/SMDI).
4. In the SCSI host section, select your SCSI adapter.
5. In the SCSI sampler section, choose the K2000 connected to your computers SCSI bus.
6. Save your configuration if you like and/or hit OK.
7. Check to see that your Configuration settings are confirmed without error and now hit Send 
Sample. The K2000 will receive the sample very quickly. 
8. To examine the new sample within the K2000, go to the Master/Sample page of the K2000. The 
sample that appears there as a default should be your newly received sample. Hit EDIT, and look to 
see that the waveform appears in the K2000s screen. Hitting preview from the Master/Sample page 
will create a new program based on this sample and will allow you to audition the sample from an 
external MIDI source.

To transfer SCSI/SMDI from the K2000 to Sound Forge
1. Having set the necessary Start/Sustain loop/Release loop points within the K2000. Select Sampler
from the Tools menu.
2. Select Configure.
3. In the Receive from section, select Kurzweil K2000 (SCSI/SMDI).
4. In the SCSI host section, select your SCSI adapter.
5. In the SCSI sampler section, choose the K2000 connected to your computers SCSI bus.
6. Save your configuration if you like and/or hit OK.



7. Check to see that your Configuration settings are confirmed without error and now hit Get Sample 
(remember to select the specific Logical send/receive sample number minus 1, unless you have 
adjusted the Sample bias). Sound Forge will receive the sample very quickly. 
8. When the transfer is complete, the sample will appear in the active sample window.

Known problems with the K2000
The following is a list of known problems with transferring samples to K2000:

- The K2000 reboots when in the Master/Sample page: This is a bug in the K2000s ROM. The 
K2000 will reboot if you transfer a sample to the same sample number twice in a row while the K2000 
is on the Master/Sample page. The best way to get around this problem is to not transfer samples 
while you are using the Master/Sample page of the K2000.
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Peavey SP - MIDI/SDS procedure
The Peavey SP is capable of sending and receiving samples via MIDI/SDS in all configuration methods 
implemented by Sound Forge.
Provided that your MIDI connections are correct, the SP is basically ready to receive a new sample. The 
SP can be sitting on any screen and will begin to receive the sample upon initiating the transfer from 
Sound Forge.
A few things to keep in mind:

- Make sure the SPs Get slave samp# is using: midi (sds) - this is located in the SPs Util menu.
- If you have set up the transfer configuration as a Wait for request, you will need to go to the SPs Util 
menu and instigate the request for sample dump. This is done by hitting Exec twice from the Util 
menu on the SP after telling Sound Forge to Send Sample. 
- In order to audition the sample from a MIDI source (such as the Sound Forge keyboard), it will be 
necessary to go to the wave menu on the SP and select the appropriate wave number that you are 
trying to audition (the last received sample should appear on this screen).
- If you are sending a sample Open loop, it is not required that the sampler's MIDI out be connected 
to Sound Forge. However, it is recommended that you use handshaking (no Open loop) for faster and
more reliable communications.

To transfer MIDI/SDS to the Peavey SP from Sound Forge
1. Having set the necessary Start/Sustain loop/Release loop points within Sound Forge. Select 
Sampler from the Tools menu.
2. Select Configure.
3. In the Send to section, select Peavey SP (MIDI/SDS).
4. In the MIDI output section choose the MIDI driver that is connected to the SPs MIDI input.
5. Select the MIDI Channel (this should match the omni/poly channel found in the SPs Global menu, 
unless the SP is set to omni mode).
6. In Sound Forge hit the Send Sample button. The transfer will begin and both Sound Forge and the 
SP will display the amount of data left to go until the procedure is complete.
7. When the transfer is complete, you can hit the wave button on the SP and immediately audition the
sample from the Sound Forge keyboard or whatever MIDI source is connected to the SP.

To transfer MIDI/SDS from the Peavey SP to Sound Forge
1. Having set the necessary Start/Sustain loop/Release loop points within the Peavey SP. Select 
Sampler from the Tools menu.
2. Select Configure.
3. In the Receive from section, select Peavey SP (MIDI/SDS).
4. In the MIDI input section choose the MIDI driver that is connected to the SPs MIDI output.
5. In the MIDI output section choose the MIDI driver that is connected to the SPs MIDI input.
6. Select the MIDI Channel (this should match the omni/poly channel found in the SPs Globl menu, 
unless the SP is set to omni mode).
7. In order for Sound Forge to automatically get the sample without invoking the transfer from the SPs
front panel, it is necessary to turn Wait for request on in the Receive section of the Sampler 
Configure dialog. Otherwise, you will have to hit exec on the SP after hitting the Get Sample button 
in Sound Forge.
8. In Sound Forge, hit the Get Sample button. The transfer will begin and both Sound Forge and the 
SP will display the amount of data left to go until the procedure is complete.
9. When the transfer is complete, the sample will appear in the active Data Window.
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Peavey SP - SCSI/SMDI procedure
Sound Forge is capable of sending and receiving samples via SCSI/SMDI to the Peavey SP. This method
is very fast and simple once you have configured the SCSI hardware properly. 
A few things to keep in mind:

- Make sure the SPs Get slave samp# is using: SCSI (SMDI). This is located in the SPs Util menu. 
Though the SP is capable of detecting what method is used with the incoming sample, it is highly 
recommended that the user select this manually as crashes can occur when first sending MIDI/SDS 
followed immediately by SCSI/SMDI.
- The SCSI cable from your computer must be connected to the SPs SCSI B port.
- When Choosing SCSI/SMDI in the Sampler dialog or if it was last set to SCSI/SMDI, Sound Forge 
will verify that the SCSI bus is operational and may therefore take a second or two to respond to any 
user interaction.
- When SCSI/SMDI method is selected, you only need to be concerned with setting the SCSI host 
and SCSI sampler in the Configuration dialog. Any SCSI device that appears in these lists, is being 
recognized by Sound Forge and should work correctly.
- Make sure that your SCSI adapter is supported by Sound Forge for sample transfer procedures. If 
you are unsure as to whether your adapter is supported for SMDI transfers with Sound Forge, see 
SCSI/SMDI Setup and Troubleshooting at the beginning of this section.
- The Peavey SPs SCSI ID is set by default to Device 0. This setting is made by means of jumpers 
within the unit itself. Every time the SP is powered on, it will reset itself to this setting. You can 
temporarily change the SCSI ID to another number from the SPs UTIL menu and will remain until the 
unit is powered off. If you find that you consistently want a SCSI ID other than 0, you should change 
the jumper settings inside the unit according to the directions in the Peavey SP manual. If you have a
bootable SCSI hard drive its ID will also be 0 so you must change the ID of the SP for proper 
operation.

To transfer SCSI/SMDI to the Peavey SP from Sound Forge
1. Having set the necessary Start/Sustain loop/Release loop points within Sound Forge. Select 
Sampler from the Tools menu.
2. Select Configure.
3. In the Send to section, select Peavey SP (SCSI/SMDI).
4. In the SCSI host section, select your SCSI adapter.
5. In the SCSI Sampler section, choose the Peavey SP connected to your computers SCSI bus.
6. Save your configuration if you like and/or hit OK.
7. Check to see that your Configuration settings are confirmed without error and hit Send Sample. 
The Peavey SP will receive the sample very quickly. 
8. When the transfer is complete, you can hit the wave button on the SP and immediately audition the
sample from the Sound Forge keyboard or whatever MIDI source is connected to the SP.

To transfer SCSI/SMDI from the Peavey SP to Sound Forge
Having set the necessary Start/Sustain loop/Release loop points within the Peavey SP. Select Sampler 
from the Tools menu.

1. Select Configure.
2. In the Receive from section, select Peavey SP (SCSI/SMDI).
3. In the SCSI host section, select your SCSI adapter.
4. In the SCSI Sampler section, choose the Peavey SP connected to your computers SCSI bus.
5. Save your configuration if you like and/or hit OK.
6. Check to see that your Configuration settings are confirmed without error and hit Get Sample. 
Sound Forge will receive the sample very quickly. 
7. When the transfer is complete, the sample will appear in the active sample window.
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